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Old Company Name in Catalogs and Other Documents
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companies. Therefore, although the old company name remains in this document, it is a valid
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Notice

All information included in this document is current as of the date this document isissued. Such information, however, is
subject to change without any prior notice. Before purchasing or using any Renesas Electronics products listed herein, please
confirm the latest product information with a Renesas Electronics sales office. Also, please pay regular and careful atention to
additional and different information to be disclosed by Renesas Electronics such as that disclosed through our website.

Renesas Electronics does not assume any liability for infringement of patents, copyrights, or other intellectual property rights
of third parties by or arising from the use of Renesas Electronics products or technical information described in this document.
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights
of Renesas Electronics or others.

Y ou should not alter, modify, copy, or otherwise misappropriate any Renesas Electronics product, whether in whole or in part.

Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of
semiconductor products and application examples. Y ou are fully responsible for the incorporation of these circuits, software,
and information in the design of your equipment. Renesas Electronics assumes no responsibility for any lossesincurred by
you or third parties arising from the use of these circuits, software, or information.

When exporting the products or technology described in this document, you should comply with the applicable export control
laws and regulations and follow the procedures required by such laws and regulations. Y ou should not use Renesas
Electronics products or the technology described in this document for any purpose relating to military applications or use by
the military, including but not limited to the devel opment of weapons of mass destruction. Renesas Electronics products and
technology may not be used for or incorporated into any products or systems whose manufacture, use, or sale is prohibited
under any applicable domestic or foreign laws or regulations.

Renesas Electronics has used reasonable care in preparing the information included in this document, but Renesas Electronics
does not warrant that such information is error free. Renesas Electronics assumes no liability whatsoever for any damages
incurred by you resulting from errorsin or omissions from the information included herein.

Renesas Electronics products are classified according to the following three quality grades: “Standard”, “High Quality”, and
“Specific”. The recommended applications for each Renesas Electronics product depends on the product’ s quality grade, as
indicated below. Y ou must check the quality grade of each Renesas Electronics product before using it in aparticular
application. You may not use any Renesas Electronics product for any application categorized as “ Specific” without the prior
written consent of Renesas Electronics. Further, you may not use any Renesas Electronics product for any application for
which it is not intended without the prior written consent of Renesas Electronics. Renesas Electronics shall not bein any way
liable for any damages or losses incurred by you or third parties arising from the use of any Renesas Electronics product for an
application categorized as “ Specific” or for which the product is not intended where you have failed to obtain the prior written
consent of Renesas Electronics. The quality grade of each Renesas Electronics product is “ Standard” unless otherwise
expressly specified in a Renesas Electronics data sheets or data books, etc.

“Standard”: Computers; office equipment; communications equipment; test and measurement equipment; audio and visual
equipment; home electronic appliances, machine tools; personal electronic equipment; and industrial robots.
“High Quality”: Transportation equipment (automobiles, trains, ships, etc.); traffic control systems; anti-disaster systems; anti-
crime systems; safety equipment; and medical equipment not specifically designed for life support.
“Specific”: Aircraft; aerospace equipment; submersible repeaters; nuclear reactor control systems; medical equipment or
systems for life support (e.g. artificial life support devices or systems), surgical implantations, or heathcare
intervention (e.g. excision, etc.), and any other applications or purposes that pose adirect threat to human life.
Y ou should use the Renesas Electronics products described in this document within the range specified by Renesas Electronics,
especialy with respect to the maximum rating, operating supply voltage range, movement power voltage range, heat radiation
characteristics, installation and other product characteristics. Renesas Electronics shall have no liability for malfunctions or
damages arising out of the use of Renesas Electronics products beyond such specified ranges.
Although Renesas Electronics endeavors to improve the quality and reliability of its products, semiconductor products have
specific characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Further,
Renesas Electronics products are not subject to radiation resistance design. Please be sure to implement safety measures to
guard them against the possibility of physica injury, and injury or damage caused by fire in the event of the failure of a
Renesas Electronics product, such as safety design for hardware and software including but not limited to redundancy, fire
control and malfunction prevention, appropriate treatment for aging degradation or any other appropriate measures. Because
the evaluation of microcomputer software alone is very difficult, please evaluate the safety of the final products or system
manufactured by you.

Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental
compatibility of each Renesas Electronics product. Please use Renesas Electronics products in compliance with all applicable
laws and regulations that regulate the inclusion or use of controlled substances, including without limitation, the EU RoHS
Directive. Renesas Electronics assumes no liability for damages or losses occurring as aresult of your noncompliance with
applicable laws and regulations.

This document may not be reproduced or duplicated, in any form, in whole or in part, without prior written consent of Renesas
Electronics.

Please contact a Renesas Electronics sdes office if you have any questions regarding the information contained in this
document or Renesas Electronics products, or if you have any other inquiries.

(Note 1) “Renesas Electronics’ as used in this document means Renesas Electronics Corporation and also includes its majority-

owned subsidiaries.

(Note 2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.




-
»
9
ﬁ\
7
<
O
-
c
)

LENESAS

SH7058 E6000H

Emulator
User’s Manual

Renesas Microcomputer
Development Environment
System

SuperH™ Family / SH7050 Series

HS7058EPH60HE

Renesas Electronics Rev.6.00 2005.10


ノート
Target devices have been added. Please read the title as follows:

SH7058 E6000H Emulator HS7058EPH60H,
SH7058S, SH7059 E6000H Emulator HS7059EPH60H
User's Manual





Keep safety first in your circuit designs!

. Renesas Technology Corp. puts the maximum effort into making semiconductor products better and
more reliable, but there is always the possibility that trouble may occur with them. Trouble with
semiconductors may lead to personal injury, fire or property damage.

Remember to give due consideration to safety when making your circuit designs, with appropriate
measures such as (i) placement of substitutive, auxiliary circuits, (ii) use of nonflammable material or
(iii) prevention against any malfunction or mishap.

Notes regarding these materials

. These materials are intended as a reference to assist our customers in the selection of the Renesas
Technology Corp. product best suited to the customer's application; they do not convey any license
under any intellectual property rights, or any other rights, belonging to Renesas Technology Corp. or
a third party.

. Renesas Technology Corp. assumes no responsibility for any damage, or infringement of any third-
party's rights, originating in the use of any product data, diagrams, charts, programs, algorithms, or
circuit application examples contained in these materials.

. All information contained in these materials, including product data, diagrams, charts, programs and
algorithms represents information on products at the time of publication of these materials, and are
subject to change by Renesas Technology Corp. without notice due to product improvements or
other reasons. It is therefore recommended that customers contact Renesas Technology Corp. or
an authorized Renesas Technology Corp. product distributor for the latest product information
before purchasing a product listed herein.

The information described here may contain technical inaccuracies or typographical errors.
Renesas Technology Corp. assumes no responsibility for any damage, liability, or other loss rising
from these inaccuracies or errors.

Please also pay attention to information published by Renesas Technology Corp. by various means,
including the Renesas Technology Corp. Semiconductor home page (http://www.renesas.com).

. When using any or all of the information contained in these materials, including product data,
diagrams, charts, programs, and algorithms, please be sure to evaluate all information as a total
system before making a final decision on the applicability of the information and products. Renesas
Technology Corp. assumes no responsibility for any damage, liability or other loss resulting from the
information contained herein.

. Renesas Technology Corp. semiconductors are not designed or manufactured for use in a device or
system that is used under circumstances in which human life is potentially at stake. Please contact
Renesas Technology Corp. or an authorized Renesas Technology Corp. product distributor when
considering the use of a product contained herein for any specific purposes, such as apparatus or
systems for transportation, vehicular, medical, aerospace, nuclear, or undersea repeater use.

. The prior written approval of Renesas Technology Corp. is necessary to reprint or reproduce in
whole or in part these materials.

. If these products or technologies are subject to the Japanese export control restrictions, they must
be exported under a license from the Japanese government and cannot be imported into a country
other than the approved destination.

Any diversion or reexport contrary to the export control laws and regulations of Japan and/or the
country of destination is prohibited.

. Please contact Renesas Technology Corp. for further details on these materials or the products
contained therein.







IMPORTANT INFORMATION
READ FIRST

* READ this user's manual before using this emulator product.

* KEEP the user's manual handy for future reference.
Do not attempt to use the emulator product until you fully understand its mechanism.

Emulator Product:
Throughout this document, the term "emulator product” shall be defined as the following
products produced only by Renesas Technology Corp. excluding all subsidiary products.
e Emulator station
e PC interface board
e User system interface board
e Cable
The user system or a host computer is not included in this definition.

Purpose of the Emulator Product:

This emulator product is a software and hardware development tool for systems employing the
Renesas microcomputer. This emulator product must only be used for the above purpose.

Limited Applications:

This emulator product is not authorized for use in MEDICAL, atomic energy, aeronautical or
space technology applications without consent of the appropriate officer of a Renesas sales
company. Such use includes, but is not limited to, use in life support systems. Buyers of this
emulator product must notify the relevant Renesas sales offices before planning to use the product
in such applications.

Improvement Policy:

Renesas Technology Corp. (including its subsidiaries, hereafter collectively referred to as
Renesas) pursues a policy of continuing improvement in design, performance, and safety of the
emulator product. Renesas reserves the right to change, wholly or partially, the specifications,
design, user's manual, and other documentation at any time without notice.

Target User of the Emulator Product:

This emulator product should only be used by those who have carefully read and thoroughly
understood the information and restrictions contained in the user's manual. Do not attempt to use
the emulator product until you fully understand its mechanism.

It is highly recommended that first-time users be instructed by users that are well versed in the
operation of the emulator product.
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LIMITED WARRANTY

Renesas warrants its emulator products to be manufactured in
accordance with published specifications and free from defects in
material and/or workmanship. Renesas, at its option, will repair or
replace any emulator products returned intact to the factory,
transportation charges prepaid, which Renesas, upon inspection,
determine to be defective in material and/or workmanship. The
foregoing shall constitute the sole remedy for any breach of Renesas'
warranty. See the Renesas warranty booklet for details on the warranty
period. This warranty extends only to you, the original Purchaser. It is
not transferable to anyone who subsequently purchases the emulator
product from you. Renesas is not liable for any claim made by a third
party or made by you for a third party.

DISCLAIMER

RENESAS MAKES NO WARRANTIES, EITHER EXPRESS OR
IMPLIED, ORAL OR WRITTEN, EXCEPT AS PROVIDED
HEREIN, INCLUDING WITHOUT LIMITATION THEREOF,
WARRANTIES AS TO MARKETABILITY, MERCHANTABILITY,
FITNESS FOR ANY PARTICULAR PURPOSE OR USE, OR
AGAINST INFRINGEMENT OF ANY PATENT. IN NO EVENT
SHALL RENESAS BE LIABLE FOR ANY DIRECT, INCIDENTAL
OR CONSEQUENTIAL DAMAGES OF ANY NATURE, OR
LOSSES OR EXPENSES RESULTING FROM ANY DEFECTIVE
EMULATOR PRODUCT, THE USE OF ANY EMULATOR
PRODUCT, OR ITS DOCUMENTATION, EVEN IF ADVISED
OF THE POSSIBILITY OF SUCH DAMAGES. EXCEPT AS
EXPRESSLY STATED OTHERWISE IN THIS WARRANTY,

THIS EMULATOR PRODUCT IS SOLD "AS IS ", AND YOU
MUST ASSUME ALL RISK FOR THE USE AND RESULTS
OBTAINED FROM THE EMULATOR PRODUCT.
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State Law:

Some states do not allow the exclusion or limitation of implied warranties or liability for
incidental or consequential damages, so the above limitation or exclusion may not apply to you.
This warranty gives you specific legal rights, and you may have other rights which may vary from
state to state.

The Warranty is Void in the Following Cases:

Renesas shall have no liability or legal responsibility for any problems caused by misuse,
abuse, misapplication, neglect, improper handling, installation, repair or modifications of the
emulator product without Renesas’ prior written consent or any problems caused by the user
system.

All Rights Reserved:

This user's manual and emulator product are copyrighted and all rights are reserved by
Renesas. No part of this user's manual, all or part, may be reproduced or duplicated in any form,
in hard-copy or machine-readable form, by any means available without Renesas' prior written
consent.

Other Important Things to Keep in Mind:

1. Circuitry and other examples described herein are meant merely to indicate the characteristics
and performance of Renesas' semiconductor products. Renesas assumes no responsibility for
any intellectual property claims or other problems that may result from applications based on
the examples described herein.

2. No license is granted by implication or otherwise under any patents or other rights of any third
party or Renesas.
Figures:

Some figures in this user's manual may show items different from your actual system.

Limited Anticipation of Danger:

Renesas cannot anticipate every possible circumstance that might involve a potential hazard.
The warnings in this user's manual and on the emulator product are therefore not all inclusive.
Therefore, you must use the emulator product safely at your own risk.

1T
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SAFETY PAGE

READ FIRST

* READ this user's manual before using this emulator product.

¢ KEEP the user's manual handy for future reference.

Do not attempt to use the emulator product until you fully understand its mechanism.

DEFINITION OF SIGNAL WORDS

A This is the safety alert symbol. Itis used to alert you to potential personal
injury hazards. Obey all safety messages that follow this symbol to avoid
possible injury or death.

A DANGER DANGER indicates an imminently hazardous situation which, if not

avoided, will result in death or serious injury.

|A WARNING| WARNING indicates a potentially hazardous situation which, if not
avoided, could result in death or serious injury.

|A CAUTION | CAUTION indicates a potentially hazardous situation which, if not
avoided, may result in minor or moderate injury.

| CAUTION |

CAUTION used without the safety alert symbol indicates a
potentially hazardous situation which, if not avoided, may result
in property damage.

NOTE emphasizes essential information.
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AWARNING

Observe the precautions listed below. Failure to do so

will result in a FIRE HAZARD and will damage the user
system and the emulator product or will result in PERSONAL
INJURY. The USER PROGRAM will be LOST.

1.

2.

3.

Carefully handle the emulator product to prevent
receiving an electric shock because the emulator product
has a DC power supply. Do not repair or remodel the
emulator product by yourself for electric shock
prevention and quality assurance.

Always switch OFF the emulator and user system before
connecting or disconnecting any CABLES or PARTS.

Always before connecting, make sure that pin 1 on both
sides are correctly aligned.

Supply power according to the power specifications and
do not apply an incorrect power voltage. Use only the
provided AC power cable. Use only the specified type of
fuse.

RENESAS




Warnings on Emulator Usage

Warnings described below apply as long as you use this emulator. Be sure to read and understand
the warnings below before using this emulator. Note that these are the main warnings, not the
complete list.

AWARNING

Always switch OFF the emulator and user system before
connecting or disconnecting any CABLES or PARTS.
Failure to do so will result in a FIRE HAZARD and will
damage the user system and the emulator product or
will result in PERSONAL INJURY. The USER PROGRAM
will be LOST.

v
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CAUTION

Place the emulator station and evaluation chip board so
that the trace cables are not bent or twisted. A bent or
twisted cable will impose stress on the user interface
leading to connection or contact failure. Make sure that the
emulator station is placed in a secure position so that it
does not move during use nor impose stress on the user
interface.

VI
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CAUTION

This equipment has been tested and found to comply
with the limits for a Class A digital device, pursuant to part 15
of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference when the
equipment is operated in a commercial environment. This
equipment generates, uses, and can radiate radio frequency
energy and, if not installed and used in accordance with the
instruction manual, may cause harmful interference to radio
communications. Operation of this equipment in a residential
area is likely to cause harmful interference in which case the
user will be required to correct the interference at his own
expense.

VI
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Preface

Thank you for purchasing the E6G000H emulator.

CAUTION

Read this manual before using the emulator product. Incorrect operation
or connection will damage the user system, the emulator product, and the
user program.

The E6000H emulator is an efficient software and hardware development support tool for application systems using the
microcomputer developed by Renesas Technology Corp.

The E6000H emulator can either be used without a user system, for developing and debugging software, or connected via
a user system interface cable to a user system, for debugging user hardware.

The emulator provides the following features:

1. Realtime emulation of the MCU
2. Efficient debugging enabled by variable break functions and a mass-storage trace memory (128-kcycles)
3. Parallel access with a command execution during emulation, for example
e Trace data display
e Emulation memory display and modification
4. Performance analysis
Measurement of subroutine execution time and count for evaluating the execution efficiency of user programs
5. Graphical User Interface by the High-performance Embedded Workshop that runs on Windows® operating systems

High-performance Embedded Workshop is a Graphical User Interface intended to ease the development and debugging of
applications written in C/C++ programming language and assembly language. Its aim is to provide a powerful yet intuitive
way of accessing, observing and modifying the debugging platform in which the application is running.

High-performance Embedded Workshop is a powerful development environment for embedded applications targeted at
microcontrollers. The main features are:

e A configurable build engine that allows you to set-up compiler, assembler and linker options via an easy to use
interface.

e An integrated text editor with user customizable syntax coloring to improve code readability.
e A configurable environment to run your own tools.

e An integrated debugger which allows you to build and debug in the same application.

e Version control support.

The High-performance Embedded Workshop has been designed with two key aims; firstly to provide you, the user, with a
set of powerful development tools and, secondly, to unify and present them in a way that is easy to use.

RENESAS



About This Manual

This manual is comprised of two parts: Hardware Part and Debugger Part.

Hardware Part: Preparation before use, hardware specifications, and troubleshooting procedure.
Debugger Part: A peculiar debugging function to the emulator, tutorial, Emulator software specification, and
notes.

This manual describes the debugging function for SH7058 E6000H Emulator debugger that used with the High-
performance Embedded Workshop.

For detailed information on the basic “look and feel” of the High-performance Embedded Workshop and customizing the
High-performance Embedded Workshop environment and the build and the debugging functions common to the High-
performance Embedded Workshop products, refer to the High-performance Embedded Workshop user's manual.

This manual does not intend to explain how to write C/C++ or assembly language programs, how to use any particular
operating system or how best to tailor code for the individual devices. These issues are left to the respective manuals.

Microsoft, MS-DOS, Windows, Windows NT are registered trademarks of Microsoft Corporation.
Visual SourceSafe is a trademark of Microsoft Corporation.
IBM is a registered trademark of International Business Machines Corporation.

All brand or product names used in this manual are trademarks or registered trademarks of their respective companies or
organizations.

Document Conventions
This manual uses the following typographic conventions:

Table 1 Typographic Conventions

Convention Meaning
[Menu->Menu Option] Bold text with ‘->" is used to indicate menu options
(for example, [File->Save As...]).
FILENAME.C Uppercase names are used to indicate filenames.
“enter this string” Used to indicate text that must be entered (excluding the “” quotes).
Key + Key Used to indicate required key presses. For example, CTRL+N means

press the CTRL key and then, whilst holding the CTRL key down,
press the N key.

) When this symbol is used, it is always located in the left-hand margin.
(The “how to” symbol) It indicates that the text to its immediate right is describing “how to”
do something.

Components

Check all the components described in the component list unpacking. If the components are not complete, contact a
Renesas sales office.
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1.1

N o wos

Section 1 Overview

Notes on Usage

CAUTION

READ the following warnings before using the emulator product.
Incorrect operation will damage the user system and the emulator
product. The USER PROGRAM will be LOST.

Check all components with the component list after unpacking the emulator.

Never place heavy objects on the casing.

Observe the following conditions in the area where the emulator is to be used:

e Make sure that the internal cooling fans on the sides of the emulator must be at least 20 cm (8") away
from walls or other equipment.

e Keep out of direct sunlight or heat. Refer to section 3.1, Environmental Conditions.

e Use in an environment with constant temperature and humidity.

e Protect the emulator from dust.

e Avoid subjecting the emulator to excessive vibration. Refer to section 3.1, Environmental Conditions.

Protect the emulator from excessive impacts and stresses.

Before using the emulator's power supply, check its specifications such as power voltage and frequency.

‘When moving the emulator, take care not to vibrate or otherwise damage it.

After connecting the cable, check that it is connected correctly. For details, refer to section 2, Preparation

before Use.

Supply power to the emulator and connected parts after connecting all cables. Cables must not be connected

or removed while the power is on.
For details on differences between the target MCU and the emulator, refer to section 3.5, Support of the
Target MCU.
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1.2 Emulator Hardware Components

The emulator consists of an E6000H station and an evaluation chip board. By installing a user system interface
board (option) on your host computer, the emulator can be connected in the same package as the device. PC
interface (option) includes a PC interface board (PCI bus and PC card bus), a LAN adapter (connected with the
network), and a USB adapter (connected with the USB interface). By connecting the emulator to the host
computer via those interfaces, the High-performance Embedded Workshop can be used for debugging. For
details on PC interface boards (available for PCI bus and PC card bus specifications), LAN adapter, and USB
adapter, refer to their description notes.

USB cable
USB adapter (option)
(option)
PC
PC interface PC interface cable
cable (option) (option)
% Network
LAN adapter
(option)

PC interface cable (option)

::l PC interface board (option)

6000

I
il
11/ E6000H station

o— Evaluation chip board

User system
W interface board

3
o~/

IC socket

User system

Figure 1.1 Emulator Hardware Components
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1.2.1 E6000H Station Components (A Part of Photos may be Different from Real Appearances)
The names of the components on the front/rear panel of the E6O00H station are listed below.

Front Panel:

EBDDOH

Figure 1.2 E6000H Station: Front Panel

(a) POWER lamp: Is lit up while the E6000H station is supplied with power.
(b) RUN lamp: Is lit up while the user program is running.
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Rear Panel:

i)
(b}
Figure 1.3 E6000H Station: Rear Panel
(a)  Power switch: Turning this switch to I (input) supplies power to
the emulator (E6000H station and evaluation chip
board).
(b)  AC power connector: For an AC 100-V to 240-V power supply.
(c) PC interface cable connector: For the PC interface cable that connects the

host computer to the E6000H station. A PC
interface board, PC card interface, LAN adapter,
or USB adapter can be connected. Marked PC/IF.
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1.2.2 Evaluation Chip Board Configuration

The names of the components on the evaluation chip board of the emulator are listed below.

(e}

(2) Bottom view of evaluation chip board

(3) Side wiew of evaluation chip board

Figure 1.4 Evaluation Chip Board

(a) Station to evaluation chip board This is a cover for protecting the connector that
interface connector cover: connects the E6000H station to the evaluation chip
board.
(b) Crystal oscillator terminals: For installing a crystal oscillator to be used as
an external clock source for the target MCU.
(c) HS7058PWB20H board: Connector to the trace cable is attached.
(d) HS7058PWB30H board: An evaluation chip is installed and a dedicated

connector to the user system interface board or
user system is attached.
(e) User system interface board For connecting the user system interface board or
connector: user system.

Note: (a) to (e) listed above are referred to as the evaluation chip board.
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1.2.3 Configuration of User System Interface Board

The names of the components of the user system interface board are given below.

(1) Top view of the HS70S8ECFE1H board (2) Bottom wiew of the HSTOS8ECFE1H board

Figure 1.5 Configuration of User System Interface Board

(a) Connector for the evaluation chip For connection to the evaluation chip board.
board:

(b) Connector for the user system: For connection to the user system.

6
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1.3 System Configuration

The emulator must be connected to a host computer (via the selected PC interface board).

1.3.1 System Configuration Using a PC Interface Board

The emulator can be connected to a host computer via a PC interface board (option: PCI bus or PC card bus).
Install the PC interface board to the expansion slot for the interface board in the host computer, and connect the
interface cable supplied with the PC interface board to the emulator. A LAN adapter can be used to connect the
emulator to a host computer as a network. A USB adapter can be used to connect the emulator to a host
computer with the USB interface. For details on PC interface boards (available for PCI bus and PC card bus
specifications), LAN adapter, and USB adapter, refer to their description notes. Figure 1.6 shows the
configuration of a system in which the PC interface board is used. Figure 1.7 shows the configuration of a
system in which the LAN adapter is used. Figure 1.8 shows the configuration of a system in which the USB
adapter is used.

Install the PC interface board to the
expansion slot for the PC interface board
in the host computer.

C]- PC interface board E6000H
emulator

PCIF

 — |

PC interface cable
:
—

Host computer

Figure 1.6 System Configuration Using a PC Interface Board

Network

E6000H
emulator

LAN adapter

Host computer

PC interface cable

Figure 1.7 System Configuration Using a LAN Adapter
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E6000H
emulator

PCIF

| — |

— | —
— | I |
[\ S8 adapter

Host computer

usB

Figure 1.8 System Configuration Using a USB Adapter
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Section 2 Preparation before Use

2.1 Description on Emulator Usage

This section describes the preparation before use of the emulator. Figure 2.1 is a flowchart on preparation before
debugging with the emulator.

CAUTION

Read this section and understand its contents before preparation.
Incorrect operation will damage the user system and the emulator.
The USER PROGRAM will be LOST.

Reference:

Connect the emulator. ‘ Described in this section. ‘
I

Set up the emulator on each OS. ‘ See the E6000H emulator setup guide.
I
Start debugging. ‘ See the Debugger Part. ‘

Figure 2.1 Emulator Preparation Flowchart
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2.2 Emulator Connection

2.2.1 Connecting the User System

AWARNING

Always switch OFF the emulator and user system before
connecting or disconnecting any CABLES. Failure to do so will result
in a FIRE HAZARD and will damage the user system and the emulator
or will result in PERSONAL INJURY. The USER PROGRAM will be
LOST.

Check that the emulator power switch is turned off. Ensure that the power lamp on the right side of the
E6000H station's front panel is not lit.

Remove the AC power cable of the E6000H station from the outlet (if the cable is connected to the outlet).

Connect pin 1 on the user system connector to the connector installed at the bottom of the E6000H user
system interface board. When connecting the connector, prevent the upper or lower side of the board from
lifting off the connector. Alternately tighten the screws on both sides of the board.
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2.2.2  Connecting the User System Interface Board

AWARNING

Always switch OFF the emulator and user system and check
pin numbers on the connectors and IC socket before connecting
or disconnecting the USER SYSTEM INTERFACE BOARD.
Connection with the power on or incorrect connection will damage
the emulator, user system interface board, and user system, and
result in a FIRE HAZARD.

For details on the method of connecting the user system interface board, refer to the descriptions of the user
system interface boards for individual SH7058 E6000H-series products.

Ewaluation chip
hoard

User systemn

: 1 Bt
interface board e “‘ mi‘_ru&

Figure 2.2 Connecting the User System Interface Board
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2.2.3 Connecting the External Probe

CAUTION

Check the external probe direction and connect the external probe
to the emulator station correctly. Incorrect connection will damage
the probe or connector.

When an external probe is connected to the external probe connector on the E6000H evaluation chip board, it
enables external signal tracing and multibreak detection. Figure 2.3 shows the external probe connector.

External probe

External probe

connectar
Pin No. _Probe Name _Signal Name Note
1 1 Probe input 1 Synchronous break
2 2 Probe input 2 input pin
3 3 Probe input 3
4 4 Probe input 4
5 5 GND GND connection pin
6 6 Trigger output Trigger mode output pin
7 7 GND GND connection pin
8 8 RUN or break High-level output at RUNSTEP
output
Figure 2.3 External Probe Connector
12
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224 Selecting the Clock

This emulator supports three types of clock for the target MCU: a crystal oscillator attached on the evaluation
chip board, external clock input from the user system, and the emulator internal clock. The clock is specified
with the [Configuration Properties] dialog box.

This emulator can use a clock source (¢) running at up to 80.0 MHz (eight times the external clock frequency of
10.0 MHz) as the MCU clock input. Select one of the followings:

Target External clock (clock signal supplied from the user system to the EXTAL pin):
5.0to 10.0 MHz

Xtal Crystal oscillator: 5.0 to 10.0 MHz

10 MHz Emulator internal clock

5 MHz Emulator internal clock

Crystal Oscillator: A crystal oscillator is not supplied with the emulator. Prepare and use one that has the same
frequency as that of the user system. When using a crystal oscillator as the target MCU clock source, the
frequency range must be from 5.0 to 10.0 MHz.

CAUTION

Always switch OFF the emulator and user system before
connecting or disconnecting the CRYSTAL OSCILLATOR.
Otherwise, the USER PROGRAM will be LOST.

Follow the procedure listed below to install the crystal oscillator:

1. Check that the emulator power switch is turned off. (Check that the power LED is not lit.)
2. Attach the crystal oscillator into the terminals on the evaluation chip board (figure 2.4).

3. Turn on the user system power and then the emulator power. Then the crystal oscillator will be automatically
set. This function will allow the execution of the user program at the operating frequency of the user system
even when the user system is not connected to the emulator.

13
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Enlarged
view

Crystal
oscillator

Crystal oscillator terminals

Evaluation chip
board

Figure 2.4 Installing the Crystal Oscillator
External Clock: Follow the procedure listed below to select the external clock.

1. Check that the emulator power switch is turned off. (Check that the power LED is not lit.)

2. Connect the evaluation chip board to the user system and supply a clock through the EXTAL pin from the
user system.

3. Turn on the user system power and then the emulator power. The external clock will then be automatically
set.

Emulator Internal Clock: Specify an emulator internal clock in the [Configuration Properties] dialog box.
Reference:

When the emulator system program is initiated, the emulator automatically selects the MCU clock source
according to the following priority:

1. User system’s clock when an external clock is supplied from the user system
2. Crystal oscillator when attached to the evaluation chip board
3. Emulator internal clock
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2.2.5 Connecting the System Ground

CAUTION

Separate the frame ground from the signal ground at the user
system. When the frame ground is connected to the signal ground
and the emulator is then connected to the user system, the emulator
will malfunction.

The emulator's signal ground is connected to the user system's signal ground via the evaluation chip board. In the
E6000H station, the signal ground and frame ground are connected (figure 2.5). At the user system, connect the
frame ground only; do not connect the signal ground to the frame ground.

If it is difficult to separate the frame ground from the signal ground in the user system, ground the frame to the
same outlet as the 100-V to 240-V power supply of the emulator station (figure 2.6) so that the ground potentials
become even.

Signal line

EG6000H station /Evaluation chip board User system
Logic I} A {> _| E A
e

/\

e

Power
supply Signal ground
ra

N

Frame ground

L

Ground

Figure 2.5 Connecting the System Ground

AWARNING

Always switch OFF the emulator and user system before
connecting or disconnecting any CABLES. Failure to do so will
result in a FIRE HAZARD and will damage the user system and the
emulator or will result in PERSONAL INJURY. The USER PROGRAM
will be LOST.

The user system must be connected to an appropriate ground so as to minimize noise and the adverse effects of
ground loops. When connecting the evaluation chip board and the user system, confirm that the ground pins of
the evaluation chip board are firmly connected to the user system's ground.

15
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Emulator power User system
supply cable power supply cable

!

Outlet \ e
Ground

100-V to 240-V AC power

—

Figure 2.6 Connecting the Frame Ground

2.2.6  PC Interface Board Specifications

For details on the PC interface board, LAN adapter, or USB adapter, refer to their description notes.
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Section 3 Hardware Specifications

3.1 Environmental Conditions

CAUTION

Observe the conditions listed in table 3.1 when using the emulator.
The following environmental conditions must be satisfied, otherwise
the user system and the emulator will not operate normally.

The USER PROGRAM will be LOST.

Table 3.1 Environmental Conditions

Item Specifications
Temperature Operating: +10 to +35°C
Storage: —10to +50°C
Humidity Operating: 35 to 80% RH, no condensation
Storage: 35 to 80% RH, no condensation
Vibration Operating: 2.45 m/s* max.
Storage: 4.9 m/s” max.
Transportation:  14.7 m/s® max.
AC input power Voltage: 100 Vto 240 V AC
Frequency: 50/60 Hz

Power consumption: 75 W

Ambient gases

There must be no corrosive gases present.

RENESAS
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3.2 Emulator External Dimensions and Mass

Figures 3.1 shows the external dimensions and mass of the E6000H emulator.

+ Extemal dimensions of the EBOODOH emulator station

2520

2220

Mats of the emdator 34 iy
Unit mm
Talerance: &0.0 mm

Figure 3.1 External Dimensions and Mass of the Emulator
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33 User System Interface Circuit

3.3.1 User System Interface Circuit

The circuits that interface the MCU in the emulator to the user system include buffers and resistors. When
connecting the emulator to a user system, adjust the user system hardware compensating for FANIN, FANOUT,
and propagation delays.

The AC timing values when using the emulator are shown in table 3.2.

Note: The values with the emulator connected, in table 3.2, are measurements for reference and are not
guaranteed values.

Table 3.2 Bus Timing when Using the Emulator (Bus Clock: 20.0 MHz)

MCU Specifications (ns) Values with Emulator Connected (ns)
Item Min Max Min Max
tRDS 15 — 18 —
tACC teyc x (n + 1.5) — 39 — teyc x (n+ 1.5) —45 —

(n is the number of (n is the number of

waits) waits)

The basic bus cycle (software wait) is shown in figure 3.2. The user system interface circuits connected to the
user system are shown in figures 3.3 to 3.8.

19
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tap
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A21 to AO X
( (]
tosp1 tespz|
_CSn \| ;
((
T
| trspy, toe tRsD2|
_RD ‘ ;‘
(When read) i
tacc tros ti‘EH
D15 to DO « JZ
(When read) ’
twsp1 twsp2  twr
BudAy
_WRx tas J 4
(When written) T «
twop twon

D15 to DO
(When written)

Note: tRDH: Specified from the earliest negation timing from A21 to A0, _CSn, or _RD.
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Figure 3.2 Basic Bus Cycle (Software Wait)
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MCU in the emulator User system

ALVCH16244A
HD151015 EPM7256AE
FWE FWE
MD2 MD2
MD1 MD1
MDO MDO

Figure 3.3 User System Interface Circuits (1)

MCU in the emulator User system
3 Vcce
4.7 kQ
ALVCH16244A
TDO NC ———— TDO
TRST TRST
TCK TCK
DI N
T™S T™MS
1kQ
_AUDRST Q53383 _AUDRST
AUDMD AUDMD
AUDSYNC AUDSYNC
AUDCK AUDCK
QS3383
AUDATAO AUDATAO
AUDATA1 AUDATA1
AUDATA2 AUDATA2
AUDAUA3 AUDAUA3
_WDTOVF . 4 _WDTOVF
VHC244

3 Vcc: 3.3-V power supplied from the emulator

Figure 3.4 User System Interface Circuits (2)
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MCU in the emulator User system

PF14/_BACK _BACK
PF15/_BREQ _BREQ
VHC244

LVT16244

PVccl

HD151015 | EPM7128AE  AHC14 AHC14 47 kQ

NMI ’ — NMI
LVTH16374
PVccl
EPM7128AE 47 KQ
_HSTBY ’ - _HSTBY
LVT16244
PVccl
AHC14 AHC14 47 KQ
— _RES

HD151015 EPM7128AE | EPM7128AE

_RES [+ —

Figure 3.5 User System Interface Circuits (3)
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MCU in the emulator

User system

3 Vce
T
3200 Q
PLLVcc PLLVCcL
300 Q 470 pF Lo1uF NC ~<—— PLLCAP

PLLCAP ! PLLVss
PLLVss 7%- 7JT

XTAL — NC NC — XTAL

EPM7128AE
EXTAL EXTAL
MAX709R
47 Q
LMC6484AIM — Vee
MAX709M
47 Q
3 Vce [+—wW\v— PVcc2
22 kQ
1kQ
PVccl
3 Vce
Vee
0.022 pF,
0.01 pF
v H
PVccl
PVcel
0.022 yF
;£ ]_ 0.01 pF
5 Vee
PVce2 T
0.022 uF #am uF
5 Vce
Avce 1_ J_ NC ~+—— AVcc
0.022 puF 0.01 pF
AVss jT
Avref Avref

3 Vcc: 3.3-V power supplied from the emulator
5 Vcc: 5-V power supplied from the emulator

Figure 3.6 User System Interface Circuits (4)
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MCU in the emulator

User system

PA (15:0)

PB (15:0)

PC4

PC (15:0)

PA (15:0)
PB (15:0)
PVccl
22 kQ
PC4 L 4 \ 4
VHC244
PC (15:0)
PD (13:0)

PD (13:0)

24

Figure 3.7 User System Interface Circuits (5)
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MCU in the emulator

PE (15:0)

AN (31:0)

PF8, PF (10:13)
PF15

PF14, PF9
PF (7:0)

PG (3:1)

FG
PH (15:0)
PJ (15:0)

PK (15:0)

PL12, PLO
PL (2:1)

PL13, PL (11:10)
PL (8:3), PL

User system

PE (15:0)
AN (3L1:0)
SN74S1053NS
PVccl
% 47K
. PF8, PG (13:10)
VHC244 PF15
PF14, PF9
PF (7:0)
PVccl
47K
® PG (3:1)
VHC244
FG
PH (15:0)
PJ (15:0)
PK (15:0)
PVccl
47K
. PL12, PLO
VHC244 PL@1)

PL13, PL (11:10)

PL (8:3), PL

Figure 3.8 User System Interface Circuits (6)
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3.3.2 Delay Time with the User System Interface

The delay time is generated on the timing of the _RES signal when it is input to the MCU from the user system,
as shown in table 3.3, because this connection for this signal is via logic circuit on the evaluation chip board.

Table 3.3 Delay Time for Signal Connected via the Evaluation Chip Board

Signal Name Delay Time (ns)

_RES 15.0

34 Connecting the Emulator to the User System

34.1 Connecting to the User System

AWARNING

Always switch OFF the emulator and user system before
connecting or disconnecting any CABLES.
Failure to do so will result in a FIRE HAZARD, and will
damage the user system or emulator or result in PERSONAL
INJURY. Also, the USER PROGRAM will be LOST.

The emulator is connected to the user system by using the user system interface board.

Table 3.4 User System Interface Board and User Interfaces

User System Interface Board User Interface
HS7058ECF61H FP-256H (TQPACK256RD)*
HS7058ECB61H BP-272 (CSPACK256Z2021H01)*

Note: The TQPACK and CSPACK series are manufactured by Tokyo Eletech Corporation.

26
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Installing IC Socket
1. Installing IC Socket
Install the IC socket for each package to the user system. After checking the location of pin 1 on the IC

socket, apply epoxy resin adhesive to the bottom of the IC, and fasten it to the user system before soldering.

2. Soldering IC Socket
After fastening, solder the IC socket to the user system. Be sure to completely solder the leads so that the
solder slops gently over the leads and forms solder fillets. (Use slightly more solder than the MCU.)

Connection Using the HS7058ECF61H

AWARNING

Always switch OFF the emulator and user system before
connecting or disconnecting any CABLES.
Failure to do so will result in a FIRE HAZARD, and will damage
the user system or emulator or result in PERSONAL INJURY.
Also, the USER PROGRAM will be LOST.

Notes: 1. For more details on the HS7058ECF61H, refer to the user’s manual supplied with the emulator.
2. This user system interface board can only be used in combination with the specified QFP socket
(TQPACK256RD).

Install the FP-256H IC socket (TQPACK256RD manufactured by Tokyo Eletech Corporation) on the user
system to connect the emulator. Since the pin assignment is the same as that of the actual MCU, refer to the
hardware manual.

Figures 3.9 to 3.11 show the connection of the HS7058 ECF61H, the size restrictions for the installed

components of the HS7058ECF61H, and the recommended mount pad dimensions of the user system IC socket,

respectively.

RENESAS
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Evaluation chip board

//~— User system interface board

T ~1—T—screw Pin 1
4~ IC socket connector

~—IC socket

User system

Figure 3.9 Connection Using the HS7058ECF61H

IC socket connector
(Tokyo Eletech Corporation

Evaluation chip board TQSOCKET256RDP)
|
S—— i ]
] —>
= 1=}
A ©
3
N
3 o
<
\ ‘{ Xy Y
IC socket )
(Tokyo Eletech Corporation Unit: mm
TQPACK256RD) Tolerance: +0.5 mm

User system

Figure 3.10 Restrictions on Component Installation
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30.20 (min.)

< 26.20 (max. »

0.50 x 51=2550+0.1 .
0.257 345

[ I T
|
E | :E —
| 1= P
| ‘ \\§§§§
T T e
| \ I -
L ‘ L
= | =N |
|
ffof \A
m__ - 10 '

Unit: mm
Tolerance: +0.3 unless otherwise specified

Figure 3.11 Recommended Mount Pad Dimensions of the User System IC Socket
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Connection Using the HS7058ECB61H

AWARNING

Always switch OFF the emulator and user system before
connecting or disconnecting any CABLES.
Failure to do so will result in a FIRE HAZARD, and will damage
the user system or emulator or result in PERSONAL INJURY.
Also, the USER PROGRAM will be LOST.

Notes: 1. For more details on the HS7058ECB61H, refer to the user’s manual supplied with the emulator.

2. This user system interface board can only be used in combination with the specified BGA socket
(CSPACK256Z2021H01).

Install the BP-272 IC socket (CSPACK256Z2021H01 manufactured by Tokyo Eletech Corporation) on the user
system to connect the emulator. Since the pin assignment is the same as that of the actual MCU, refer to the
hardware manual.

Figures 3.12 to 3.14 show the connection of the HS7058ECB61H, the size restrictions for the installed
components of the HS7058ECB61H, and the recommended mount pad dimensions of the user system IC socket,
respectively.

30
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Evaluation chip board

~— Board

A L
IC socket

User system

[

Figure 3.12 Connection Using the HS7058ECB61H

Evaluation chip board
|

A
~
]
[Ie}
\]
/ Unit: mm
IC socket Tolerance: £0.5 mm
(CSPACK256Z2021H01 manufactured by
User system Tokyo Eletech Corporation)

Figure 3.13 Restrictions on Component Installation
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Figure 3.14 Recommended Mount Pad D
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Connection Using the Dedicated Connector

AWARNING

Always switch OFF the emulator and user system before
connecting or disconnecting any CABLES.
Failure to do so will result in a FIRE HAZARD, and will damage
the user system or emulator or result in PERSONAL INJURY.
Also, the USER PROGRAM will be LOST.

Note: This evaluation chip board can only be used in combination with the specified dedicated connector (WD-

200P-VF85-N).

Install the dedicated connector (WD-200P-VF85-N manufactured by Japan Aviation Electronics Industry, Ltd.)
on the user system to connect the emulator. Figures 3.15 to 3.17 show connection using the dedicated connector,

size restrictions for the installed components, and the location for mounting the connector in the user system,
respectively.

RENESAS
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Evaluation chip board

Connector: WD-200P-VF85-N
(manufactured by Japan Aviation

@% Electronics Industry, Ltd.)
/ /

S

Figure 3.15 Connection Using the Dedicated Connector

Evaluation chip board
|

o~
i — [ — ©
= oo ~
2! 0
~

-y = N i°

\ Unit: mm
Connector: WD-200P-VF85-N Tolerance: +0.1 mm
User system (manufac_tured by Japan Aviation
Electronics Industry, Ltd.)
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Figure 3.16 Restrictions on Component Installation
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Hole for a connector (NTH) x 4

_ 100.0 _
» 83.0 _
A
| [0 ]
A
A
- &
3| g
Yy 2
=
-
(e}
] 6.0
\

Unit: mm
Tolerance: +0.1 mm

Figure 3.17 Location for Mounting the Connector in the User System

To design the foot pattern, refer to the catalog on WD-200P-VF85-N for dimensions.
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34.2 Pin Assignment on the User System Interface Connector
Table 3.5 lists the pin assignment on the user system interface connector of HS7058EPH60H.

Table 3.5 Pin Assignment on HS7058EPH60H

Userl/F1  Pin No. Signal Name UserI/F1  Pin No. Signal Name
UCN1 1 GND UCNT1 25 PF8/_WAIT

2 GND 26 GND

3 GND 27 GND

4 GND 28 PE7/A7

5 GND 29 PF7/_WRH

6 GND 30 PE6/A6

7 GND (TGBONT1) 31 PF6/_WRL

8 PE15/A15 32 PE5/A5

9 PF15/_BREQ 33 PF5/A21/_POD

10 PE14/A14 34 PE4/A4

11 PF14/_BACK 35 PF4/A20

12 PE13/A13 36 GND

13 PF13/_CS3 37 GND

14 PE12/A12 38 PE3/A3

15 PF12/_CS2 39 PF3/A19

16 GND 40 PE2/A2

17 GND 41 PF2/A18

18 PE11/A11 42 PE1/A1

19 PF11/_CS1 43 PF1/A17

20 PE10/A10 44 PEO/AO

21 PF10/_CS0 45 PFO/A16

22 PE9/A9 46 GND

23 PF9/_RD 47 GND

24 PE8/A8 48 PD13/PULS6/

HRxDO/HTxD1
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Table 3.5 Pin Assignment on HS7058EPH60H (cont)

Userl/F1  Pin No. Signal Name User I/F 1 Pin No. Signal Name
UCNT1 49 GND UCNT1 75 GND

50 PD12/PULS4 76 PD2/TIO1C

51 GND 77 GND

52 GND 78 PD1/TIO1B

53 GND 79 GND

54 PD11/PULS3 80 PDO/TIO1A

55 GND 81 AUDCK

56 PD10/PULS2 82 GND

57 GND 83 AUDMD

58 PD9/PULS1 84 PL13/_IRQOUT

59 GND 85 _AUDSYNC

60 PD8/PULSO 86 PL12/_IRQ4

61 GND 87 _AUDRST

62 GND 88 GND

63 GND 89 GND

64 PD7/TIO1H 90 PL11/HRxD/HRxD1/
HRxDO&HRxD1

65 GND 91 AUDATA3

66 PD6/TIO1G 92 PL10/HTxDO/
HTxD1/HTxDO&HTxD
1

67 GND 93 AUDATA2

68 PD5/TIO1F 94 PL9/SCK4/_IRQ5

69 GND 95 AUDATA1

70 PD4/TIO1E 96 PL8/SCK3

71 GND 97 AUDATAO

72 GND 98 GND

73 GND 99 N.C.

74 PD3/TIO1D 100 PL7/SCK2
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Table 3.5 Pin Assignment on HS7058EPH60H (cont)

Userl/F1  Pin No. Signal Name User I/F 1 Pin No. Signal Name
UCNT1 101 3Vee UCNT1 127 GND

102 PL6/ADEND 128 GND

103 3Vee 129 GND

104 PL5/_ADTRG1 130 PK11/TO8L

105 3Vee 131 GND

106 PL4/_ADTRGO 132 PK10/TO8K

107 3Vce 133 GND

108 GND 134 PK9/TO8J

109 3Vee 135 GND

110 PL3/TCLKB 136 PK8/TO8I

111 5Vce 137 N.C.

112 PL2/TIO11B/_IRQ7 138 GND

113 5Vce 139 N.C.

114 PL1/TIO11A/_IRQ6 140 PK7/TO8H

115 5Vce 141 N.C.

116 PLO/TI10 142 PK6/TO8G

117 5Vce 143 N.C.

118 GND 144 PK5/TO8F

119 5Vce 145 N.C.

120 PK15/TO8P 146 PK4/TO8E

121 5Vce 147 N.C.

122 PK14/TO80 148 GND

123 5Vce 149 N.C.

124 PK13/TO8N 150 PK3/TO8D

125 GND 151 N.C.

126 PK12/TO8M 152 PK2/TO8C
38
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Table 3.5 Pin Assignment on HS7058EPH60H (cont)

Userl/F1  Pin No. Signal Name User I/F 1 Pin No. Signal Name

UCNT1 153 N.C. UCNT1 177 GND
154 PK1/TO8B 178 GND
155 GND 179 GND
156 PKO/TO8A 180 PJ7/TIO2H
157 GND 181 GND
158 GND 182 PJ6/TIO2G
159 GND 183 GND
160 PJ15/TI9F 184 PJ5/TIO2F
161 GND 185 GND
162 PJ14/TI9E 186 PJ4/TIO2E
163 GND 187 PG3/_IRQ3/

_ADTRGO
164 PJ13/TI9D 188 GND
165 GND 189 PG2/_IRQ2/ADEND
166 PJ12/TI9C 190 PJ3/TI02D
167 GND 191 PG1/_IRQ1
168 GND 192 PJ2/TI02C
169 GND 193 PGO0/PULS7/HRxDO/
HRxD1

170 PJ11/TI9B 194 PJ1/TI02B
171 GND 195 GND
172 PJ10/TI9A 196 PJO/TIO2A
173 GND 197 GND
174 PJ9/TIO5D 198 GND
175 GND 199 GND
176 PJ8TIO5C 200 GND
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Table 3.5 Pin Assignment on HS7058EPH60H (cont)

Userl/F2 Pin No. Signal Name Userl/F2  Pin No. Signal Name
UCN2 1 GND UCN2 31 PH9/D9
2 GND 32 CK
3 GND 33 PH10/D10
4 GND 34 GND
5 GND 35 PH11/D11
6 GND 36 GND
7 GND 37 GND
8 GND 38 GND
9 PHO/DO 39 PH12/D12
10 FWE 40 GND
11 PH1/D1 41 PH13/D13
12 MD2 42 GND
13 PH2/D2 43 PH14/D14
14 MD1 44 GND
15 PH3/D3 45 PH15/D15
16 MDO 46 GND
17 GND 47 GND
18 GND 48 Vee
19 PH4/D4 49 GND
20 EXTAL 50 Vee
21 PH5/D5 51 GND
22 GND 52 Vee
23 PH6/D6 53 GND
24 _RES 54 PVcel
25 PH7/D7 55 GND
26 GND 56 PVceit
27 GND 57 GND
28 _HSTBY 58 PVceil
29 PH8/D8 59 GND
30 GND 60 PVcc2
40
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Table 3.5 Pin Assignment on HS7058EPH60H (cont)

User I/F 2 Pin No. Signal Name Userl/F2  Pin No. Signal Name

UCN2 61 GND UCN2 90 N.C.
62 PVcc2 91 GND
63 ANO 92 N.C.
64 PVcc2 93 AN12
65 AN1 94 N.C.
66 GND 95 AN13
67 AN2 96 N.C.
68 GND 97 AN14
69 AN3 98 N.C.
70 GND 99 AN15
71 GND 100 N.C.
72 GND 101 GND
73 AN4 102 AVce
74 GND 103 AN16
75 AN5 104 AVce
76 GND 105 AN17
77 AN6 106 AVce
78 N.C. 107 AN18
79 AN7 108 AVce
80 NMI 109 AN19
81 GND 110 AVref
82 N.C. 111 GND
83 AN8 112 AVref
84 N.C. 113 AN20
85 AN9 114 AVss
86 N.C. 115 AN21
87 AN10 116 AVss
88 N.C. 117 AN22
89 AN11 118 AVss
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Table 3.5 Pin Assignment on HS7058EPH60H (cont)

User I/F 2 Pin No. Signal Name Userl/F2  Pin No. Signal Name
UCN2 119 AN23 UCN2 146 GND
120 AVss 147 PA2/TIOC
121 GND 148 GND
122 GND 149 PA3/TIOD
123 AN24 150 GND
124 GND 151 GND
125 AN25 152 GND
126 _WDTOVF 153 PA4/TIO3A
127 AN26 154 GND
128 GND 155 PA5/TIO3B
129 AN27 156 PBO/TO6A
130 GND 157 PAG/TIO3C
131 GND 158 PB1/TO6B
132 GND 159 PA7/TIO3D
133 AN28 160 PB2/TO6C
134 GND 161 GND
135 AN29 162 PB3/TO6D
136 GND 163 PA8/TIO4A
137 AN30 164 GND
138 GND 165 PA9/TIO4B
139 AN31 166 PB4/TO7A/
TO8A
140 GND 167 PA10/TIO4C
141 GND 168 PB5/TO7B/
TO8B
142 GND 169 PA11/TIO4D
143 PAO/TIOA 170 PB6/TO7C/
TO8C
144 GND 171 GND
145 PA1/TIOB 172 PB7/TO7D/
TO8D
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Table 3.5 Pin Assignment on HS7058EPH60H (cont)

User I/F 2 Pin No. Signal Name Userl/F2  Pin No. Signal Name
UCN2 173 PA12/TIO5A UCN2 187 PC2/TxD2

174 GND 188 PB13/SCKO

175 PA13/TIO5B 189 PC3/RxD2

176 PB8/TxD3/ 190 PB14/SCK1/
TO8E TCLKB/TI10

177 PA14/TxDO 191 PC4/_IRQO

178 PB9/RxD3/ 192 PB15/PULS5/
TO8F SCK2

179 PA15/RxD0 193 GND

180 PB10/TxD4/ 194 GND
HTxDO/TO8G (TGBON2)

181 GND 195 GND

182 PB11/RxD4/ 196 GND
HRxDO/TO8H

183 PCO/TxD1 197 GND

184 GND 198 GND

185 PC1/RxD1 199 GND

186 PB12/TCLKA/ 200 GND
_UBCTRG
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343 Precautions on Connecting the User System
When connecting the evaluation chip board to the user system, note the following:

1. Secure the E6000H station location.
Place the E60O00H station and evaluation chip board so that the station to trace cable is not bent or twisted, as
shown below. A bent or twisted cable will impose stress on the user interface, leading to connection or
contact failure. Make sure that the E6GOOOH station is placed in a secure position so that it does not move and
impose stress on the user interface during use.

2. Make sure the power supply is off.
Before connecting the evaluation chip board to the user system, check that the emulator and the user system
are turned off.

3. Connect the Vcc, PVecl, and PVcec2 to the user system power.
The emulator monitors and decides whether the user system is turned on or off by the following Vcc pins:
(a) Connecting the dedicated connector for HS7058EPH60H
Vcc: Pins UCN2-48, UCN2-50, and UCN2-52
PVccl: Pins UCN2-54, UCN2-56, and UCN2-58
PVcc2: Pins UCN2-60, UCN2-62, and UCN2-64
(b) Connecting the user system interface board
Vcee, PVecel, and PVec?2 pins of each package
For the pin assignment, refer to the SH7058 series (F-ZTAT microcomputer) hardware manual.
Accordingly, after connecting the user system to the emulator, be sure to supply power to the Vcc pins.
Otherwise, the emulator assumes that the user system is not connected.
‘When the user system is connected, check that the power of the user system is supplied to these pins.
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35 Support of the Target MCU

3.5.1 Memory Space
The MCU has a 4-Gbyte memory space in its architecture.

On-Chip Flash Memory Area

e Access to the on-chip flash memory area

The emulator includes on-chip flash memory for the MCU. The on-chip flash memory is accessed in the mode
where the on-chip flash memory exists. The on-chip flash memory area access differs between user program
execution and the emulator commands.

Only read access is enabled during execution of the user program. A break does not occur if the on-chip flash
memory area is written to.

For access with emulator functions ((Memory] window or loading), read and write are always enabled.
The on-chip flash memory area is accessed in one state.

On-Chip I/O Area

If an attempt is made to access the on-chip I/O area, the on-chip I/O area in the MCU installed in the emulator is
accessed. To break the user program when the on-chip I/O area is written to or accessed, use the hardware break
or internal break.

External Memory Area

The MCU’s external memory area can be set with all memory attributes that the emulator supports.

Emulation RAM Area

The emulator includes the emulation RAM (16 kbytes x 16 blocks) for RAM emulation of the on-chip flash
memory. This emulation RAM (ERAM) can be used by overlapping with the on-chip flash memory address. If
an attempt is made to write the address that overlaps ERAM to the on-chip flash memory area, the address is
written by ERAM and a break does not occur.
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3.5.2 Low Power-Consumption Mode (Sleep, Software Standby, and Hardware Standby)
For reduced power consumption, the MCU has sleep, software standby, and hardware standby modes.

Hardware Standby Mode

Since the _HSTBY signal from the user system is not input to the MCU in the emulator, the emulator does not
support this mode.

Sleep and Software Standby Modes

e Break
The sleep and software standby modes can be cleared with either the normal clearing function or with the
break condition satisfaction (forced break), and the program breaks. When restarting after a break, the user
program will restart at the instruction following the SLEEP instruction.

e Trace
Trace information is not acquired in these modes.

e Memory access with emulator functions

For information on displaying and modifying the contents of memory in the sleep and software standby
modes, refer to section 5.4, Displaying and Modifying the Contents of Memory.

353 Interrupts
During execution and step execution, the user can interrupt the MCU.

During halting emulation (break mode), the interrupt source is retained. The mode transits the interrupt
processing immediately after emulation is restarted.

354 Control Input Signals (_RES, _BREQ, and _WAIT)
The MCU control input signals are _RES, _BREQ, and _WAIT.

The _RES signal is only valid when emulation has been started with normal program execution (i.e., the _RES
signal is invalid when emulation has been started with step execution). The _BREQ and _WAIT signals are valid
during emulation with the display and modification of memory contents, execution, and step execution. While
emulation is being halted (break), the input of the _RES, BREQ, or _WAIT signal to the MCU by the user
system is not possible.

The input of the _RES, _BREQ, or _WAIT signal during execution or step execution can be disabled by a
setting in the [Configuration Properties] dialog box.

3.5.5 Watchdog Timer (WDT)

While emulation is being halted (during break), counting up the WDT timer counter (TCNT) is suspended, and
restarted when emulation is executed again (user mode).

During break mode, a prescaler, which supplies a clock to TCNT, operates continuously. Since the phase of the
prescaler may be unmatched before or after emulation transits the break mode, the period before an overflow
occurs will differ by £1 cycle in the prescaler’s clock cycle.
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3.5.6 A/D Converter

The A/D converter has AVce, AVss, Avref, and _ADTRG pins as well as the analog input pins. As the A/D
converter operates with an independent power supply, connect AVcc (the power supply pin) to the A/D power
supply on the user system.

Notes: 1. When not using the A/D converter, connect AVcc to Vcec.

2. As the user system interface board, printed circuit boards, and protective circuits are connected
between the user system and the MCU installed on the evaluation chip board, the conversion
precision is lower than that of the SH7058 series MCU. At final debugging of the user system using
the A/D converter, use the actual SH7058 series (F-ZTAT microcomputer) MCU.

3.5.7 Emulator State and On-Chip Modules

Some on-chip modules do not operate when the emulator is in break mode. Table 3.6 shows the relation between
the emulator’s state and operation of the on-chip modules.

Table 3.6 Emulator State and Operation of On-Chip Modules

Operation During

Operation During Emulation
Emulation Halted (Execution or Step

Internal Module (Break) Execution)

UBC (user break controller) No Yes

DMAC (direct memory access controller) Yes Yes

ATU-Il (advanced timer unit) Yes Yes

APC (advanced pulse controller) Yes Yes

WDT (watchdog timer) No Yes

CMT (compare-match timer) Yes Yes

SCI (serial communication interface) Yes Yes

HCAN2 Yes Yes

A/D converter Yes Yes

AUD (advanced user debugger) Yes' Yes”

1/0 port Yes Yes

H-UDI (user debugging interface) Not available® Not available®

Notes: 1. The AUD can be used by the user or the emulator function. Therefore, when the AUD is used by the
emulator, it is not available for the user.

2. The user cannot use the H-UDI.
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3.5.8 Different Initial Values of Registers in the Emulator

Note that the emulator initializes some general or control registers whenever the system is activated or the MCU
is reset by commands.

Table 3.7 Initial Values of Registers in the MCU and the Emulator

Register Name

Emulator

Power On

Reset (Reset CPU)

MCU (Reset)

PC

Power-on reset vector
PC value

Power-on reset vector
PC value

Power-on reset vector
PC value

RO to R14 H'00000000 Value before reset Undefined

R15 (SP) Power-on reset vector Power-on reset vector Power-on reset vector
SP value SP value SP value

SR H'000000F0 H'000000FO0 H'00000XFX*

GBR H'00000000 Value before reset Undefined

VBR H'00000000 H'00000000 H'00000000

MACH H'00000000 Value before reset Undefined

MACL H'00000000 Value before reset Undefined

PR H'00000000 Value before reset Undefined

Note: X indicates an undefined value.
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Section 4 Diagnostic Test Procedure

This section describes the diagnostic test procedure using the E6G000H diagnostic program.

4.1 System Set-Up for Diagnostic Program Execution

To execute the diagnostic program, use the following hardware; do not connect the user system interface board
and user system.

E6000H (HS7058EPH60H)

Host computer

The E6000 PC interface board which will be one of the following boards:
PCI bus interface board (HS6000EICO1H or HS6000EIC02H)

PC card interface (HS6000EIPO1H)

LAN adapter (HS6000ELNO1H)

USB adapter (HS6000EIUO1H or HS6000EIU02H)

Install the E6000 PC interface board in the host computer and connect the supplied PC interface cable to the
board.

Connect the PC interface cable to the E6000H.

Connect the supplied AC power cable to the E6G000H.

Initiate the host computer to make it enter the command input wait state of the DOS prompt (Windows®
98SE or Windows® Me) or command prompt (Windows NT®, Windows® 2000, or Windows® XP). If the
property of the prompt window is not a mode for displaying the whole screen, press the [Alt + Enter] key to
switch the mode. To set back the mode, press the [Alt + Enter] key. The display of the screen is switched
regardless of the OS being used.

Note: In the MS-DOS prompt, if the display of the screen is not switched after pressing the [Alt + Enter] key,

mark the [Alt+Enter] check box in [Windows shortcut keys] of the [Misc] page on the [MS-DOS Prompt
Properties] dialog box and click the [Apply] button to update the settings, as shown in figure 4.1.
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M5-D0OS Prompt Properties

Figure 4.1 [Misc] Page
5. Turn on the E6000H emulator power switch.
Note: To execute the diagnostic program, firstly turn on the power of the emulator. In the diagnostic program,

the initial state of hardware is checked. Therefore, after the power is turned on, do not activate the High-
performance Embedded Workshop before executing the diagnostic program.
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4.2 Test Item of the Diagnostic Program

Table 4.1 shows the test items of this diagnostic program.

Table 4.1 Test Items of the Diagnostic Program

Test No. Test Item Description
1 Main Board Access Register test in the EG000H main board
2 Emulation Board Access Register test in the E6000H emulation
board
3 Evaluation Chip Board Access Register test in the EB000H evaluation
chip board
Basic Function Test for the basic function
5 GO to BREAK Time Measurement Test for the execution time
measurement function
6 Emulation Monitor Test for emulation monitor
G/A Break Function Test for the G/A break function
8 G/A Performance Analysis Function Test for the G/A performance
measurement function
9 G/A Monitor Function Test for the G/A monitoring function
10 G/A Parallel RAM Monitor Test for the G/A parallel RAM
monitoring function
11 G/A Trace Function Test for the G/A trace function
12 Combination Test for combination of each function
13 Parallel Access Test for the parallel access function
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4.3 Diagnostic Test Procedure Using the Diagnostic Program

Insert the CD-R (HS7058EPH60SR supplied with the E6000H) into the CD-ROM drive of the host computer,
move the current directory to <Drive>:\Diag\HS7058EPH60H with a command prompt, and enter one of the
following commands according to the PC interface board used to initiate the diagnostic program:

1. PCI bus interface board (HS6000EICO1H or HS6000EICO2H)
>TM?7058 —PCI (RET)

2. PC card interface (HS6000EIPO1H)
> TM7058 ~PCCD (RET)

3. LAN adapter (HS6000ELNO1H)
>TM7058 -ELN (RET)

4. USB adapter (HS6000EIUO1H or HS6000EIUO2H)
>TM7058 -USB (RET)

The High-performance Embedded Workshop must be installed before the test program is executed.

Be sure to initiate the diagnostic program from <Drive>:\Diag\HS7058 EPH60H. Do not initiate it from a
directory other than <Drive>:\Diag\HS7058 EPH60H, such as > <Drive>:\Diag\HS 7058 EPH60H\TM7058 -PCI
(RET). If the diagnostic program is initiated when the current directory is not <Drive>:\Diag\HS7058 EPH60H,
the diagnostic program will not operate correctly.

When -S is added to the command line such as > TM7058 —PCI -S (RET), steps 1 to 13 will be repeatedly
executed. To stop the execution, enter Q.

Notes: 1. <Drive> is a drive name for the CD-ROM drive.
2. Do not remove the CD-R from the CD-ROM drive during test program execution.
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The following messages are displayed during the test. There are 13 steps in this test (wWhen a PCI interface board

is used, the time for the test will be about three minutes).

Message

SH7058 E6000H Emulator Tests Vx.x.xXx

Loading driver .................... OK (Use PCI)
Initializing driver ....................... OK
Searching for interface card .............. OK
Checking emulator is connected ............ OK

Emulator board information:
Main board ID: H'0

Normal started at Tue Oct 07 16:52:05 2003

*x%*%%*x NORMAL TEST - Press 'Q'

to sStop **x**x*

1. Main Board Access

Emulation board ID:

Description

Test program start message. X.X
shows the version number.

Shows that the PC interface
board is correctly installed in
the host computer.

Shows that the E6000H
emulator is correctly connected
to the host computer.

H'001

Shows the ID number of the
E6000H emulator.

Shows the time when the
diagnostic program has started.

(COUNT=0001)

01) Registers Initial Value Check ............... i OK
02) Registers Write/Verify ....... ...ttt OK
03) DPRAM Address Decode TeSt ..............iiiiiunnnnnnnnnnnn. SKIP
04) DPRAM Marching Test ........... ... .. it iiiiiiiiiinnnnnn. SKIP
05) Trace Memory Address Decode TeSt . ...viiiiiiinnenennennnn OK
06) Trace Memory Marching Test ............... ... iiiininnnn.. OK
07) G/A Registers Initial Value Check ...........uuuuunnnnnnn.. OK
08) G/A Registers Write/Verify ... ... iiinn e innennn OK
2. Emulation Board Access
01) Registers Initial Value Check ............. ... it OK
02) Registers Write/Verify ....... ...ttt OK
03) H-UDI Interface Registers Initial Value Check ............. OK
04) H-UDI Interface Registers Write/Verify .................... OK
05) AUD Interface Registers Initial Value Check ............... OK
06) AUD Interface Registers Write/Verify....................... OK
07) AUD Interface Registers Address Decode TesSt ............... OK
08) PCKCR Registers Bit Test..... ..ttt OK
3. Evaluation Board Access
01) Registers Initial Value Check ..................iiiiunnn.. OK
02) Registers Write/Verify ....... ... ... OK
03) H-UDI IDCODE CheCk . .ttt ittt ettt e e e e OK
04) Firmware BOOT ... ...ttt ittt ittt e iae et OK
05) Configuration Set ........... ... .. . . . . ... i OK
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4. Basic
01)
02)
03)
04)
05)
06)
07)
5. GO to
01)
02)
03)
04)
05)
06)
07)
08)
09)

Function

GO £O BREAK ..ttt it e e e OK
RESET GO ..ttt ittt ittt et ettt e et et e e OK
S P .t i e e e e e e OK
KEYBREAK . . et et e e e OK
BRKCON T .ottt it e et et e et e et e e e OK
Internal ROM TeSE vttt OK
Internal RAM TeSt ... ..ttt et iiee s OK

BREAK Time Measurement

Counter Test MOde ... ...ttt OK
EMU 5MHz MPU 20MHz Sampling 20ns (Default) ................ OK
EMU 5MHz MPU 20MHz Sampling 1.6US ..............uuniunnn... OK
EMU 5MHz MPU 20MHz Sampling 52US ... ....ieuuneeunnennnnnn. OK
EMU 10MHz MPU 40MHz Sampling MPU ................uiiiuun.... OK
EMU 10MHz MPU 40MHz Sampling MPU/2 ............coiiuieeeen... OK
EMU 10MHz MPU 40MHz Sampling MPU/4 .. ... ....uuuiuinnenenn. . OK
EMU 5MHz MPU 20MHz Sampling 20NS ............ciiiuuiennnn... OK
EMU 10MHz MPU 80MHz Sampling 200S . .......cuuueeuneennnnnn. OK

6. Emulation Monitor

01)
02)
03)
04)
05)
06)

AUDRE S . .ttt OK
TRES .ot e OK
ASESTL = 0 ottt e e e e e e OK
VCC3VNG .ttt ittt it et it et et e it ettt e OK
VCC2-5VNG .+ttt ittt e it e e it et ettt e OK
O e OK

7. G/A Break Function

01)
02)
03)
04)
05)
06)
07)
08)
09)

Address Condition ....... ... e OK
Data Condition .......... ... ... ... OK
Control Signal Condition (ASEDSHH/HL/LH/HL) ............... OK
Function Code Condition (ASEBM1 ASESAS2-0) ................ OK
Control Signal Condition (ASEAS2-1) .........iiiiniinnnn... OK
Control Signal Condition (ASEIF-N) ..........iiuininininano.... OK
Control Signal Condition (ASEERAM-N) ...................... OK
Control Signal Condition (/DMA_AUD AEBMO) ................. OK
Control Signal Condition (ASEST1-0) ..., OK

8. G/A Performance Analysis Function

01)

Time Measurement (20ns Sampling) .................o.ooo.... OK

9. G/A Monitor Function

01)
02)
03)
04)

54

STEP/RUN . .ottt ittt e ettt e OK
VCCDOWN . oLttt ettt e e e OK
NOCLK oottt e e e et e e e OK
TIMEOUT ...ttt it it et it it ettt et e e e OK
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10. G/A Parallel RAM Monitor

01) PRAM Monitor (BYTE) . ......iiiiiitttttiiiiiiiiinnnnnn OK
02) PRAM Monitor (WORD) . ..........iiiitttttiiiiiinnnnnnn OK
03) PRAM Monitor (LONG WORD) ... .....iiiiiiiiinnnnnnns OK

11. G/A Trace Function

01) Free TIrACE ...ttt ittt ittt et i i i OK
02) TEACE SEOD t ottt ettt e e ettt e e e e et et et e OK
03) Time Stamp . ...... ..t OK
04) Trace SUPPLESS .ottt ittt ittt ittt ettt it i e e OK

12. Combination

01) B to A Time Measurement ( FPGA counter ) ................... OK
02) B to A Time Measurement ( G/A counter ) ............eeeenonn OK
03) D to C Time Measurement ( G/A counter ) ............uueeeenn. OK
13. Parallel Access
01) AUD Write (INROM BYTE) ..ttt ie i iaee i OK
02) AUD Write (INROM WORD) ..t tuiittie e tte e iee e eeeee e OK
03) AUD Write (INROM LONGWORD) ..t vvvitininiimneiinneinneeennn OK
04) AUD Write (INRAM BYTE) ..ttt ittt ettt iee e e eee e OK
05) AUD Write (INRAM WORD) ..t tuiimie e iie e iaeeiiane e OK
06) AUD Write (INRAM LONGWORD) ... ...itiiiiimmmnnnnnnnnnnnns OK
07) AUD Sample (INROM BYTE) ..ttt iuii e tie e eeaee e OK
08) AUD Sample (INROM WORD) ...ttt e iiaeeiinne i OK
09) AUD Sample (INROM LONGWORD) ... ...otiiiiiunnnnnnnnnnnnnnnns OK
10) AUD Sample (INRAM BYTE) . ...ttininiinenitneenneennnnnenns OK
11) AUD Sample (INRAM WORD) .. ttuittuit ettt e eee e e eeee oo OK
12) AUD Sample (INRAM LONGWORD) .. tvvitiuintinneinneenneeenns OK
13) AUD Sample 256p0int . ..... ... e OK

Normal stopped at Tue Oct 07 16:54:23 2003

Tests run for Oh:2min:18s

Summary :
Tests performed 1 time(s).

1. Main Board Access 0
2. Emulation Board Access 0
3. Evaluation Board Access 0
4. Basic Function 0
5. GO to BREAK Time Measurement 0
6. Emulation Monitor 0
7. G/A Break Function 0
8. G/A Performance Analysis Function 0
9. G/A Monitor Function 0
10. G/A Parallel RAM Monitor 0
11. G/A Trace Function 0
12. Combination 0
13. Parallel Access 0

Error (s)
Error (s)
Error (s)
Error (s)
Error (s)
Error (s)
Error (s)
Error (s)
Error (s)
Error (s)
Error (s)
Error (s)
Error (s)

RENESAS

Shows the time when the
diagnostic program has
ended.

Shows the execution time
of the diagnostic program.

Shows the total of the
number of errors occurred
in each test item.
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1.1

N o wos

Section 1 Overview

Notes on Usage

CAUTION

READ the following warnings before using the emulator product.
Incorrect operation will damage the user system and the emulator
product. The USER PROGRAM will be LOST.

Check all components with the component list after unpacking the emulator.

Never place heavy objects on the casing.

Observe the following conditions in the area where the emulator is to be used:

e Make sure that the internal cooling fans on the sides of the emulator must be at least 20 cm (8") away
from walls or other equipment.

e Keep out of direct sunlight or heat. Refer to section 3.1, Environmental Conditions.

e Use in an environment with constant temperature and humidity.

e Protect the emulator from dust.

e Avoid subjecting the emulator to excessive vibration. Refer to section 3.1, Environmental Conditions.

Protect the emulator from excessive impacts and stresses.

Before using the emulator's power supply, check its specifications such as power voltage and frequency.

‘When moving the emulator, take care not to vibrate or otherwise damage it.

After connecting the cable, check that it is connected correctly. For details, refer to section 2, Preparation

before Use.

Supply power to the emulator and connected parts after connecting all cables. Cables must not be connected

or removed while the power is on.
For details on differences between the target MCU and the emulator, refer to section 3.5, Support of the
Target MCU.
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1.2 Emulator Hardware Components

The emulator consists of an E6000H station and an evaluation chip board. By installing a user system interface
board (option) on your host computer, the emulator can be connected in the same package as the device. PC
interface (option) includes a PC interface board (PCI bus and PC card bus), a LAN adapter (connected with the
network), and a USB adapter (connected with the USB interface). By connecting the emulator to the host
computer via those interfaces, the High-performance Embedded Workshop can be used for debugging. For
details on PC interface boards (available for PCI bus and PC card bus specifications), LAN adapter, and USB
adapter, refer to their description notes. This emulator supports devices SH7058S and SH7059F.

USB cable
USB adapter (option)
(option)
PC
PC interface PC interface cable
cable (option) (option)
% Network
LAN adapter
(option)

PC interface cable (option)

::l PC interface board (option)

6000

I
il
11/ E6000H station

o— Evaluation chip board

User system
W interface board

[
IC socket

User system

Figure 1.1 Emulator Hardware Components
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1.2.1 E6000H Station Components (A Part of Photos may be Different from Real Appearances)
The names of the components on the front/rear panel of the E6O00H station are listed below.

Front Panel:

EBDDOH

Figure 1.2 E6000H Station: Front Panel

(a) POWER lamp: Is lit up while the E6000H station is supplied with power.
(b) RUN lamp: Is lit up while the user program is running.
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Rear Panel:

i)
(b}
Figure 1.3 E6000H Station: Rear Panel
(a)  Power switch: Turning this switch to I (input) supplies power to
the emulator (E6000H station and evaluation chip
board).
(b)  AC power connector: For an AC 100-V to 240-V power supply.
(c) PC interface cable connector: For the PC interface cable that connects the

host computer to the E6000H station. A PC
interface board, PC card interface, LAN adapter,
or USB adapter can be connected. Marked PC/IF.
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1.2.2 Evaluation Chip Board Configuration

The names of the components on the evaluation chip board of the emulator are listed below.

(e}

(b) (1) Top view of evaluation chip board

(e —>
(d) —»

(3 Side view of evaluation chip board

Figure 1.4 Evaluation Chip Board

(a) Station to evaluation chip board This is a cover for protecting the connector that
interface connector cover: connects the E6000H station to the evaluation chip
board.
(b) Crystal oscillator terminals: For installing a crystal oscillator to be used as
an external clock source for the target MCU.
(c) HS7059PWB20H board: Connector to the trace cable is attached.
(d) HS7059PWB30H board: An evaluation chip is installed and a dedicated

connector to the user system interface board or
user system is attached.

(e) User system interface board For connecting the user system interface board or
connector: user system.

Note: (a) to (e) listed above are referred to as the evaluation chip board.
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1.2.3 Configuration of User System Interface Board

The names of the components of the user system interface board are given below.

(1) Top view of the HS70S8ECFE1H board (2) Bottom wiew of the HSTOS8ECFE1H board

Figure 1.5 Configuration of User System Interface Board

(a) Connector for the evaluation chip For connection to the evaluation chip board.
board:

(b) Connector for the user system: For connection to the user system.

6
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1.3 System Configuration

The emulator must be connected to a host computer (via the selected PC interface board).

1.3.1 System Configuration Using a PC Interface Board

The emulator can be connected to a host computer via a PC interface board (option: PCI bus or PC card bus).
Install the PC interface board to the expansion slot for the interface board in the host computer, and connect the
interface cable supplied with the PC interface board to the emulator. A LAN adapter can be used to connect the
emulator to a host computer as a network. A USB adapter can be used to connect the emulator to a host
computer with the USB interface. For details on PC interface boards (available for PCI bus and PC card bus
specifications), LAN adapter, and USB adapter, refer to their description notes. Figure 1.6 shows the
configuration of a system in which the PC interface board is used. Figure 1.7 shows the configuration of a
system in which the LAN adapter is used. Figure 1.8 shows the configuration of a system in which the USB
adapter is used.

Install the PC interface board to the
expansion slot for the PC interface board
in the host computer.

C]- PC interface board E6000H
emulator

PCIF

 — |

PC interface cable
:
—

Host computer

Figure 1.6 System Configuration Using a PC Interface Board

Network

E6000H
emulator

LAN adapter

Host computer

PC interface cable

Figure 1.7 System Configuration Using a LAN Adapter
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E6000H
emulator

PCIF

| — |

— | —
— | I |
[\ S8 adapter

Host computer

usB

Figure 1.8 System Configuration Using a USB Adapter
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Section 2 Preparation before Use

2.1 Description on Emulator Usage

This section describes the preparation before use of the emulator. Figure 2.1 is a flowchart on preparation before
debugging with the emulator.

CAUTION

Read this section and understand its contents before preparation.
Incorrect operation will damage the user system and the emulator.
The USER PROGRAM will be LOST.

Reference:

Connect the emulator. ‘ Described in this section. ‘
I

Set up the emulator on each OS. ‘ See the E6000H emulator setup guide.
I
Start debugging. ‘ See the Debugger Part. ‘

Figure 2.1 Emulator Preparation Flowchart
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2.2 Emulator Connection

2.2.1 Connecting the User System

AWARNING

Always switch OFF the emulator and user system before
connecting or disconnecting any CABLES. Failure to do so will result
in a FIRE HAZARD and will damage the user system and the emulator
or will result in PERSONAL INJURY. The USER PROGRAM will be
LOST.

Check that the emulator power switch is turned off. Ensure that the power lamp on the right side of the
E6000H station's front panel is not lit.

Remove the AC power cable of the E6000H station from the outlet (if the cable is connected to the outlet).

Connect pin 1 on the user system connector to the connector installed at the bottom of the E6000H user
system interface board. When connecting the connector, prevent the upper or lower side of the board from
lifting off the connector. Alternately tighten the screws on both sides of the board.
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2.2.2  Connecting the User System Interface Board

AWARNING

Always switch OFF the emulator and user system and check
pin numbers on the connectors and IC socket before connecting
or disconnecting the USER SYSTEM INTERFACE BOARD.
Connection with the power on or incorrect connection will damage
the emulator, user system interface board, and user system, and
result in a FIRE HAZARD.

For details on the method of connecting the user system interface board, refer to the descriptions of the user
system interface boards for individual SH7059 E6000H-series products.

Ewaluation chip
hoard

User systemn

: 1 Bt
interface board e “‘ mi‘_ru&

Figure 2.2 Connecting the User System Interface Board
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2.2.3 Connecting the External Probe

the probe or connector.

CAUTION

Check the external probe direction and connect the external probe
to the emulator station correctly. Incorrect connection will damage

When an external probe is connected to the external probe connector on the E6000H evaluation chip board, it

enables external signal tracing and multibreak detection. Figure 2.3 shows the external probe connector.

External prakbe

External prake
cannector

Pin No. _Probe Name _Signal Name Note
Probe input 1 Synchronous break
Probe input 2 input pin

Probe input 3

Probe input 4

OIN|O|O |~ [WIN(F-
N[O |W[(N |-

GND GND connection pin

Trigger output Trigger mode output pin

GND GND connection pin

RUN or break High-level output at RUNSTEP
output

Figure 2.3 External Probe Connector
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224 Selecting the Clock

This emulator supports three types of clock for the target MCU: a crystal oscillator attached on the evaluation
chip board, external clock input from the user system, and the emulator internal clock. The clock is specified
with the [Configuration Properties] dialog box.

This emulator can use a clock source (¢) running at up to 80.0 MHz (eight times the external clock frequency of
10.0 MHz) as the MCU clock input. Select one of the followings:

Target External clock (clock signal supplied from the user system to the EXTAL pin):
5.0to 10.0 MHz

Xtal Crystal oscillator: 5.0 to 10.0 MHz

10 MHz Emulator internal clock

8 MHz Emulator internal clock

6 MHz Emulator internal clock

5 MHz Emulator internal clock

Crystal Oscillator: A crystal oscillator is not supplied with the emulator. Prepare and use one that has the same
frequency as that of the user system. When using a crystal oscillator as the target MCU clock source, the
frequency range must be from 5.0 to 10.0 MHz.

CAUTION

Always switch OFF the emulator and user system before
connecting or disconnecting the CRYSTAL OSCILLATOR.
Otherwise, the USER PROGRAM will be LOST.

Follow the procedure listed below to install the crystal oscillator:

1. Check that the emulator power switch is turned off. (Check that the power LED is not lit.)

2. Attach the crystal oscillator into the terminals on the evaluation chip board (figure 2.4).

3. Turn on the user system power and then the emulator power. Then the crystal oscillator will be automatically
set. This function will allow the execution of the user program at the operating frequency of the user system
even when the user system is not connected to the emulator.

13
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Enlarged
view

Crystal
oscillator

Crystal oscillator terminals

Evaluation chip
board

Figure 2.4 Installing the Crystal Oscillator
External Clock: Follow the procedure listed below to select the external clock.

1. Check that the emulator power switch is turned off. (Check that the power LED is not lit.)

2. Connect the evaluation chip board to the user system and supply a clock through the EXTAL pin from the
user system.

3. Turn on the user system power and then the emulator power. The external clock will then be automatically
set.

Emulator Internal Clock: Specify an emulator internal clock in the [Configuration Properties] dialog box.
Reference:

When the emulator system program is initiated, the emulator automatically selects the MCU clock source
according to the following priority:

1. User system’s clock when an external clock is supplied from the user system
2. Crystal oscillator when attached to the evaluation chip board
3. Emulator internal clock
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2.2.5 Connecting the System Ground

CAUTION

Separate the frame ground from the signal ground at the user
system. When the frame ground is connected to the signal ground
and the emulator is then connected to the user system, the emulator
will malfunction.

The emulator's signal ground is connected to the user system's signal ground via the evaluation chip board. In the
E6000H station, the signal ground and frame ground are connected (figure 2.5). At the user system, connect the
frame ground only; do not connect the signal ground to the frame ground.

If it is difficult to separate the frame ground from the signal ground in the user system, ground the frame to the
same outlet as the 100-V to 240-V power supply of the emulator station (figure 2.6) so that the ground potentials
become even.

Signal line

EG6000H station /Evaluation chip board User system
Logic I} A {> _| E A
e

/\

e

Power
supply Signal ground
ra

N

Frame ground

L

Ground

Figure 2.5 Connecting the System Ground

AWARNING

Always switch OFF the emulator and user system before
connecting or disconnecting any CABLES. Failure to do so will
result in a FIRE HAZARD and will damage the user system and the
emulator or will result in PERSONAL INJURY. The USER PROGRAM
will be LOST.

The user system must be connected to an appropriate ground so as to minimize noise and the adverse effects of
ground loops. When connecting the evaluation chip board and the user system, confirm that the ground pins of
the evaluation chip board are firmly connected to the user system's ground.

15
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Emulator power User system
supply cable power supply cable

!

Outlet \ e
Ground

100-V to 240-V AC power

—

Figure 2.6 Connecting the Frame Ground

2.2.6  PC Interface Board Specifications

For details on the PC interface board, LAN adapter, or USB adapter, refer to their description notes.

RENESAS




Section 3 Hardware Specifications

3.1 Environmental Conditions

CAUTION

Observe the conditions listed in table 3.1 when using the emulator.
The following environmental conditions must be satisfied, otherwise
the user system and the emulator will not operate normally.

The USER PROGRAM will be LOST.

Table 3.1 Environmental Conditions

Item Specifications
Temperature Operating: +10 to +35°C
Storage: —10to +50°C
Humidity Operating: 35 to 80% RH, no condensation
Storage: 35 to 80% RH, no condensation
Vibration Operating: 2.45 m/s* max.
Storage: 4.9 m/s” max.
Transportation:  14.7 m/s® max.
AC input power Voltage: 100 Vto 240 V AC
Frequency: 50/60 Hz

Power consumption: 75 W

Ambient gases

There must be no corrosive gases present.

RENESAS
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3.2 Emulator External Dimensions and Mass

Figures 3.1 shows the external dimensions and mass of the E6000H emulator.

+ Extemal dimensions of the EBOODOH emulator station

2520

2220

Mass of (he smulstor: 3.4 ky
Unk mim
Teterance. £1.0 mm

Figure 3.1 External Dimensions and Mass of the Emulator
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33 User System Interface Circuit

3.3.1 User System Interface Circuit

The circuits that interface the MCU in the emulator to the user system include buffers and resistors. When
connecting the emulator to a user system, adjust the user system hardware compensating for FANIN, FANOUT,
and propagation delays.

The AC timing values when using the emulator are shown in table 3.2.

Note: The values with the emulator connected, in table 3.2, are measurements for reference and are not
guaranteed values.

Table 3.2 Bus Timing when Using the Emulator (Bus Clock: 20.0 MHz)

MCU Specifications (ns) Values with Emulator Connected (ns)
Item Min Max Min Max
tRDS 15 — 18 —
tACC teyc x (n + 1.5) — 39 — teyc x (n+ 1.5) —45 —

(n is the number of (n is the number of

waits) waits)

The basic bus cycle (software wait) is shown in figure 3.2. The user system interface circuits connected to the
user system are shown in figures 3.3 to 3.8.

19
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T4

Vo ) S— —
tap
( (]
A21 to AO X
( (]
tosp1 tespz|
_CSn \| ;
((
T
| trspy, toe tRsD2|
_RD ‘ ;‘
(When read) i
tacc tros ti‘EH
D15 to DO « JZ
(When read) ’
twsp1 twsp2  twr
BudAy
_WRx tas J 4
(When written) T «
twop twon

D15 to DO
(When written)

Note: tRDH: Specified from the earliest negation timing from A21 to A0, _CSn, or _RD.
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Figure 3.2 Basic Bus Cycle (Software Wait)
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MCU in the emulator

User system

LVTH16244A
HD151015 EPIS20
FWE FWE
MD2 MD2
MD1 MD1
MDO MDO
Figure 3.3 User System Interface Circuits (1)
MCU in the emulator User system
3 Vee
4.7 kQ
LVTH16244A
TDO NC ————— TDO
TRST TRST
TCK TCK
TDI NG = ol
T™S T™S
1kQ
_AUDRST Qs3383 _AUDRST
AUDMD AUDMD
AUDSYNC AUDSYNC
AUDCK AUDCK
QS3383
AUDATAO AUDATAO
AUDATA1 AUDATA1
AUDATA2 AUDATA2
AUDAUA3 AUDAUA3
_WDTOVF 4 _WDTOVF
VHC244

L

3 Vce: 3.3-V power supplied from the emulator

Figure 3.4 User System Interface Circuits (2)

RENESAS




MCU in the emulator

User system

PF14/_BACK _BACK
PF15/_BREQ _BREQ
VHC244
ALVCH16374
PVcct
HD151015 | EPIS20 AHC14  AHC14 247kQ
NMI & ¢ — NMI
LVTH16374
PVceil
EPIS20 47kQ
HSTBY > &— _HSTBY
LVT16244
PVcci
AHC14  AHC14 47KO
— _RES
HD151015  EPIS20 |ALVCH16244A
_RES [+ —

Figure 3.5 User System Interface Circuits (3)
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MCU in the emulator

User system

EXTAL

3 Vce
3200 Q
PLLVce PLLVcL
300 Q 470 pF Lot NG <—— PLLCAP
PLLCAP T PLLVss
PLLVss 7J7- 7J7-
XTAL |—= NG NG — XTAL

Vee

Vss

PVcet

EPIS20
EXTAL
MAX709R
47 Q
LMC6484AIM Veo
MAX709M
47Q
3 Vce [+—wW\— PVcc2
22 kQ
1 kQ
PVcel
3 Vce
0.022 uF
I i 0.01 pF
PVcet
0.022 uF
;g " T 0.01 uF
5Vce

PVcc2

]
|_

0.022 pF 0.01 pF

)

o
<
Q
s

AVce

AVss

AVref

_

NC «+—— AVce

B
|_

0.022 pF 0.01 pF

)

AVref

3 Vcc: 3.3-V power supplied from the emulator
5 Vcce: 5-V power supplied from the emulator

Figure 3.6 User System Interface Circuits (4)
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MCU in the emulator

PA (15:0)
PB (15:0)
PVcei
22 kQ
PC4 \ 4 \ 4
VHC244
PC (15:0)
PD (13:0)

User system

PA (15:0)

PB (15:0)

PC4

PC (15:0)

PD (13:0)

24

Figure 3.7 User System Interface Circuits (5)
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MCU in the emulator

PE (15:0)

AN (31:0)

PF8, PF (10:13)
PF15

PF14, PF9
PF (7:0)

PG (3:1)

FGo
PH (15:0)
PJ (15:0)

PK (15:0)

PL12, PL9
PL (2:1)

PL13, PL (11:10)
PL (8:3), PLo

User system

PE (15:0)
AN (31:0)
SN7451053NS
PVcet
f 47 kKQ
® PF8, PG (13:10)
VHC244 PF15
PF14, PF9
PF (7:0)
PVccl
f 47 kQ
O PG (3:1)
VHC244
FGo
PH (15:0)
PJ (15:0)
PK (15:0)
PVecl
47 kQ
® PL12, PL9
VHC244 PL (2:1)

PL13, PL (11:10)

PL (8:3), PLo

Figure 3.8 User System Interface Circuits (6)
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3.3.2 Delay Time with the User System Interface

The delay time is generated on the timing of the _RES signal when it is input to the MCU from the user system,
as shown in table 3.3, because this connection for this signal is via logic circuit on the evaluation chip board.

Table 3.3 Delay Time for Signal Connected via the Evaluation Chip Board

Signal Name Delay Time (ns)

_RES 15.0

34 Connecting the Emulator to the User System

34.1 Connecting to the User System

AWARNING

Always switch OFF the emulator and user system before
connecting or disconnecting any CABLES.
Failure to do so will result in a FIRE HAZARD, and will
damage the user system or emulator or result in PERSONAL
INJURY. Also, the USER PROGRAM will be LOST.

The emulator is connected to the user system by using the user system interface board.

Table 3.4 User System Interface Board and User Interfaces

User System Interface Board User Interface
HS7058ECF61H FP-256H (TQPACK256RD)*
HS7058ECB61H BP-272 (CSPACK256Z2021H01)*

Note: The TQPACK and CSPACK series are manufactured by Tokyo Eletech Corporation.

26
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Installing IC Socket
1. Installing IC Socket
Install the IC socket for each package to the user system. After checking the location of pin 1 on the IC

socket, apply epoxy resin adhesive to the bottom of the IC, and fasten it to the user system before soldering.

2. Soldering IC Socket
After fastening, solder the IC socket to the user system. Be sure to completely solder the leads so that the
solder slops gently over the leads and forms solder fillets. (Use slightly more solder than the MCU.)

Connection Using the HS7058ECF61H

AWARNING

Always switch OFF the emulator and user system before
connecting or disconnecting any CABLES.
Failure to do so will result in a FIRE HAZARD, and will damage
the user system or emulator or result in PERSONAL INJURY.
Also, the USER PROGRAM will be LOST.

Notes: 1. For more details on the HS7058ECF61H, refer to the user’s manual supplied with the emulator.
2. This user system interface board can only be used in combination with the specified QFP socket
(TQPACK256RD).

Install the FP-256H IC socket (TQPACK256RD manufactured by Tokyo Eletech Corporation) on the user
system to connect the emulator. Since the pin assignment is the same as that of the actual MCU, refer to the
hardware manual.

Figures 3.9 to 3.11 show the connection of the HS7058 ECF61H, the size restrictions for the installed

components of the HS7058ECF61H, and the recommended mount pad dimensions of the user system IC socket,

respectively.

RENESAS
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Evaluation chip board

T @~T—T—sScrew Pin 1
4~ IC socket connector

#~— IC socket

User system

Figure 3.9 Connection Using the HS7058ECF61H

IC socket connector
(Tokyo Eletech Corporation

Evaluation chip board TQSOCKET256RDP)
|
— i ]
I 1) —— &
= 1=}
A o
3
o
3 N
<
\ ‘{ Sy '
IC socket )
(Tokyo Eletech Corporation Unit: mm
TQPACK256RD) Tolerance: £0.5 mm

User system

Figure 3.10 Restrictions on Component Installation
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30.20 (min.)

< 26.20 (max. »

0.50 x 51=2550+0.1 .
0.257 345

[ I T
|
E | :E —
| 1= P
| ‘ \\§§§§
T T e
| \ I -
L ‘ L
= | =N |
|
ffof \A
m__ - 10 '

Unit: mm
Tolerance: +0.3 unless otherwise specified

Figure 3.11 Recommended Mount Pad Dimensions of the User System IC Socket

RENESAS
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Connection Using the HS7058ECB61H

AWARNING

Always switch OFF the emulator and user system before
connecting or disconnecting any CABLES.
Failure to do so will result in a FIRE HAZARD, and will damage
the user system or emulator or result in PERSONAL INJURY.
Also, the USER PROGRAM will be LOST.

Notes: 1. For more details on the HS7058ECB61H, refer to the user’s manual supplied with the emulator.

2. This user system interface board can only be used in combination with the specified BGA socket
(CSPACK256Z2021H01).

Install the BP-272 IC socket (CSPACK256Z2021H01 manufactured by Tokyo Eletech Corporation) on the user
system to connect the emulator. Since the pin assignment is the same as that of the actual MCU, refer to the
hardware manual.

Figures 3.12 to 3.14 show the connection of the HS7058ECB61H, the size restrictions for the installed
components of the HS7058ECB61H, and the recommended mount pad dimensions of the user system IC socket,
respectively.

30

RENESAS



Evaluation chip board

~— Board

User system

[

Figure 3.12 Connection Using the HS7058ECB61H

Evaluation chip board
|

15

/ Unit: mm
Tolerance: 0.5 mm

IC socket
(CSPACK25672021H01 manufactured by

User system Tokyo Eletech Corporation)

Figure 3.13 Restrictions on Component Installation
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Connection Using the Dedicated Connector

AWARNING

Always switch OFF the emulator and user system before
connecting or disconnecting any CABLES.
Failure to do so will result in a FIRE HAZARD, and will damage
the user system or emulator or result in PERSONAL INJURY.
Also, the USER PROGRAM will be LOST.

Note: This evaluation chip board can only be used in combination with the specified dedicated connector (WD-

200P-VF85-N).

Install the dedicated connector (WD-200P-VF85-N manufactured by Japan Aviation Electronics Industry, Ltd.)
on the user system to connect the emulator. Figures 3.15 to 3.17 show connection using the dedicated connector,

size restrictions for the installed components, and the location for mounting the connector in the user system,
respectively.
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Evaluation chip board

Connector: WD-200P-VF85-N
(manufactured by Japan Aviation

@% Electronics Industry, Ltd.)
/ |

Y

Figure 3.15 Connection Using the Dedicated Connector

Evaluation chip board
|

o~
i | o
= oo <
o -
~

2 o N 20 ¥

\ Unit: mm
Connector: WD-200P-VF85-N Tolerance: 0.1 mm

User system (manufac_tured by Japan Aviation
Electronics Industry, Ltd.)
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Figure 3.16 Restrictions on Component Installation
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Hole for a connector (NTH) x 4
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Unit: mm
Tolerance: +0.1 mm

Figure 3.17 Location for Mounting the Connector in the User System

To design the foot pattern, refer to the catalog on WD-200P-VF85-N for dimensions.
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34.2 Pin Assignment on the User System Interface Connector
Table 3.5 lists the pin assignment on the user system interface connector of HS7059EPH60H.

Table 3.5 Pin Assignment on HS7059EPH60H

Userl/F1  Pin No. Signal Name UserI/F1  Pin No. Signal Name
UCN1 1 GND UCNT1 25 PF8/_WAIT

2 GND 26 GND

3 GND 27 GND

4 GND 28 PE7/A7

5 GND 29 PF7/_WRH

6 GND 30 PE6/A6

7 GND (TGBONT1) 31 PF6/_WRL

8 PE15/A15 32 PE5/A5

9 PF15/_BREQ 33 PF5/A21/_POD

10 PE14/A14 34 PE4/A4

11 PF14/_BACK 35 PF4/A20

12 PE13/A13 36 GND

13 PF13/_CS3 37 GND

14 PE12/A12 38 PE3/A3

15 PF12/_CS2 39 PF3/A19

16 GND 40 PE2/A2

17 GND 41 PF2/A18

18 PE11/A11 42 PE1/A1

19 PF11/_CS1 43 PF1/A17

20 PE10/A10 44 PEO/AO

21 PF10/_CS0 45 PFO/A16

22 PE9/A9 46 GND

23 PF9/_RD 47 GND

24 PE8/A8 48 PD13/PULS6/

HRxDO/HTxD1
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Table 3.5 Pin Assignment on HS7059EPH60H (cont)

Userl/F1  Pin No. Signal Name User I/F 1 Pin No. Signal Name
UCNT1 49 GND UCNT1 75 GND

50 PD12/PULS4 76 PD2/TIO1C

51 GND 77 GND

52 GND 78 PD1/TIO1B

53 GND 79 GND

54 PD11/PULS3 80 PDO/TIO1A

55 GND 81 AUDCK

56 PD10/PULS2 82 GND

57 GND 83 AUDMD

58 PD9/PULS1 84 PL13/_IRQOUT

59 GND 85 _AUDSYNC

60 PD8/PULSO 86 PL12/_IRQ4

61 GND 87 _AUDRST

62 GND 88 GND

63 GND 89 GND

64 PD7/TIO1H 90 PL11/HRxD/HRxD1/
HRxDO&HRxD1

65 GND 91 AUDATA3

66 PD6/TIO1G 92 PL10/HTxDO/
HTxD1/HTxDO&HTxD
1

67 GND 93 AUDATA2

68 PD5/TIO1F 94 PL9/SCK4/_IRQ5

69 GND 95 AUDATA1

70 PD4/TIO1E 96 PL8/SCK3

71 GND 97 AUDATAO

72 GND 98 GND

73 GND 99 N.C.

74 PD3/TIO1D 100 PL7/SCK2
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Table 3.5 Pin Assignment on HS7059EPH60H (cont)

Userl/F1  Pin No. Signal Name User I/F 1 Pin No. Signal Name
UCNT1 101 3Vee UCNT1 127 GND

102 PL6/ADEND 128 GND

103 3Vee 129 GND

104 PL5/_ADTRG1 130 PK11/TO8L

105 3Vee 131 GND

106 PL4/_ADTRGO 132 PK10/TO8K

107 3Vce 133 GND

108 GND 134 PK9/TO8J

109 3Vee 135 GND

110 PL3/TCLKB 136 PK8/TO8I

111 5Vce 137 N.C.

112 PL2/TIO11B/_IRQ7 138 GND

113 5Vce 139 N.C.

114 PL1/TIO11A/_IRQ6 140 PK7/TO8H

115 5Vce 141 N.C.

116 PLO/TI10 142 PK6/TO8G

117 5Vce 143 N.C.

118 GND 144 PK5/TO8F

119 5Vce 145 N.C.

120 PK15/TO8P 146 PK4/TO8E

121 5Vce 147 N.C.

122 PK14/TO80 148 GND

123 5Vce 149 N.C.

124 PK13/TO8N 150 PK3/TO8D

125 GND 151 N.C.

126 PK12/TO8M 152 PK2/TO8C
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Table 3.5 Pin Assignment on HS7059EPH60H (cont)

Userl/F1  Pin No. Signal Name User I/F 1 Pin No. Signal Name

UCNT1 153 N.C. UCNT1 177 GND
154 PK1/TO8B 178 GND
155 GND 179 GND
156 PKO/TO8A 180 PJ7/TIO2H
157 GND 181 GND
158 GND 182 PJ6/TIO2G
159 GND 183 GND
160 PJ15/TI9F 184 PJ5/TIO2F
161 GND 185 GND
162 PJ14/TI9E 186 PJ4/TIO2E
163 GND 187 PG3/_IRQ3/

_ADTRGO
164 PJ13/TI9D 188 GND
165 GND 189 PG2/_IRQ2/ADEND
166 PJ12/TI9C 190 PJ3/TI02D
167 GND 191 PG1/_IRQ1
168 GND 192 PJ2/TI02C
169 GND 193 PGO0/PULS7/HRxDO/
HRxD1

170 PJ11/TI9B 194 PJ1/TI02B
171 GND 195 GND
172 PJ10/TI9A 196 PJO/TIO2A
173 GND 197 GND
174 PJ9/TIO5D 198 GND
175 GND 199 GND
176 PJ8TIO5C 200 GND
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Table 3.5 Pin Assignment on HS7059EPH60H (cont)

Userl/F2 Pin No. Signal Name Userl/F2  Pin No. Signal Name
UCN2 1 GND UCN2 31 PH9/D9
2 GND 32 CK
3 GND 33 PH10/D10
4 GND 34 GND
5 GND 35 PH11/D11
6 GND 36 GND
7 GND 37 GND
8 GND 38 GND
9 PHO/DO 39 PH12/D12
10 FWE 40 GND
11 PH1/D1 41 PH13/D13
12 MD2 42 GND
13 PH2/D2 43 PH14/D14
14 MD1 44 GND
15 PH3/D3 45 PH15/D15
16 MDO 46 GND
17 GND 47 GND
18 GND 48 Vee
19 PH4/D4 49 GND
20 EXTAL 50 Vee
21 PH5/D5 51 GND
22 GND 52 Vee
23 PH6/D6 53 GND
24 _RES 54 PVcel
25 PH7/D7 55 GND
26 GND 56 PVceit
27 GND 57 GND
28 _HSTBY 58 PVceil
29 PH8/D8 59 GND
30 GND 60 PVcc2
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Table 3.5 Pin Assignment on HS7059EPH60H (cont)

User I/F 2 Pin No. Signal Name Userl/F2  Pin No. Signal Name

UCN2 61 GND UCN2 90 N.C.
62 PVcc2 91 GND
63 ANO 92 N.C.
64 PVcc2 93 AN12
65 AN1 94 N.C.
66 GND 95 AN13
67 AN2 96 N.C.
68 GND 97 AN14
69 AN3 98 N.C.
70 GND 99 AN15
71 GND 100 N.C.
72 GND 101 GND
73 AN4 102 AVce
74 GND 103 AN16
75 AN5 104 AVce
76 GND 105 AN17
77 AN6 106 AVce
78 N.C. 107 AN18
79 AN7 108 AVce
80 NMI 109 AN19
81 GND 110 AVref
82 N.C. 111 GND
83 AN8 112 AVref
84 N.C. 113 AN20
85 AN9 114 AVss
86 N.C. 115 AN21
87 AN10 116 AVss
88 N.C. 117 AN22
89 AN11 118 AVss
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Table 3.5 Pin Assignment on HS7059EPH60H (cont)

User I/F 2 Pin No. Signal Name Userl/F2  Pin No. Signal Name
UCN2 119 AN23 UCN2 146 GND
120 AVss 147 PA2/TIOC
121 GND 148 GND
122 GND 149 PA3/TIOD
123 AN24 150 GND
124 GND 151 GND
125 AN25 152 GND
126 _WDTOVF 153 PA4/TIO3A
127 AN26 154 GND
128 GND 155 PA5/TIO3B
129 AN27 156 PBO/TO6A
130 GND 157 PAG/TIO3C
131 GND 158 PB1/TO6B
132 GND 159 PA7/TIO3D
133 AN28 160 PB2/TO6C
134 GND 161 GND
135 AN29 162 PB3/TO6D
136 GND 163 PA8/TIO4A
137 AN30 164 GND
138 GND 165 PA9/TIO4B
139 AN31 166 PB4/TO7A/
TO8A
140 GND 167 PA10/TIO4C
141 GND 168 PB5/TO7B/
TO8B
142 GND 169 PA11/TIO4D
143 PAO/TIOA 170 PB6/TO7C/
TO8C
144 GND 171 GND
145 PA1/TIOB 172 PB7/TO7D/
TO8D
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Table 3.5 Pin Assignment on HS7059EPH60H (cont)

User I/F 2 Pin No. Signal Name Userl/F2  Pin No. Signal Name
UCN2 173 PA12/TIO5A UCN2 187 PC2/TxD2

174 GND 188 PB13/SCKO

175 PA13/TIO5B 189 PC3/RxD2

176 PB8/TxD3/ 190 PB14/SCK1/
TO8E TCLKB/TI10

177 PA14/TxDO 191 PC4/_IRQO

178 PB9/RxD3/ 192 PB15/PULS5/
TO8F SCK2

179 PA15/RxD0 193 GND

180 PB10/TxD4/ 194 GND
HTxDO/TO8G (TGBON2)

181 GND 195 GND

182 PB11/RxD4/ 196 GND
HRxDO/TO8H

183 PCO/TxD1 197 GND

184 GND 198 GND

185 PC1/RxD1 199 GND

186 PB12/TCLKA/ 200 GND
_UBCTRG

RENESAS

43



343 Precautions on Connecting the User System
When connecting the evaluation chip board to the user system, note the following:

1. Secure the E6000H station location.
Place the E60O00H station and evaluation chip board so that the station to trace cable is not bent or twisted, as
shown below. A bent or twisted cable will impose stress on the user interface, leading to connection or
contact failure. Make sure that the E6GOOOH station is placed in a secure position so that it does not move and
impose stress on the user interface during use.

2. Make sure the power supply is off.
Before connecting the evaluation chip board to the user system, check that the emulator and the user system
are turned off.

3. Connect the Vcc, PVecl, and PVcec2 to the user system power.
The emulator monitors and decides whether the user system is turned on or off by the following Vcc pins:
(a) Connecting the dedicated connector for HS7059EPH60H
Vcc: Pins UCN2-48, UCN2-50, and UCN2-52
PVccl: Pins UCN2-54, UCN2-56, and UCN2-58
PVcc2: Pins UCN2-60, UCN2-62, and UCN2-64
(b) Connecting the user system interface board
Vcee, PVecel, and PVec?2 pins of each package
For the pin assignment, refer to the SH7059 series (F-ZTAT microcomputer) hardware manual.
Accordingly, after connecting the user system to the emulator, be sure to supply power to the Vcc pins.
Otherwise, the emulator assumes that the user system is not connected.
‘When the user system is connected, check that the power of the user system is supplied to these pins.
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35 Support of the Target MCU

3.5.1 Memory Space
The MCU has a 4-Gbyte memory space in its architecture.

On-Chip Flash Memory Area

e Access to the on-chip flash memory area

The emulator includes on-chip flash memory for the MCU. The on-chip flash memory is accessed in the mode
where the on-chip flash memory exists. The on-chip flash memory area access differs between user program
execution and the emulator commands.

Only read access is enabled during execution of the user program. A break does not occur if the on-chip flash
memory area is written to.

For access with emulator functions ((Memory] window or loading), read and write are always enabled.
The on-chip flash memory area is accessed in one state.

On-Chip I/O Area

If an attempt is made to access the on-chip I/O area, the on-chip I/O area in the MCU installed in the emulator is
accessed. To break the user program when the on-chip I/O area is written to or accessed, use the hardware break
or internal break.

External Memory Area

The MCU’s external memory area can be set with all memory attributes that the emulator supports.

Emulation RAM Area

The emulator includes the emulation RAM (16 kbytes x 16 blocks) for RAM emulation of the on-chip flash
memory. This emulation RAM (ERAM) can be used by overlapping with the on-chip flash memory address. If
an attempt is made to write the address that overlaps ERAM to the on-chip flash memory area, the address is
written by ERAM and a break does not occur.
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3.5.2 Low Power-Consumption Mode (Sleep, Software Standby, and Hardware Standby)
For reduced power consumption, the MCU has sleep, software standby, and hardware standby modes.

Hardware Standby Mode

Since the _HSTBY signal from the user system is not input to the MCU in the emulator, the emulator does not
support this mode.

Sleep and Software Standby Modes

e Break
The sleep and software standby modes can be cleared with either the normal clearing function or with the
break condition satisfaction (forced break), and the program breaks. When restarting after a break, the user
program will restart at the instruction following the SLEEP instruction.

e Trace
Trace information is not acquired in these modes.

e Memory access with emulator functions

For information on displaying and modifying the contents of memory in the sleep and software standby
modes, refer to section 5.4, Displaying and Modifying the Contents of Memory.

353 Interrupts
During execution and step execution, the user can interrupt the MCU.

During halting emulation (break mode), the interrupt source is retained. The mode transits the interrupt
processing immediately after emulation is restarted.

354 Control Input Signals (_RES, _BREQ, and _WAIT)
The MCU control input signals are _RES, _BREQ, and _WAIT.

The _RES signal is only valid when emulation has been started with normal program execution (i.e., the _RES
signal is invalid when emulation has been started with step execution). The _BREQ and _WAIT signals are valid
during emulation with the display and modification of memory contents, execution, and step execution. While
emulation is being halted (break), the input of the _RES, BREQ, or _WAIT signal to the MCU by the user
system is not possible.

The input of the _RES, _BREQ, or _WAIT signal during execution or step execution can be disabled by a
setting in the [Configuration Properties] dialog box.

3.5.5 Watchdog Timer (WDT)

While emulation is being halted (during break), counting up the WDT timer counter (TCNT) is suspended, and
restarted when emulation is executed again (user mode).

During break mode, a prescaler, which supplies a clock to TCNT, operates continuously. Since the phase of the
prescaler may be unmatched before or after emulation transits the break mode, the period before an overflow
occurs will differ by £1 cycle in the prescaler’s clock cycle.
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3.5.6 A/D Converter

The A/D converter has AVcc, AVss, AVref, and _ADTRG pins as well as the analog input pins. As the A/D
converter operates with an independent power supply, connect AVcc (the power supply pin) to the A/D power
supply on the user system.

Notes: 1. When not using the A/D converter, connect AVcc to Vcec.

2. As the user system interface board, printed circuit boards, and protective circuits are connected
between the user system and the MCU installed on the evaluation chip board, the conversion
precision is lower than that of the SH7059 series MCU. At final debugging of the user system using
the A/D converter, use the actual SH7059 series (F-ZTAT microcomputer) MCU.

3.5.7 Emulator State and On-Chip Modules

Some on-chip modules do not operate when the emulator is in break mode. Table 3.6 shows the relation between
the emulator’s state and operation of the on-chip modules.

Table 3.6 Emulator State and Operation of On-Chip Modules

Operation During

Operation During Emulation (Execution or
Internal Module Emulation Halted (Break) = Step Execution)
UBC (user break controller) No Yes
DMAC (direct memory access controller) Yes Yes
ATU-II (advanced timer unit) Yes Yes
APC (advanced pulse controller) Yes Yes
WDT (watchdog timer) No Yes
CMT (compare-match timer) Yes Yes
SCI (serial communication interface) Yes Yes
HCAN2 Yes Yes
A/D converter Yes Yes
AUD (advanced user debugger) Yes” Yes”
1/0 port Yes Yes
H-UDI (user debugging interface) Not available® Not available®

Notes: 1. The AUD can be used by the user or the emulator function. Therefore, when the AUD is used by the
emulator, it is not available for the user.
2. The user cannot use the H-UDI.
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3.5.8 Different Initial Values of Registers in the Emulator

Note that the emulator initializes some general or control registers whenever the system is activated or the MCU
is reset by commands.

Table 3.7 Initial Values of Registers in the MCU and the Emulator

Register Name

Emulator

Power On

Reset (Reset CPU)

MCU (Reset)

PC

Power-on reset vector
PC value

Power-on reset vector
PC value

Power-on reset vector
PC value

RO to R14 H'00000000 Value before reset Undefined

R15 (SP) Power-on reset vector Power-on reset vector Power-on reset vector
SP value SP value SP value

SR H'000000F0 H'000000FO0 H'00000XFX*

GBR H'00000000 Value before reset Undefined

VBR H'00000000 H'00000000 H'00000000

MACH H'00000000 Value before reset Undefined

MACL H'00000000 Value before reset Undefined

PR H'00000000 Value before reset Undefined

Note: X indicates an undefined value.
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Section 4 Diagnostic Test Procedure

This section describes the diagnostic test procedure using the E6G000H diagnostic program.

4.1 System Set-Up for Diagnostic Program Execution

To execute the diagnostic program, use the following hardware; do not connect the user system interface board
and user system.

E6000H (HS7059EPH60H)

Host computer

The E6000 PC interface board which will be one of the following boards:
PCI bus interface board (HS6000EICO1H or HS6000EIC02H)

PC card interface (HS6000EIPO1H)

LAN adapter (HS6000ELNO1H)

USB adapter (HS6000EIUO1H or HS6000EIU02H)

Install the E6000 PC interface board in the host computer and connect the supplied PC interface cable to the
board.

Connect the PC interface cable to the E6000H.

Connect the supplied AC power cable to the E6G000H.

Initiate the host computer to make it enter the command input wait state of the DOS prompt (Windows®
98SE or Windows® Me) or command prompt (Windows NT®, Windows® 2000, or Windows® XP). If the
property of the prompt window is not a mode for displaying the whole screen, press the [Alt + Enter] key to
switch the mode. To set back the mode, press the [Alt + Enter] key. The display of the screen is switched
regardless of the OS being used.

Note: In the MS-DOS prompt, if the display of the screen is not switched after pressing the [Alt + Enter] key,

mark the [Alt+Enter] check box in [Windows shortcut keys] of the [Misc] page on the [MS-DOS Prompt
Properties] dialog box and click the [Apply] button to update the settings, as shown in figure 4.1.
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M5-D0OS Prompt Properties

Figure 4.1 [Misc] Page
5. Turn on the E6000H emulator power switch.
Note: To execute the diagnostic program, firstly turn on the power of the emulator. In the diagnostic program,

the initial state of hardware is checked. Therefore, after the power is turned on, do not activate the High-
performance Embedded Workshop before executing the diagnostic program.
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4.2 Test Item of the Diagnostic Program

Table 4.1 shows the test items of this diagnostic program.

Table 4.1 Test Items of the Diagnostic Program

Test No. Test Item Description
1 Main Board Access Register test in the EG000H main board
2 Emulation Board Access Register test in the E6000H emulation
board
3 Evaluation Chip Board Access Register test in the EB000H evaluation
chip board
Basic Function Test for the basic function
5 GO to BREAK Time Measurement Test for the execution time
measurement function
6 Emulation Monitor Test for emulation monitor
G/A Break Function Test for the G/A break function
8 G/A Performance Analysis Function Test for the G/A performance
measurement function
9 G/A Monitor Function Test for the G/A monitoring function
10 G/A Parallel RAM Monitor Test for the G/A parallel RAM
monitoring function
11 G/A Trace Function Test for the G/A trace function
12 Combination Test for combination of each function
13 Parallel Access Test for the parallel access function
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4.3 Diagnostic Test Procedure Using the Diagnostic Program

Insert the CD-R (HS7058EPH60SR supplied with the E6000H) into the CD-ROM drive of the host computer,
move the current directory to <Drive>:\Diag\HS7059EPH60H with a command prompt, and enter one of the
following commands according to the PC interface board used to initiate the diagnostic program:

1. PCI bus interface board (HS6000EICO1H or HS6000EICO2H)
>TM?7059 -PCI (RET)

2. PC card interface (HS6000EIPO1H)
> TM7059 ~PCCD (RET)

3. LAN adapter (HS6000ELNO1H)
>TM?7059 -ELN (RET)

4. USB adapter (HS6000EIUO1H or HS6000EIUO2H)
>TM7059 -USB (RET)

The High-performance Embedded Workshop must be installed before the test program is executed.

Be sure to initiate the diagnostic program from <Drive>:\Diag\HS7059EPH60H. Do not initiate it from a
directory other than <Drive>:\Diag\HS7059EPH60H, such as > <Drive>:\Diag\HS7059EPH60H\TM7059 -PCI
(RET). If the diagnostic program is initiated when the current directory is not <Drive>:\Diag\HS7059EPH60H,
the diagnostic program will not operate correctly.

When -S is added to the command line such as > TM7059 -PCI -S (RET), steps 1 to 13 will be repeatedly
executed. To stop the execution, enter Q.

Notes: 1. <Drive> is a drive name for the CD-ROM drive.
2. Do not remove the CD-R from the CD-ROM drive during test program execution.

52
RENESAS



The following messages are displayed during the test. There are 14 steps in this test (wWhen a PCI interface board

is used, the time for the test will be about three minutes).

Message

SH7059 E6000H Emulator Tests Vx.x.XX

Loading driver .................... OK (Use PCI)
Initializing driver ....................... OK
Searching for interface card .............. OK
Checking emulator is connected ............ OK

Emulator board information:
Main board ID: H'0

Normal started at Tue Feb 04 16:52:05 2005

*x%*%%*x NORMAL TEST - Press 'Q'

to sStop **x**x*

1. Main Board Access

Emulation board ID:

Description

Test program start message. X.X
shows the version number.

Shows that the PC interface
board is correctly installed in
the host computer.

Shows that the E6000H
emulator is correctly connected
to the host computer.

H'001

Shows the ID number of the
E6000H emulator.

Shows the time when the
diagnostic program has started.

(COUNT=0001)

01) Registers Initial Value Check ............... it OK
02) Registers Write/Verify ....... ...ttt OK
03) DPRAM Address Decode TeSt ..............iiiiiunnnnnnnnnnnn. SKIP
04) DPRAM Marching Test ........... ... .. it iiiiiiiiiinnnnnn. SKIP
05) Trace Memory Address Decode TeSt . ...viiiiiiinnenennennnn OK
06) Trace Memory Marching Test ............... ... iiiininnnn.. OK
07) G/A Registers Initial Value Check ...........uuuuunnnnnnn.. OK
08) G/A Registers Write/Verify ... ... iiinn e innennn OK
2. Emulation Board Access
01) Registers Initial Value Check ............. ... it OK
02) Registers Write/Verify ....... ...ttt OK
03) H-UDI Interface Registers Initial Value Check ............. OK
04) H-UDI Interface Registers Write/Verify .................... OK
05) AUD Interface Registers Initial Value Check ............... OK
06) AUD Interface Registers Write/Verify....................... OK
07) AUD Interface Registers Address Decode TesSt ............... OK
08) PCKCR Registers Bit Test...... ittt OK
3. Evaluation Board Access
01) Registers Initial Value Check ..................iiiiunnn.. OK
02) Registers Write/Verify ....... ... ... OK
03) H-UDI IDCODE CheCk . .ttt ettt et et e e e e e OK
04) Firmware BOOT ... ...ttt ittt ittt e iae et OK
05) Configuration Set ........... ... .. . . . . ... i OK
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4.

5.

6.

7.

8.

9.
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Basic
01)
02)
03)
04)
05)
06)
07)

GO to
01)
02)
03)
04)
05)
06)
07)
08)
09)

Function

GO tO BREAK ...ttt it it et e e OK
RESET GO ..ttt ittt ittt et ettt e et et e e OK
S P .t i e e e e e e OK
KEYBREAK . . it et e OK
BRKCON T .ottt it e et et e et e et e e e OK
Internal ROM TeSE vttt OK
Internal RAM TeSt ... ..ttt et iiee s OK
BREAK Time Measurement

Counter Test MOde ... ...ttt OK
EMU 12MHz MPU 96MHz Sampling 20ns (Default) ............... OK
EMU 12.5MHz MPU 100MHz Sampling 1.6uUs ..................... OK
EMU 5MHz MPU 40MHz Sampling 52US ... ....ieumneennnennnnnn. OK
EMU 8MHz MPU 64MHz Sampling MPU ...............cuuniiunnn... OK
EMU 12MHz MPU 96MHz Sampling MPU/2 . ........uiiiiunennnnnan. OK
EMU 12.5MHz MPU 100MHz Sampling MPU/4 ..........couieeeen... OK
EMU 9.6MHz MPU 76.8MHz Sampling 20NS ........c.veuenennen.. OK
EMU 8.5MHz MPU 68MHz Sampling 20MS ..........uvieuunennnnnn. OK

Emulation Monitor

01)
02)
03)
04)
05)
06)

AUDRE S . .ttt OK
TRES .ot e OK
ASESTL = 0 ottt e e e e e e OK
VCC3VNG .ttt ittt it et it et et e it ettt e OK
VCC2-5VNG &ttt ittt ittt it e it ettt et e e e OK
O e OK

G/A Break Function

01)
02)
03)
04)
05)
06)
07)
08)
09)

Address Condition ....... ... e OK
Data Condition .......... ... ... .. ... OK
Control Signal Condition (ASEDSHH/HL/LH/HL) ............... OK
Function Code Condition (ASEBM1 ASESAS2-0) ................ OK
Control Signal Condition (ASEAS2-1) ........uuiiiinninnnn.n. OK
Control Signal Condition (ASEIF-N) ..........iiuininininano.... OK
Control Signal Condition (ASEERAM-N) ...................... OK
Control Signal Condition (/DMA_AUD AEBMO) ................. OK
Control Signal Condition (ASEST1-0) .......oiuinininininnenn. .. OK

G/A Performance Analysis Function

01)

Time Measurement (20ns Sampling) .................o.ooo.... OK

G/A Monitor Function

01)
02)
03)
04)

STEP/RUN . .ottt ittt ettt e OK
VCCDOWN . oLttt ettt e e e OK
NOCLK oottt e e e et e e e OK
TIMEOUT ...ttt it it et it it ettt et e e e OK
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10.

11.

12.

13.

14.

G/A Parallel RAM Monitor

01) PRAM Monitor (BYTE) . ......iiiiiitttttiiiiiiiiinnnnnn OK
02) PRAM Monitor (WORD) . ..........iiiitttttiiiiiinnnnnnn OK
03) PRAM Monitor (LONG WORD) ... .....iiiiiiiiinnnnnnns OK

G/A Trace Function

01) Free TIrACE ...ttt ittt ittt et i i i OK
02) TEACE SEOD t ottt ettt e e ettt e e e e et et et e OK
03) Time Stamp . ...... ..t OK
04) Trace SUPPLESS .ottt ittt ittt ittt ittt it ii i OK
Combination
01) B to A Time Measurement ( FPGA counter ) ................... OK
02) B to A Time Measurement ( G/A counter ) ............eeeenonn OK
03) D to C Time Measurement ( G/A counter ) ............eeeeenn. OK

Parallel Access

01) AUD Write (INROM BYTE) ..ttt ie i iaee i OK
02) AUD Write (INROM WORD) . ... ...ttt OK
03) AUD Write (INROM LONGWORD) ..t vvvitininiimneiinneinneeennn OK
04) AUD Write (INRAM BYTE) .. ...ttt OK
05) AUD Write (INRAM WORD) ..t tuiimie e iie e iaeeiiane e OK
06) AUD Write (INRAM LONGWORD) ... ...\ttt OK
07) AUD Sample (INROM BYTE) .........iiiiiiiiiiiinnnnnnnn OK
08) AUD Sample (INROM WORD) ...ttt e iiaeeiinne i OK
09) AUD Sample (INROM LONGWORD) ... ...otiiiiiunnnnnnnnnnnnnnnns OK
10) AUD Sample (INRAM BYTE) . ..tttiiniinnnteeenneennnnnennn OK
11) AUD Sample (INRAM WORD) ... ...ttt OK
12) AUD Sample (INRAM LONGWORD) .. tvvitiuintinneinneenneeenns OK
13) AUD Sample 256p0int . ..... ... e OK

FPGA Parallel RAM Function

01) CHO 256Byte Area Check (BYTE) .. ...t iiuiiiunimnneennneenns OK
02) CHO 256Byte Area Check (WORD) ..........iiuuuuunnnnnnnnnnnns OK
03) CHO 256Byte Area Check (LONG WORD) ... ...t vuiiimunneunneeennn OK
04) CHO - CH1l1l 256Byte Area Check (LONG WORD) ........icuunnenennn OK
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Normal stopped at Tue Feb 04 16:54:23 2005
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sts run for Oh:2min:18s

mmary:

Tests performed 1 time(s).
Main Board Access

Emulation Board Access
Evaluation Board Access
Basic Function

GO to BREAK Time Measurement
Emulation Monitor

G/A Break Function

G/A Performance Analysis Function
9. G/A Monitor Function

0. G/A Parallel RAM Monitor

1. G/A Trace Function

2. Combination

3. Parallel Access

4. FPGA Parallel RAM Function
Total 0 Error(s)
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diagnostic program has
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Shows the execution time
of the diagnostic program.

Shows the total of the
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Section 1 Overview

The Debugger Part includes the following information.

Table 1.1 Debugger Part Contents

Section Title Content

2 Preparation before Use This section starts with creation of a workspace
and ends with connection to the emulator.

3 Debugging This section describes this emulator ‘s peculiar
debugging operation and the associated windows
and dialog boxes.

Refer to the High-performance Embedded
Workshop user's manual about High-performance
Embedded Workshop common functions as below.
— Preparations for Debugging
— Viewing a Program
— Operating Memory
— Displaying Memory Contents as
Waveforms
— Displaying Memory Contents as an Image
— Modifying the variables
— Viewing the 1/O Memory
— Looking at Registers
— Executing Your Program
— Viewing the Function Call History
— Debugging with the Command Line
Interface
— Elf/Dwarf2 Support
— Looking at Labels

4 Tutorial This section describes how to use the emulator
functions by using a tutorial program provided with
the emulator.

5 Software Specifications and Notes  This section describes software specifications and

Specific to This Product notes regarding the emulator.
6 Error Messages This section describes the contents of error

messages that may occur while the emulator is in
use, and solutions to them.
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Section 2 Preparation before Use

2.1 Method for Activating High-performance Embedded Workshop
To activate the High-performance Embedded Workshop, follow the procedure listed below.

1. Connect the emulator to the host computer.

2. Connect the user system interface cable to the connector of the emulator if you use the user system interface
cable. This is not necessary when you do not use the user system interface cable.
Turn on the emulator. Be sure to turn on the user system before supplying power to the emulator if you use
the user system.

3. Activate the High-performance Embedded Workshop from [Programs] in the [Start] menu.

4. The [Welcome!] dialog box is displayed.

— Optiohiz: oK

¢ Create a new project workspace Cancel

% | lpen arecent project workspace: Administration..

| =

Flt

" Browse to anather project workspace

Figure 2.1 [Welcome!] Dialog Box
[Create a new project workspace] radio button: Creates a new workspace.

[Open a recent project workspace] radio button: Uses an existing workspace and displays the history of the
opened workspace.

[Browse to another project workspace] radio button: Uses an existing workspace; this radio button is used when
the history of the opened workspace does not remain.

In this section, we describe the following three ways to start up the High-performance Embedded Workshop:

e [Create a new project workspace] - a toolchain is not in use

e [Create a new project workspace] - a toolchain is in use

e [Browse to another project workspace]

The method to create a new workspace depends on whether a toolchain is or is not in use. Note that this emulator
product does not include a toolchain. Use of a toolchain is available in an environment where the H8S, H8/300
series C/C++ compiler package or the SuperH™ RISC engine C/C++ compiler package has been installed. For

details on this, refer to the manual attached to the H8S, H8/300 series C/C++ compiler package or the SuperH™
RISC engine C/C++ compiler package.
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2.1.1 Creating a New Workspace (Toolchain Not Used)

1. In the [Welcome!] dialog box that is displayed when the High-performance Embedded Workshop is activated,
select [Create a new project workspace] radio button and click the [OK] button.

21X

— Optiong: oK

¢ Create a new project work space Eeree)

% " [pen arecent project workspace; Adrministration..

| =

Fl

" Browse to another project workspace

Figure 2.2 [Welcome!] Dialog Box
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2. Creation of a new workspace is started. The following dialog box is displayed.

2l

‘Workspace Mame:

Isa mple

Project Mame:

Isa mple

Directory:

IO:¥ Hewz¥zample Browse... |

CPU family:

| HE:S He/a00 =l

Tool chain:

Properties.. |

oK I Cancel

Figure 2.3 [New Project Workspace] Dialog Box

[Workspace Name] edit box: Enter the new workspace name.
[Project Name] edit box: Enter the project name. When the project name is the same as the workspace name,
it needs not be entered.

[Directory] edit box: Enter the directory name in which the workspace will be created. Click the [Browse...]
button to select a directory.

[CPU family] combo box: Select the target CPU family.

Other list boxes are used for setting the toolchain; the fixed information is displayed when the toolchain has not
been installed.

Click the [OK] button.
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3. Select the target platform of the session file. The following dialog box is displayed.

fed 4
— Targets :
vl vy EGO00H Emulator GPU nnnn
GO00H Emulato *LI mimmim
Target type : I."-\ll Targets j
< Back I Mest » I Finizh | Cancel |

Figure 2.4 [New Project — Step 7] Dialog Box

The target platform for the session file used when the High-performance Embedded Workshop is
activated must be selected here. Check the box against the target platform and then click the [Next]
button.
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4. Set the configuration file name. The configuration file saves the state of High-performance Embedded
Workshop except for the emulator.

Target name :

Configuration name :

|Debue_yyyy_EOOOH_Emulator GP

— Detail options :

Item | WValue |

Fadify |

< Back I Hest = I Finish | Cancel |

Figure 2.5 [New Project — Step 8] Dialog Box

If multiple target platforms were selected in the [New Project — Step 7] dialog box shown in figure 2.5, set
the name of a configuration file for each of them, each time clicking the [Next] button to proceed to the next
target.

Setting of the configuration file name is the end of the emulator settings.

Click the [Finish] button to display the [Summary] dialog box. Clicking the [OK] button activates the High-
performance Embedded Workshop.

5. After the High-performance Embedded Workshop has been activated, the emulator is automatically
connected. The message “Connected” is displayed on the [Debug] tab in the [Output] window to indicate the
completion of connection.
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2.1.2 Creating a New Workspace (Toolchain Used)

1. In the [Welcome!] dialog box that is displayed when the High-performance Embedded Workshop is activated,
select the [Create a new project workspace] radio button and click the [OK] button.

21X

— Optiong: oK

¢ Create a new project work space Eeree)

% " [pen arecent project workspace; Adrministration..

| =

Fl

" Browse to another project workspace

Figure 2.6 [Welcome!] Dialog Box
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2. Creation of a new workspace is started. The following dialog box is displayed.

2]

Frojects I

' C Iyl

5] Assembly Application ISaI‘ﬂD|E
Demonstration
@ Empty Application
& Impart Makefile ISE"""Dl'3
G Library Directony:

IE: “WHew2hzample Browsze... |

LCPU Family:
[ Hs He/a00 =l

Wiorkspace Wame:

Project Mame:

Tool chair:
[ Hitachi H8S H8/300 Standard =

Froperties... |

Ok I Cancel

Figure 2.7 [New Project Workspace] Dialog Box

[Workspace Name] edit box: Enter the new workspace name.

[Project Name] edit box: Enter the project name. When the project name is the same as the workspace name,

it needs not be entered.

[Directory] edit box: Enter the directory name in which the workspace will be created. Click the [Browse...]

button to select a directory.

[CPU family] combo box: Select the target CPU family.

[Tool chain] combo box: Select the target toolchain name when using the toolchain. Otherwise, select
[None].

[Project type] list box: Select the project type to be used.

Notes: ‘When [Demonstration] is selected in the emulator, note the followings:
The [Demonstration] is a program for the simulator attached to the H8S, H8/300 compiler package or
the SuperH™ RISC engine C/C++ compiler package. To use the generated source file, delete the
printf statement in the source file.
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3. Make the required setting for the toolchain. When the setting has been completed, the following dialog box
is displayed.

— Targets :

Il vy EGON0OH Emulator GPU nnnn
SO00H Emul: P U mmrmm

Target bype : IAII Targets j

< Back I Hest = I Finish | Cancel |

Figure 2.8 [New Project — Step 7] Dialog Box

The target platform for the session file used when the High-performance Embedded Workshop is activated
must be selected here. Check the box against the target platform and then click the [Next] button.
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4. Set the configuration file name. The configuration file saves the state of High-performance Embedded

Workshop except for the emulator.

Target name :

Configuration name :

|Debue_yyyy_EOOOH_Emulator GP

— Detail options :

Item | WValue |

Fadify |

< Back I Hest = I Finish | Cancel |

Figure 2.9 [New Project — Step 8] Dialog Box

If multiple target platforms were selected in the [New Project — Step 7] dialog box shown in figure 2.9, set
the configuration file name for each of them, each time clicking the [Next] button to proceed to the next
target.

Setting of the configuration file name is the end of the emulator settings.

Complete the creation of a new workspace according to the instructions on the screen. This activates the
High-performance Embedded Workshop.

. After the High-performance Embedded Workshop has been activated, connect the emulator. However, it is
not necessary to connect the emulator immediately after the High-performance Embedded Workshop has
been activated.

Select either of the following two ways to connect the emulator: connecting the emulator after the setting at
emulator activation or without the setting at emulator activation. For details on the connection of the
emulator, refer to section 2.2, Connecting the Emulator.

11
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2.1.3 Selecting an Existing Workspace

1. In the [Welcome!] dialog box that is displayed when the High-performance Embedded Workshop is activated,
select [Browse to another project workspace] radio button and click the [OK] button.

21X

iy
¢ Create a new project work space Cancel |
" [pen arecent project workspace; Adrministration.. |
é | |
" Browse to another project workspace

Figure 2.10 [Welcome!] Dialog Box

2. The [Open Workspace] dialog box is displayed. Select a directory in which you have created a workspace.
After that, select the workspace file ((hws) and click the [Open] button.

Look in: Ia sample j = IE:F -

sample

Filz hame: |sample.hws Open I
Files of type: IWorkspaces [ hws] j Cancel |
A

Figure 2.11 [Open Workspace] Dialog Box

3. This activates the High-performance Embedded Workshop and recovers the state of the selected workspace
at the time it was saved.
‘When the saved state information of the selected workspace includes connection to the emulator, the
emulator will automatically be connected. To connect the emulator when the saved state information does not
include connection to the emulator, refer to section 2.2, Connecting the Emulator.
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2.2 Connecting the Emulator
Select either of the following two ways to connect the emulator:

(a) Connecting the emulator after the setting at emulator activation

Select [Debug -> Debug Settings...] to open the [Debug Settings] dialog box. It is possible to register the
download module or the command chain that is automatically executed at activation.

‘When the dialog box is closed after setting the [Debug Settings] dialog box, the emulator will automatically
be connected.

(b) Connecting the emulator without the setting at emulator activation
Connect the emulator by simply switching the session file to one in which the setting for the emulator use has
been registered.

{3 sample - Hitachi Emb o ol x|
File Edit Wisw Project Options Buld Took Window Help

DeEgzsee|oral|ltp|@atus ¢ |m |@ == & |
I e e N e e D [ERENET:

IH £
=3 DefaulSession

E-E sample
B3 C soures fils
2] dhscte
intprg.c
resetpig.c
sample.c

stke

Build £ Debug b Find in Files b Version Contral

Ready [ - [ns [ om

Figure 2.12 Selecting the Session File

In the list box that is circled in figure 2.12, select the session file name including the character string that has
been set in the [Target name] text box in figure 2.9, [New Project — Step 8] dialog box. The setting for using the
emulator has been registered in this session file.

Selecting [Debug -> Connect] connects the emulator.

13
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2.3 Re-connecting the Emulator
When the emulator is disconnected, re-connection is possible by using the following methods.
Select [Debug -> Connect] or click the [Connect] toolbar button (&) to re-connect the emulator.

Note: When re-connecting the emulator, the load module must be registered to the High-performance
Embedded Workshop beforehand.

24 Ending the Emulator
The emulator can be exited by using the following two methods:

(a) Canceling the connection of the emulator being activated
Select [Debug -> Disconnect] or click on the [Disconnect] toolbar button ().

(b) Exiting the High-performance Embedded Workshop

1. Select [File -> Exit].
2. A message box is displayed. If necessary, click the [Yes] button to save a session. After saving a session,
the High-performance Embedded Workshop exits.

Cancel

Figure 2.13 [Session has been modified] Message Box
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Section 3 Debugging
This section describes the debugging operations and their related windows and dialog boxes.

31 Setting the Environment for Emulation

The method for setting the environment for emulation is described here. This environment must be set correctly
before debugging is started.

3.1.1 Opening the [Configuration Properties] Dialog Box

Selecting [Setup -> Emulator -> System...] or clicking the [Emulator System] toolbar button (@) opens the
[Configuration Properties] dialog box.

figuration Prop 2=l

General I ERam |

Device: [SH7058 =] e St
[v User Bieset enable

Mode: | 3{0n-ChipROM SingleChip) | [ User WMl enable

Clock: I‘IDMHz j [T User Standby enable
JTAG Clock: 10MH= = ¥ User Bus Request®ait enable
Timer Fesolution: | 20ns j

Input Freguency: |5_ oo Busz Timeout: I 100us vl
Flazh Load Option: Idisable vl

[~ Enable intermupts during step execution
¥ Enable select AUD ta Ermulator[Enable read and wite on the fiy)
[~ Enable multi breal

User VCC Thieshold = 4.40v <] m B

Driver:  EG000H H-UDI USE Driver

[ Change driver in start up

Cancel

Figure 3.1 [Configuration Properties] Dialog Box ([General] Page)

RENESAS

15




[General] page

[Device] Selects the target MCU to be emulated. See the hardware manual for
details.
[Mode] Selects the operating mode for emulation. There are the following five
modes.
0: 8-bit bus
1: 16-bit bus
2: On-chip ROM enabled
3: On-chip ROM enabled, single chip
Target: Mode that has been set on the user system
[Clock] Selects the clock to be supplied to the MCU.

Target: Clock signal for the user system

Xtal: Crystal oscillator on the evaluation chip board

XMHz: Internal clock (When HS7058EPH60H is used: x =5 or 10
When HS7059EPH60H is used: x = 5, 6, 8 or 10)

[JTAG Clock]

Selects the JTAG clock.
When HS7058EPH60H is used:10, 15, or 20(MHz)
When HS7059EPH60H is used:5, 6, 8, 10, 12, 12.5, 15, 18 or 20(MHz)

[Timer Resolution]

Selects the timer resolution for use in execution time measurement and
performance analysis.

Select one of the following values.

Execution time measurement: 52 us, 1.6 us, or 20 ns

Clock counter measurement: CLOCK, CLOCK/2, CLOCK/4, or CLOCK/8

[Input Frequency]

Selects the clock to be supplied to the MCU. Set the frequency of Xtal or
Target that has been specified for [Clock]. The value must be input to two
decimal places between 5.00 MHz to 10.00 MHz (by rounding off to two
decimal places). This frequency is used for programming the on-chip
flash memory.

[Flash Load Option]

[Enable interrupts during step
execution]

Sets the operation when programming the on-chip flash memory.
disable: Programming disabled. The on-chip flash memory is not
programmed even if loading of a program is attempted.

update: Programs the on-chip flash memory without initialization
erase: Initializes and programs the on-chip flash memory of the target
block

all erase: Initializes and programs the entire on-chip flash memory

When this box is checked, interrupts are accepted during step execution.

[Enable select AUD to Emulator
(Enable read and write on the

fly)]

When this box is checked, the AUD is used by the emulator. It is possible
to view or modify the contents of memory during user program execution.

[Enable multi break]

When this box is checked, the multibreak function is enabled. The
multibreak function allows a break to occur in several EB000H emulators
by using a trigger input and probe pins.

[User VCC Threshold]

Sets the voltage level for the user system. [Down] will be displayed in
[User PVCC1] of the [Extended Monitor] window when the actual user
VCC of the target system is lower than the specified value. When the
operating mode is changed, the voltage level will be set to the initial value
of the new operating mode.

[User Signals]

When this group box is checked, input of the corresponding control pins
are enabled.

[Bus Timeout]

Select the bus timeout detection time. 100us, 1.6ms, 13ms, or 210ms can
be selected.
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[General] page (cont)

[Driver] Displays the E6000H driver that is currently installed.

[Change driver in start up] When this box is checked, selection of a driver will be available next time
the emulator is connected.

Notes: 1. The system clock (¢) is set as the input for the clock counter setting.

2. The emulator realizes a parallel access by using the AUD function. When [Enable select AUD to
Emulator (Enable read and write on the fly)] is unchecked and the AUD function is used by the user,
memory access is disabled during user program execution.

(1) Change of the Operating Mode

Changing the operating mode releases the settings made regarding the ERAM or software breaks and resets the
CPU. If the mode selected in the user system is incorrect while [Target] is selected, an error is displayed. Select
an appropriate mode.

(2) Clock supplied to the MCU
Check the followings when you select a clock:

e Before selecting Target, ensure that the user system is supplied with power. Otherwise, an error appears
after [OK] is pressed.

e Before selecting Xtal, ensure that the crystal oscillator is installed into the crystal oscillator terminals on
the evaluation chip board. Otherwise, the operation will be incorrect.

e  Changing the clock resets the target MCU.

(3) JTAG Clock

The debugging function in the E6000H emulator is realized by serial communication with the target MCU. The
JTAG clock is used as the input clock in this serial communication. Set the JTAG clock frequency as high as
possible to improve performance in downloading and reading memory. Note that, however, the JTAG clock
frequency must be lower than that of the peripheral modules clock (P¢) of the target MCU.

17
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3.1.2 Using the Emulation RAM

Use the [ERam] page of the [Configuration Properties] dialog box to make settings for the emulation RAM. 16
and 24 blocks of 16-kbyte units are available in the emulation RAM of HS7058EPH60H and HS7059EPH60H,
respectively. The addresses of the emulation RAM can overlap with those of the on-chip flash memory. Use of
the emulation RAM allows debugging without overwriting a program or data in the on-chip flash memory. The
emulation RAM can also be used as an on-chip RAM for debugging while not used in the emulator.

2=
General  ERam
Mode
’7(‘ User (¥ " Auto allocate for software break.
r— allocate Ernulation FAM on ROM
[T ERaMD | | [~ RO to ERAKMD
[T ERaM1 | | | ROk o ERAMT
[T ERaMz | | ™| ROk to ERAME
[T ERaM3 | | ™| ROk o ERAH3
[~ ER&Me | | I~ RO to ER& 4
[~ ER&ME | | ™ RO to ERE&ME
[~ ERaME | | = RO ta ERAME
[~ ERaMz | | = RO ta ERAMT
[~ ERama | | = RO to ERAHME
[~ ERaMI | | [~ RO to ERARE
[~ ERAMIOR) [ | = RO to ERAMID
I~ ER&MTIE) [ | = O to ERERTT
[ ERaM12(C) | | | ROk o ERAMTZ2
[ ERAM13D] | | | ROk o ERAMTS
[ ERAM14E] | | ™| ROk o ERik 14
[ ERAMISE] | | | ROk o ERAM1E
[1].8 I Carncel

Figure 3.2 [Configuration] Dialog Box ((ERam] Page)
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[ERam] page

[Mode]

[User]

The emulation RAM is not used in the emulator.

[Emulation Memory]

The emulation RAM is used in the emulator. [allocate
Emulation RAM on ROM] allows allocation of
addresses overlapped with those of the on-chip flash
memory.

[Auto allocate for
software break]

[allocate Emulation
RAM on ROM]

The emulation RAM is used in the emulator and automatically allocated when a software
break is being set on the on-chip flash memory.

First checkbox

Checking this box allocates the emulation RAM to the
on-chip flash memory address specified in the right-
hand field. Pressing the [OK] button after removing a
check mark in this box displays the message “Do you
copy ERAMn memory to flash memory?”. Clicking “Yes
starts programming the content of the emulation RAM
into the on-chip flash memory, except in the following
cases;

e [Emulation Memory] has been changed to [User] in
[Mode]

e The ERAM mode has been changed from [Auto
allocate for software break] to [User]

e The system is terminated

When an error has occurred while programming to the
on-chip flash memory, the message “Flash Memory
Access Error” is displayed and the dialog box is
opened again. Check the settings and click the [OK]
button.

Address input

Enter the start address of an allocation area. The next
field displays the range for allocation. When a value is
set outside the 16-kbyte boundary, the value below the
boundary will be rounded to the nearest value.

Last checkbox

Checking this box reads the content of the on-chip flash
memory and then writes it to the emulation RAM when
the emulation RAM is allocated. When the user
program is downloaded to the on-chip flash memory in
this state, the program is also downloaded to the
emulation RAM.

Notes: 1. Software break set on the emulation RAM will not function if use of the emulation RAM is cancelled.
Changing the operation mode cancels the emulation RAM settings.
2. Stop the DMAC operation when the emulation memory is set.

Using the Emulation RAM as an On-Chip RAM for Debugging

To use the emulation RAM as an on-chip RAM for debugging, select [User] in [Mode]. Addresses available as
an on-chip RAM for debugging are H’FFFB 0000 to H’FFFE FFFF. The emulation RAM is an exclusive
function for the emulator. Note that this address area is reserved in the target MCU product.

19
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3.1.3 Selecting the Interface to be Connected

Checking [Change driver in start up] on the [Configuration Properties] dialog box allows a selection of the driver
next time the emulator is connected.

EGO00H D

Driver: IEmuIator PCI Card Driver j
— Dretails
Interface: IF'Cl j
Channel; IEmuIator PCl Card Interface j

— Canfiguration

Canfigure... |

I Ehange diiver in st

Figure 3.3 [Driver Details] Dialog Box
[Driver]: Selects the driver that connects the High-performance Embedded Workshop and the emulator.
[Details]: Sets the details of the driver being connected.

[Interface]: The name of the interface to be connected. This should not be changed in this
emulator.

[Channel]: Channel for the selected interface. This should not be changed in this emulator.

[Configuration]: Driver setting.

[Configure...]: A dialog box for setting will be displayed when the driver supports the configuration
dialog. Note that this item is not available with this emulator.

[Change driver in start up]:
Checking this box selects the driver when the emulator is connected the next time.
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3.2 Downloading a Program

This section describes how to download a program and view it as source code or assembly-language mnemonics.

Note: After a break has occurred, the [Editor] window displays the location of the present program counter
(PC). In most cases, for example if an Elf/Dwarf2-based project is moved from its original path, the

source file may not be automatically found. In this case, a source file browser dialog box is displayed to
allow you to manually locate the source file.

3.2.1 Downloading a Program
A load module to be debugged must be downloaded.

To download a program, select the load module from [Debug -> Download] or select [Download] from the
popup menu opened by clicking the right-hand mouse button on the load module in [Download modules] of the
[Workspace] window.

Note: Before downloading a program, it must be registered to the High-performance Embedded Workshop as a
load module.

3.2.2 Viewing the Source Code

To view a source file’s code, double-click on its icon in the file tree, or right-click on the source file and select
the [Open] option on the pop-up menu. The [Editor] window is displayed.

=101

31 0d010zZe wvoid tutorial (woid) j

32 {

33 long J:

34 int i:

35 class Sample *p_sam;

36

37 | oooi03z (4 | p_sam= Sample;

38 | 00D1050 for | i=0; i<10; i++ )14

39 | O00103e = 4 = rand();

40 | 0001044 if (3 < 014

41 | 0001046 |& 5 2 =99

32 *

43 | DoO1048 | alil = i:

44 ¥

45 | 0001058 |& p_sam->sortia);

46 0001066 p_sam->change (a) ;

47

45 | 000106 | &b p_sam-»s0=a[0]:

49 ooo10va p_sam->sl=al[l];

j=1n} 0001076 p_sam->s2=al2]; -
KN o

Figure 3.4 Editor Window
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In this window, the following items are shown on the left as information on lines.

e Ist column (Line Number column): A line number for the source file

e 2nd column (Source Address column): Address information for the source line

e 3rd column (On Chip Break column): On-chip breaks

e 4th column (S/W Breakpoints column): PC, bookmark, and breakpoint information
The text area is displayed in the right part of the [Editor] window.

Line Number column

This column displays the line number for the source file.

Source Address column

When a program is downloaded, an address for the current source file is displayed on the Source address column.
These addresses are helpful when setting the PC value or a breakpoint.

On Chip Break column

The On Chip Break column displays the following items:
O & On-chip break channel 1 to 12

@: Reset point

These are also set by using the popup menu.

S/W Breakpoints column

This column displays the following items:

: A bookmark is set.

& A PC breakpoint is set.

5%: PC location
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To switch off a column in all source files

. Click the right-hand mouse button on the [Editor] window or select the [Edit] menu.
. Click the [Define Column Format...] menu item.
. The [Global Editor Column States] dialog box is displayed.

A check box indicates whether the column is enabled or not. If it is checked, the column is enabled. If
the check box is gray, the column is enabled in some files and disabled in others. Deselect the check box
of a column you want to switch off.

Click the [OK] button for the new column settings to take effect.

Line Murmber
[w]On Chip Break
[w] 5. Breakpoints Cancel |
SAw Breakpaints - A5

Source Address

Figure 3.5 [Global Editor Column States] Dialog Box

< To switch off a column in one source file

1.
2.

Open the source file which contains the column you want to remove and click the [Edit] menu.

Click the [Columns] menu item to display a cascaded menu item. The columns are displayed in this
popup menu. If a column is enabled, it has a tick mark next to its name. Clicking the entry will toggle
whether the column is displayed or not.
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3.2.3 Viewing the Assembly-Language Code

If you have a source file open, right-click to open the pop-up menu and select the [View Disassembly] option to
open a Disassembly view at the same address as the current Source view.

It is also possible to view the disassembly using the new integrated [Disassembly view] in the source file.

If you do not have a source file, but wish to view code at assembly-language level, then select one of the
following operations:

0O Click on the View Disassembly toolbar button (|
O Choose the [View -> Disassembly...] menu option.
O Press Ctrl + D.

The [Disassembly] window opens at the current PC location.

=[Ol x|
void main(woid) g
{
while (1)1
tutorial();
000102A 5502 _mwain B3R Brutorial():8
00010zC 40FC ERL [_mwain:s
H
B
void tutorial (void)
00010ZE O1106DFZ tutorial STH.L (ERZ-ER3) ,B-3F
{
long 3:
int i:
class Fample *p_sam;
p_sSaw= new Sample;
€ 0001032 1A80 SUE.L ERO,ERD
0001034 SEOOzZOO0 JSR B3ample::Jample () 24
0001038 OF83 MOV . L ERO, ER3
000103k 1922 SUB. W RZ,RZ
3 = rand():
000103C SEOO1174 JSR 0_rand:24
0001040 0DO1 MO .o RO, R1
oo0104z 17F1 EXTS.L ER1
if{j < 0)¢
0001044 4C0z EGE BH'1048:5 hi
411 H

Figure 3.6 [Disassembly] Window
In this window, the following information is shown on the left as information lines.
e First column (On-chip break column): On-chip breaks

e Second column (S/W Breakpoints - ASM column): PC and breakpoint information

This window is used in the same way as the source code window.
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3.24 Modifying the Assembly-Language Code

You can modify the assembly-language code by double-clicking on the instruction that you want to change. The
[Assembler] dialog box will be opened.

=mbler ﬂ il
Address Code

0001040 0001

- Cancel |
tnemonic:

Figure 3.7 [Assembler] Dialog Box

The address, instruction code, and mnemonic are displayed. Enter a new instruction or edit the old instruction in
the [Mnemonics] field. Pressing the [Enter] key will replace the memory content with the new instruction and
move on to the next instruction. Clicking the [OK] button will replace the memory content with the new
instruction and close the dialog box. Clicking the [Cancel] button or pressing the [Esc] key will close the dialog
box without modifying the memory contents.

Note: The assembly-language code being displayed is the current memory content. If the memory contents are
changed the [Assembler] dialog box and the [Disassembly] window will show the new assembly-
language code, but the source file displayed in the [Editor] window will be unchanged. This is the same
even if the source file contains assembly codes.

3.2.5 Viewing a Specific Address

When you are viewing your program in the [Disassembly] window, you may wish to look at another area of your
program's code. Rather than scrolling through a lot of code in the program, you can go directly to a specific
address. Select [Set Address...] from the popup menu, and the dialog box shown in figure 3.8 is displayed.

Address:
S j Cancel |

Figure 3.8 [Set Address] Dialog Box

Enter the address in the [Address] edit box and either click on the [OK] button or press the Enter key. A label
name can also be specified as the address. When an overloaded function or a class name is entered, the [Select
Function] dialog box opens for you to select a function.

3.2.6 Viewing the Current Program Counter Address

Wherever you can enter an address or value into the High-performance Embedded Workshop, you can also enter
an expression. If you enter a register name prefixed by the hash character, the contents of that register will be
used as the value in the expression. Therefore, if you enter the expression #pc in the [Set Address] dialog box,
the [Editor] or [Disassembly] window will display the current PC address. It allows the offset of the current PC
to be displayed by entering an expression with the PC register plus an offset, e.g., #PC+0x100.
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33 Viewing the Current Status

Choose [View -> CPU -> Status] or click the [View Status] toolbar button () to open the [Status] window and
see the current status of the debugging platform.

=10l =|
Item Status

Target Device Configuration 00000000 - OOOFFFFF  Internal ROM

00100000 - FFFAEFFF Reserved Area
FFFFOOOO0 - FFFFEFFF Internsl RAM
FFFFCOO00 - FFFFFFFF  Inkternal IO
System Memory Resources Emulation RAM:
Mode: Emulation Memory
ERAMO: onRCM 00000000 - OO003FFF
ERAMI:
ERAMZ :
ERAM3I:
ERAM4:
ERAMS:
ERAME:
ERAMT:
ERAME:
ERAMO:
ERAMIO:
ERAMI1:
ERAM1Z:
ERAM13:
ERAM14:
ERAM15:

Program Name Mewory Loaded Area
..tor_epuiTutorial.abs 0ooooo00-00000687
..tor_eputTutorial.abs 00000A00-00000A47

...tDr_cpu\TutDrial.abs 00001000-0000160E

...tDr_cpu\TutDrial.abs 0000zZ000-00002 137

E\Memory A Platfarmm )\ Events [‘

Figure 3.9 [Status] Window
The [Status] window has following three sheets:

e [Memory] sheet
Displays information about the current memory status including the memory mapping resources and the
areas used by the currently loaded object file.

e [Platform] sheet
Displays information about the environment for emulation, typically including CPU type and emulation
mode.

e [Events] sheet

Displays information about the current event (breakpoint) status, including resource information.

Note: The items that can be set in this window depend on the emulator in use. For details, refer to the online
help.
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34 Reading and Displaying the Emulator Information Regularly

Use the [Extended Monitor] window to know the changing information on the emulator no matter the user
program is running or halted.

Note:  The extended monitor function does not affect the execution of the user program since it monitors the
user system or the signal output from the target MCU in the emulator by using the emulator’s hardware
circuit.

3.4.1 Opening the [Extended Monitor] Window

Selecting [View -> CPU -> Extended Monitor] or clicking the [Extended Monitor] toolbar button () displays
this window. The interval of updating the display is approximately 1,000 ms during user program execution or
5,000 ms while breaking, respectively.

=10l |

5}

Item Value I
TUser RES Inactive

TUser HNMI Inactive

Uzer WAIT Inactive

Uzer EBREQ Inactive

User HSTEY Inactive

User UWDTOVE Inactive

Tser IRQ7-0 11111111

TUser VOO Ignore

Tser PVCC1 Ignore

User PVCCE Ignore

TUser Target Hot Connected
Ewa Chip Board Attached
Coverage Board Not Connected
Running status Break = User Break
Trace Count 131072

Trace Timestamp OverFlow HNone

Target Mode Ignore

Target FWE Ignore

Target Clock Ignore

Figure 3.10 [Extended Monitor] Window
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34.2 Selecting Items to be Displayed

Selecting [Properties...] from the popup menu displays the [Extended Monitor Configuration] dialog box.

— Update millsecond
-QK
Bunning: | 1000 Break: | 5000
LCancel |
Settings:
Item I Walue =
User RES |nactive
Uszer M| |nactive
User wialT Inactive L
User BREQ Inactive
User HSTBY Inactive
Uszer IWDTOVF Inactive
[ User IRQ7-0 11111111
User YCC lanare -
1 | _>l_I

Figure 3.11 [Extended Monitor Configuration] Dialog Box
This dialog box allows the user to set the items to be displayed in the [Extended Monitor] window.

Note: The items that can be set in this window depend on the emulator in use. For details, refer to the online
help.
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3.5 Displaying Memory Contents in Realtime

Use the [Monitor] window to monitor the memory contents during user program execution. In the Monitor
function, the realtime operation is retained since the bus monitoring circuit of the emulator sets the read/write
signal of the MCU as a trigger and holds the address bus and data bus values to update the displayed contents of
the memory.

Up to eight points or 256 bytes in total can be set by using the eight monitoring channels on the bus monitoring
circuit. It is possible that a part or all of monitoring ranges is overlapped.

Notes: 1. Monitoring is impossible for an area, such as an on-chip timer counter, where no internal write signal
is generated to update a value.
2. The procedure to display or modify the contents of memory differs depending on the product. If the
display of memory contents is updated during execution of the user program, realtime emulation may
not be available. For details, refer to section 5.3, Displaying and Modifying the Contents of Memory.

3.5.1 Opening the [Monitor] Window

To open the [Monitor] window, select [View -> CPU -> Monitor -> Monitor Setting...] or click the [Monitor]
toolbar button () to display the [Monitor Settings] dialog box.

Manite e |

Monitor Setting I

Mame : |monitor1

— Dptionz
Address

Size (byte] - [Honz0 =l
[

Access [Fomat) : IBYTE [ASCI)

v &uto-Refresh at rate [ms)] : ID'DDEDD

¥ Beading the Iritial alue

r— Colar
Change ndicator : IChange j
Foreground : _I"l Background I:IIYI
¥ Mayfly
r— Detail
IDETAILNDT SUPPORTED! Dietail... |
—History

| [
QK I Cancel |

Figure 3.12 [Monitor Setting] Dialog Box
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[Name]: Decides the name of the monitor window.

[Options]: Sets monitor conditions.
[Address]: Sets the start address for monitoring.
[Size]: Sets the range for monitoring.
[Access]: Sets the access size to be displayed in the monitor window.
[Auto-Refresh at rate]: Sets the interval for acquisition by monitoring (500 ms at minimum).

[Reading the Initial Value]: ~ Selects reading of the values in the monitored area when the monitor
window is opened.

[Color]: Sets the method to update monitoring and the attribute of colors.

[Change Indicator]: Selects how to display the values that have changed during monitoring
(available when [Reading the Initial Value] has been selected).
No change: No color change.

Change: Color is changed according to the [Foreground] and [Background]
options.

Gray: Those data with values that have not been changed are displayed in
gray.
Appear: A value is only displayed after changed.

[Foreground]: Sets the color used for display (available when [Change] has been selected).
[Background]: Sets the background color (available when [Change] has been selected).
[Mayfly]: A check in this box selects restoration of the color of those data which have

not been updated in a specified interval to the color selected in the
[Background] option. The specified interval is the interval for monitor
acquisition (available when [Change], [Gray], or [Appear] has been selected).

[Detail]: Sets the items specific to the emulator.
[History]: Displays the previous settings.

Notes: 1. In this emulator, odd addressees cannot be specified as the start addresses for monitoring.
2. Selection of the foreground or background color may not be available depending on the operating
system in use.

After setting, clicking the [OK] button displays the [Monitor] window.
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b monitor: monitor1 - DOFFE40D _ |0 x|

® 2 |15 =] |[oeasci =]

Address | 40| +1| 42| +3 | +4 | 45| +6| +7 | +8 | 49| +A| 4B | +C| 4D | +E | +F | Value
OOFFE400 OO 00 79 4B 00 00 59 EZ 00 00 44 6B 00 00 41 C6 ..yE..¥...Dk..A.
OOFFB410 00 OO0 3F 54 00 00 27 81 00 00 1¢c FB 00 00 16 7E .2Te.'.u..... -

Figure 3.13 [Monitor] Window
During user program execution, the display is updated according to the setting value of the auto-update interval.

Note: Select [Refresh] from the popup menu when data is not displayed correctly after changing the address or
content of memory.

3.5.2 Changing the Monitor Settings

Selecting [Monitor Setting...] from the popup menu of the [Monitor] window displays the [Monitor Setting]
dialog box, which allows the settings to be changed.

Colors, the size of accesses, and the display format can be easily changed from [Color] or [Access] of the popup
menu.

353 Temporarily Stopping Update of the Monitor

During user program execution, the display of the [Monitor] window is automatically updated according to the
auto-update interval. Select [Lock Refresh] from the popup menu of the [Monitor] window to stop the update of
display. The characters in the address section are displayed in black, and the update of display is stopped.

Selecting [Lock Refresh] again from the popup menu cancels the stopped state.

3.5.4  Deleting the Monitor Settings

Selecting [Close] from the popup menu of the [Monitor] window to be deleted closes the [Monitor] window and
deletes the monitor settings.

3.5.5 Monitoring Variables
Using the [Watch] window refers to the value of any variables.

When the address of the variable registered in the [Watch] window exists within the monitoring range that has
been set by the Monitor function, the value of the variable can be updated and displayed.

This function allows checking the content of a variable without affecting the realtime operation.
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3.5.6 Hiding the [Monitor] Window

When using the Monitor function to monitor the value of a variable from the [Watch] window, hide the
[Monitor] window for the effective use of the screen.

The current monitoring information is listed as the submenu when selecting [Display -> CPU -> Monitor]. The
list consists of the [Monitor] window name and the address to start monitoring.

When the left of the list is checked, the [Monitor] window is being displayed.

Selecting items of the [Monitor] window you want to hide from the monitor setting list displays no [Monitor]
window and removes the check mark at the left of the list.

To display the [Monitor] window again, select the hidden the [Monitor] window.

L4 _i Monitor Setting. .. Shift+Ckrl+E

[ menitor2 - HooFFEOS0
monitor] - H'OOFFE000 ("_heap_area™)

Windows Select. ..

Figure 3.14 Monitor Setting List
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3.5.7 Managing the [Monitor] Window

Selecting [Display -> CPU -> Monitor -> Windows Select...] displays the [Windows Select] dialog box. In this

window, the current monitoring condition is checked and the new monitoring condition is added, edited, and
deleted in succession.

Selecting multiple monitoring conditions enables a temporary stop of update, hiding, and deletion.

2]

| Mame | &ddress |

¥ moniterZ  H'OOFFECS0
¥ manitar H'OOFFED [*_heap_area™)

Add..

Edit... |
Lock Fiefresh? |
Hide? |
Remove |

LCloze |

Figure 3.15 [Windows Select] Dialog Box

[Add]: Adds a new monitoring condition.
[Edit]: Changes the settings of the selected [Monitor] window (disabled when selecting multiple
items).

[Lock Refresh/Unlock Refresh]:
Automatically updates or stops updating the display of the selected [Monitor] window.

[Hide/UnHide]: Displays or hides the selected [Monitor] window.
[Remove]: Removes the selected monitoring conditions.

[Close]: Closes this dialog box.
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3.6 Looking at Variables

This section describes how you can look at variables in the source program.

3.6.1 [Watch] Window

You can view any value in the [Watch] window.

----- H'000041ck { FFE400 }
----- R [1] H'00001e7e { FFE404 }
----- R [2] H'O000Z781 { FFE408 }
----- R [31 H'000044ek { FFE40C }
----- R [4] H'O0000794k { FFE410 }
----- R [5] H'000015fk { FFE414 }
----- R [6] H'00005%9e2 { FFE418 }
----- R [7] H'00001cfh { FFE41C }
----- R o[s81 H'00003f54 { FFE420 }
----- R [9] H'OO00Offe { FFE4Z4 }
------ i H'OOOa { RZ }

4[> [ watcht A wiatchz } Watchs }, Wwatchd f

Figure 3.16 [Watch] Window
The [R] mark shows that the value of the variable can be updated during user program execution.

It is possible to recognize the method for updating the value during user program execution according to the
color of the [R] mark.

Blue-outline [R]: ~ The address of the variable is within the range that has been set for the monitoring function
and the data is readable by using the monitoring function.

Blue [R]: An updated value of the data at this location has been read by the monitoring function.

Black-outline [R]:  The address of the variable is outside the range that has been set for the monitoring function
and the data is not readable by using the monitoring function.

Black [R]: A value has been updated by reading the normal data.
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Notes: 1.
2.
3.
4.

This function can be set per variable or per element or body for structures of data.

The color of an [R] in the [Name] column changes according to the monitoring settings.

A variable that is allocated to a register cannot be selected for monitoring.

The procedure to display or modify the contents of memory differs depending on the product. If the
display of memory contents is updated during execution of the user program, realtime emulation
may not be available. For details, refer to section 5.3, Displaying and Modifying the Contents of
Memory.

The SH7059 E6000H emulators incorporate a dedicated on-chip RAM monitor of 256 bytes x 12
points for the watch function that only allows the contents of the on-chip RAM to be displayed in
realtime. Enabling Auto Update after registering variables automatically allows use of this on-chip
RAM monitor, while disabling Auto Update or deleting variables cancels use of the on-chip RAM
monitor. When Auto Update is enabled while all of the 12 points of this on-chip RAM monitor are in
use, the values will be updated by reading data as usual. To display the contents of memory other
than the on-chip RAM in realtime, use the normal monitor.
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3.7 Using the Event Points
The emulator has the event point function to support breakpoints of the following three types.

Software breakpoints: Execution of the user program stops when the instruction at the specified address is
fetched. Up to 255 software breakpoints can be set. Any content at the specified address is replaced by a break
instruction (a dedicated instruction for use with the emulator). The software breakpoint cannot be set in the
write-protected area such as ROM area or flash memory area on the user system. The user can set a software
breakpoint in the [Editor] or [Disassembly] window.

On-chip breakpoints: These break functions built in the MCU. Conditions on the address bus, data bus,
bus/area, and satisfaction count can be set. The on-chip breakpoint can be set even in the ROM area or flash
memory area on the user system. It is also possible to set a sequential breakpoint consisted of several on-chip
breakpoints. The user can set an on-chip breakpoint in the [Editor] or [Disassembly] window.

On-emulator breakpoints: On-emulator break functions are implemented by dedicated hardware in the
E6000H station. Conditions on the address bus, data bus, bus/area, external probe signals, external interrupt
signals, and satisfaction count can be set. As the emulator hardware provides this function, several cycles may be
required until a break occurs after satisfaction of a condition.

Software, on-chip, and on-emulator breakpoints can be set in the [Event] window.

Select [View -> Code -> Eventpoints] or click the [Eventpoints] toolbar button () to open the [Event] window.

=lolx|
[ |EI
Type | State | Condition | Action I

IIII\Soﬂware j{ on Chip )\ O Ernulatar [‘

Figure 3.17 [Event] Window
The [Event] window has the following three sheets:

[Software] sheet: Displays the settings made for software breakpoints. It is also possible to set, modify,
and cancel software breakpoints.

[On Chip] sheet: Displays or sets on-chip breakpoints.
[On Emulator] sheet: Displays or sets on-emulator breakpoints.

Note: For notes on event points, refer o section 5.5, Event Functions.
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3.7.1

Use the [Software] sheet on the [Event] window to display, change, or add settings for software breakpoints.

Setting a Software Breakpoint

Select [Add...] or [Edit...] from the popup menu displayed on the [Software] sheet. The [Breakpoint Properties]
dialog box (the [Software Break] page) will appear.

Software Break | On Chip Break | On Emulator Break |

Sequerntial Break

FisF 2l a4 s 6 7251 8

[Caurt]
Address Fanage Break
(I‘ 510 = 112
Fiur e count between tigger outputs
’V I Erom 7 to & Back

21X

Cloge I Cance| | Apply

Figure 3.18 [Breakpoint Properties] Dialog Box ([Software Break] Page)
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To add a new software breakpoint, select an empty line from the list box on the [Software Break] page and click
the [Edit...] button. To change existing settings, select the software breakpoint that you want to change from the
list box and click the [Edit...] button. The [Software Break] dialog box is displayed.

2=

Address |

Address

Addiess  [H'00001 000

QK. I Cancel Apply

Figure 3.19 [Software] Dialog Box ([Address] Page)

Specify the breakpoint’s address in the [Address] edit box and click the [OK] button.
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3.7.2 Setting an On-Chip Breakpoint

Use the [On Chip] sheet on the [Event] window to display, change, or add settings for on-chip breakpoints.

Select [Add...] or [Edit...] from the popup menu displayed on the [On Chip] sheet. The [Breakpoint Properties]
dialog box (the [On Chip Break] page) will appear.

21X

Software Break,  On Chip Break I On Emulator Break |

Sequential Break

Tas 2o a3 4 85 B 751 8

[Caunt)
Address Range Break
(I‘ 310 ™ 12
Fiun time count between tigger outputs
’V I~ From 7o Back

=T LT e 0

TEIge

Edt. |  Besst | FResetay |

Cloge I Cance| | Apply |

Figure 3.20 [Breakpoint Properties] Dialog Box ([On Chip Break] Page)

[Sequential Break]:

[Address Range Break]:

Specifies a sequential break that uses channels 1 to 8. Channels are specified in a
sequential order. When channels other than 1 to 8 or 5 to 8 are used, the channels
shown as UNUSED are not available.

Specifies the combination of channels and the range of halting a break. For channels,
select either of the followings.

9-10: Channels 9 and 10 are used to specify the range of break.

11-12: Channels 11 and 12 are used to specify the range of break.

[Run time count between trigger outputs]:

[Back]:

Measures the time between two points by using channels 7 and 8. After channel 7 has
been satisfied, the time is measured when channel 8 is satisfied. The result is
displayed in [RunTime Count] on the [Platform] sheet of the [Status] window.

Puts the setting back to the previous state at the time the dialog box has been
displayed.
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List box: Displays the current settings for each of the channels. R shown as a channel number
indicates the reset point of a sequential break. If no setting has been made for a
channel, only the channel number is displayed here. When a channel is used for the
sequential break function, S is displayed next to the channel number.

[Edit...]: Clicking this button opens the [On Chip Break Channel n] dialog box (n: channel
number), which allows the user to set a break condition for a selected channel.

[Reset]: Clears the settings made for the selected channel.

[Reset All]: Clears the settings made for all of the channels.

The user can set more complex break conditions in the [On Chip Break Channel n] dialog box by a combination
of conditions provided on pages [Address], [Data], [Bus/Area], [Count], and [Action].

2]

Address | Data I Bus.-’.-’-\real Count | .-'-‘«ctionl

r Addre

Address  [HO0DO107C

[ Use mask I

Ol H" on 0 o B' i3 effective,
amazk iz and a nomask iz 0

ak I Cancel Lpply

Figure 3.21 [On Chip Break Channel n] Dialog Box
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[Address]: Sets address bus conditions.

[Don’t Care]: Selects no address bus condition.
[Address]: Sets an address bus value.
[Use mask]: Sets mask conditions. Set the mask bits if [Use mask] is selected. Masked bits satisfy

this break condition regardless of their values.

[Data]: Sets data bus conditions.

[Don’t Care]: Selects no data bus condition.
[Value]: Sets a data bus value.
[Use mask]: Sets mask conditions. Set the mask bits if [Use mask] is selected. Masked bits satisfy

this break condition regardless of their values.
[Access Size]:  Selects the data-access size.
[Bus/Area]: Sets access type, bus status, and read/write cycle conditions.
[Access type]:  Sets access type conditions.

[Bus State]: Sets bus status conditions. When [Don’t Care] has been selected, no bus status
condition can be set.

[Read/Write]: Sets read/write conditions. When [Don’t Care] has been selected, no read/write
condition can be set.

[Count]: Sets the satisfaction count of the condition. When [Don’t Care] has been selected, the
satisfaction count is defined as 1.

[Action]
[Break]: Halts execution when the selected condition has been satisfied.
[After execution]: Halts execution after the address at which the condition has been
satisfied.
[Before execution]: Halts execution before the address at which the condition is
satisfied.

[Output Trigger]: Outputs a trigger when the selected condition has been satisfied.
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3.7.3  Settings an On-Emulator Breakpoint

Use the [On Emulator] sheet on the [Event] window to display, change, or add settings for on-emulator

breakpoints.

Select [Add...] or [Edit...] from the popup menu displayed on the [On Chip] sheet. The [Breakpoint Properties]
dialog box (the [On Emulator Break] page) will appear.

point Properkies ﬂ ﬂ
Software Break | On Chip Break  On Emulstor Break I

Sequerntial Break

FisF 2l a4 s 6 7251 8

[Caurt]
Address Fanage Break
(I‘ 510 = 112
Fiur e count between tigger outputs
’V I Erom 7 to & Back

Edt. |  Besst | FResetay |

Cloge I Cance| | Apply |

List box:

[Edit...]:

[Reset]:

[Reset All]:
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Figure 3.22 [Breakpoint Properties] Dialog Box ((On Emulator Break] Page)

Displays the current settings for each of the channels. If no setting has been made for
a channel, only the channel number is displayed here.

Clicking this button opens the [On Emulator Break Channel n] dialog box (n: channel
number), which allows the user to set a break condition for a selected channel.

Clears the settings made for the selected channel.

Clears the settings made for all of the channels.
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The user can set more complex break conditions in the [On Emulator Break Channel n] dialog box by a
combination of conditions provided on pages [Address], [Data], [Bus/Area], [Probe], [Interrupt], and [Count].

o Emula & 21x|

Address | Data I Bus.-’.-’-\real Prabe | Interruptl Court I

~ Addre
[ :
¢ Addess  { Bange
Stat  [HO000107C [
End |

= Dutside Ranae

oK I Cancel Apply

Figure 3.23 [On Emulator Break Channel n] Dialog Box

RENESAS




[Address]:

[Datal]:

[Bus/Areal:

[Probe]:

[Interrupt]:

44

[Don’t Care]:

[Address]:

[Range]:

[Outside Range]:

[£0...]:

Sets data conditions.

[Don’t Care]:
[Value]:

[Use mask]:

[Except this value]:
[Access Size]:

[Position]:

[Long]:

[Word]:

[Byte]:

[Access type]:

[Bus State]:

[Read/Write]:

Sets address conditions.

Selects no address bus condition.

Select this button to set the address bus value specified in [Start] as the break
condition.

A break occurs in the range of the address bus values specified from [Start]
(start address) to [End] (end address).

Select this option to generate a break with an address bus outside the range
set in [Range].

The address range of a function can be set by [Start] and [End]. For details,
refer to section 5.10, Input Format.

Selects no data bus condition.
Sets a data bus value.

Sets mask conditions. Set the mask bits if [Use mask] is selected. Masked
bits satisfy this break condition regardless of their values.

Sets a value other than that has been specified as the data bus condition.
Selects the data-access size.

Sets a data bus value as a number. The position of the valid data bus is
specified.

None

4n: Upper word
4n + 2: Lower word

4n: Upper byte of the upper word

4n + 1: Lower byte of the upper word
4n + 2: Upper byte of the lower word
4n + 3: Lower byte of the lower word

Sets access type, bus status, and read/write cycle conditions.

Sets access type conditions. When [Don’t Care] has been selected, no access
type condition can be set.

Sets bus status conditions. When [Don’t Care] has been selected, no bus
status condition can be set.

Sets read/write conditions. When [Don’t Care] has been selected, no
read/write condition can be set.

Sets the levels (high or low) of the external probe signals (PRB1 to PRB4) as the condition.
When [Don’t Care] has been selected, the level of the selected probe signal cannot be set as the

condition.

Sets the levels (high or low) of the IRQ and NMI signals as the condition. When [Don’t Care]

has been selected, the level of the IRQ or NMI signal cannot be set as the condition.
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[Count]: Sets a satisfaction count condition. When [Don’t Care] has been selected, the satisfaction count
is defined as 1.

3.7.4 Editing Event Points

Handlings for settings other than software breakpoints, on-chip breakpoints, and on-emulator breakpoints are
common.

3.7.5 Modifying Event Points

Select an event point to be modified, and choose [Edit...] from the popup menu to open the dialog box that
corresponds the event, which allows the user to modify the event conditions. The [Edit...] menu is only available
when one event point is selected.

3.7.6 Enabling an Event Point

Select an event point and choose [Enable] from the popup menu to enable the selected event point.

3.7.7 Disabling an Event Point

Select an event point and choose [Disable] from the popup menu to disable the selected event point. When an
event point is disabled, the event point will remain in the list, but an event will not occur when the specified
conditions have been satisfied.

3.7.8 Deleting an Event Point

Select an event point and choose [Delete] from the popup menu to remove the selected event point. To retain the
event point but not have it cause an event when its conditions are met, use the [Disable] option (see section
3.15.7, Disabling an Event Point).

3.7.9 Deleting All Event Points

Choose [Delete All] from the popup menu to remove all event points.

3.7.10  Viewing the Source Line for an Event Point

Select an event point and choose [Go to Source] from the popup menu to open the [Editor] or [Disassembly]
window at the address of the event point. The [Go to Source] menu is only available when one event point that
has the corresponding source file is selected.
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3.8 Viewing the Trace Information

The emulator acquires the results of each instruction execution into the trace buffer as trace information and
displays it in the [Trace] window. The conditions for the trace information acquisition can be specified in the
[Trace Acquisition] dialog box.

Since trace information in bus-cycles is acquired by the hardware circuit and stored in the trace buffer, the
realtime operation is retained. The [Trace] window displays the content of the trace buffer, which records up to
128-k bus cycles from the last program run and is always updated.

Note: For notes on the trace functions, refer to section 5.6, Trace Functions.

3.8.1 Opening the [Trace] Window

To open the [Trace] window, choose [View -> Code -> Trace] or click the [Trace] toolbar button ().

3.8.2 Acquiring Trace Information

When the emulator does not set the acquisition condition of the trace information, all bus cycles are acquired by
default without any condition (free trace mode).

In the free trace mode, trace acquisition is started with the execution of the user program and stopped by halting
the user program. The acquired trace information is displayed in the [Trace] window.

=10 x|
|7 E S| |0
cycle ‘ Address ‘ c3 | Caodel Codel ‘ Data | R/W | Erd ‘ Bus | Frobes ‘ NMI | IRQ | TJ_mestax;I
-00010 fiffhfad 00000000 RD L CPO 1111 1 0000ha.
-00009 00002120 MOV R4,R0 MOV.L R1,E@(... 60430516 IF PO 1111 1 0000h0.
-00008 00002124 ADD #H'01,R2 MOV #H'OA,R7 72Z01e?0a IF PO 1111 1 0000h0.
-00007 ffff0424 00000000 WR b} PO 1111 1 0000h0.
-0000& 00002128 CME/GE R7,RZ BF @H'Z1... 32738bec IF cPooo 1111 1 0000h0.
-00005 0000Z212c ADD #H'Zc, RIS MOV. T @riS5+, RO TfIcedfE IF cPooo1111 1 0000h0 .
-00004 00002130 RTS NOP 000bO00S  IF cPooo1111 1 0000h0 .
-00003 ffffhfdn 00000000 RD b} cPooo1111 1 00000 .
-00002 000010a% JDATA.W H'0000 0000EZEZ  IF CPU 1111 1 0000RO.
—-00001 000010a8 2d22dels IF CPU 1111 1 0000k,

——— 1

Figure 3.24 [Trace] Window
This window displays the following trace information items:

[PTR]: Cycle number in the trace buffer. When the most recent record is record 0, earlier
record numbers go backwards (-1, -2, ...). If a delay count has been set, the cycle
number where the trace stop condition has been satisfied is record 0. For the cycle
(during delay) executed until the trace has stopped, earlier record numbers go forward
(+1, 42, ...) the most recent record.

[Address]: Address on the processor bus

[CS]: CS area (the SH7059 E6000H emulator does not have this item)
[CodeO]: Upper 16-bit instruction code being executed

[Codel]: Lower 16-bit instruction code being executed
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[Datal]:

[R/W]:

[SZ]:
[Bus]:

[Probes]:

[NMI]:

[IRQ:

[Timestamp]:

[Source]:
[Label]:

[Timestamp-Difference]

Data in byte, word, or longword units, displayed as 2-digit, 4-digit, or 8-digit
hexadecimal

Whether the cycle was for reading, writing, or fetching.
IF: Fetch cycle

RD: Read cycle

WR: Write cycle

Selects the size of an access as B (byte), W (word), or L (longword).
Bus mastership

A 4-Dbit binary number showing the four probe pins in the order of Probe 4, Probe 3,
Probe 2, and Probe 1 from the left.

NMI signal state

IRQ signal states (0: low level, 1: high level) showing in the order of IRQ7 to IRQO
from the left. If the 32-bit time stamp counter is enabled, the states of IRQ7 to IRQO
are ANDed and this result will be displayed.

Time stamp of the record. Time stamps start from zero each time the user program is
executed. Select the minimum unit used in time measurement in the [Trace
Acquisition Properties] dialog box.

Source program of the executed instruction address
Label information of the address (if defined)

Difference from the timestamp value shown on the previous line

It is possible to hide any column not necessary in the [Trace] window. Selecting a column you want to hide from
the popup menu displayed by clicking the right-hand mouse button on the header column hides that column. To
display the hidden column, select the column from the said popup menu again.
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3.8.3 Specifying Trace Acquisition Conditions

The capacity of the trace buffer is limited. When the buffer becomes full, the oldest trace information is
overwritten. Setting the trace acquisition condition allows acquisition of useful trace information and effective
use of the trace buffer.

There are the following types of trace acquisition conditions.

Free trace: Acquires trace information continuously from the start of the user program execution to the
occurrence of a break (only when no trace acquisition condition is set).

Sequential trace stop: Specifies the order of trace acquisition conditions to be satisfied and stops trace
acquisition when all of the conditions are satisfied. It is possible to set up to seven pass points and one reset point.
No break will occur even when the trace acquisition stops.

Trace stop due to trace buffer overflow: Stops trace acquisition when the trace buffer in the emulator station
overflows. No break will occur even when the trace acquisition stops.

Trace stop: Stops trace acquisition when the specified conditions are satisfied. In this mode, trace acquisition
stops without stopping the user program execution. Up to 12 points can be set independently as trace stop
conditions. No break will occur even when the trace acquisition stops.

Address range trace: Acquires trace information of instructions or operands accessed in the range (subroutine)
between the start and end addresses. Note that, however, when the selected subroutine calls another subroutine,
no trace information will be acquired from the called subroutine. Up to 12 points can be set independently as the
address ranges.

Conditional trace: Only acquires trace information from the points where the specified conditions are satisfied.
Up to 12 points can be set independently as the conditions.

Address range conditional trace: Accesses instructions or operands in the range (subroutine) between the start
and end addresses and only acquires trace information in the bus cycles that satisfy the conditions. This mode is
a combination of address range trace and conditional trace. Up to six points can be set independently as the
address ranges with conditions.

Point to Point trace: Acquires trace information from the satisfaction of the address condition set as a start
condition to that of the address condition set as an end condition.

Execution time measurement: Measures execution time between two points by using the trace acquisition
conditions.

Trigger output: Outputs a pulse from trigger pins when the specified conditions are satisfied.

The trace acquisition condition is set in the [Trace Acquisition] dialog box that is displayed by selecting
[Acquisition...] from the popup menu.

The [Trace Acquisition Properties] dialog box has the pages [Condition] and [Other].
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(1) [Condition] page

Condition I Other |

— Combination
— Sequential Trace Stop

Jd

s 2o 3o 40 8e B2 7

[ ResetPoint [Delay]
— Run time count between tigger outputs
v Free trace
[~ Use & From o2 = From 3 to 4 o =
£ From 5 to & = From 7 to 8 Back

‘

Edt. | Besst | Fesetan |

Close I Cancel | Apply

Figure 3.25 [Trace Acquisition Properties] Dialog Box ([Condition] Page)

[Sequential Trace Stop]:

Use this option to set a sequential trace stop by using channels 1 to 7. The sequential
trace stop function allows trace acquisition to stop when the conditions of several
channels are satisfied in the specified order. Two to seven pass points and one reset
point are selectable as sequential trace stop conditions. The conditions are satisfied in
the order of 1 to 7. To use a sequential trace stop, select the checkbox of the channel.
To set a reset condition, select the [Reset Point] checkbox. Channel 8 is used for a
reset condition. When a reset condition is satisfied, all the sequential trace stop
conditions that have been satisfied will be cleared and the emulator starts checking
the first condition again. When a sequential trace stop is enabled, no setting is
available for the channels (out of 1 to 7) that are not used for the sequential trace stop
function.

[Run time count between trigger outputs]:

[Free trace]:

[Back]:

Selects channels for use in execution time measurement. Clicking [Use] allows
measurement of time in tracing. There are four types of channel combinations
consisted of those for the start and the end of measurement: 1-2, 3-4, 5-6, and 7-8.

Selects the free trace mode. When [Free trace] is enabled, any trace acquisition
condition set will be ignored.

Puts the setting back to the previous state at the time the dialog box has been
displayed.
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List box:

[Edit...]:

[Reset]:

[Reset All]:

50

Displays the current settings for each of the channels. If no setting has been made for
a channel, only the channel number is displayed here. When a channel is used for the
sequential trace stop function, S is displayed next to the channel number. When a
reset condition for a sequential trace stop is enabled, R is displayed next to channel 8.
PtoP is for use in the Point to Point trace. UNUSED is displayed next to the channel
number if that channel is not available.

Clicking this button opens the [Trace Acquisition Condition Channel n] dialog box (n:
channel number or PtoP), which allows the user to set a break condition for a selected
channel.

Clears the settings made for the selected channel.

Clears the settings made for all of the channels.
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(2) [Other] page

2=
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Figure 3.26 [Trace Acquisition] Dialog Box ([Other] Page)
[When trace-buffer full]: Selects an action to take when the trace buffer becomes full.
[No action]: Overwrites the oldest information in the trace buffer.
[Stop trace]: Stops trace acquisition without stopping the user program execution.
[Stop execution and trace]: Stops the user program execution.

[Time measurement unit]: Selects the minimum time unit for the time stamping of the bus trace information.

[52us]: Time stamping is in minimum time units of 52 ps.
[1.6us]: Time stamping is in minimum time units of 1.6 ps.
[20ns]: Time stamping is in minimum time units of 20 ns.
[Clock]: Time stamping is in terms of the number of bus-clock cycles, i.e., is

synchronized with the cycles of the internal clock signal (¢).

[Clock/2]: Time stamping is in terms of the number of bus-clock cycles, i.e., is
synchronized with 1/2 cycle of the internal clock signal (¢).

[Clock/4]: Time stamping is in terms of the number of bus-clock cycles, i.e., is
synchronized with 1/4 cycle of the internal clock signal (¢).

51
RENESAS




[Clock/8]: Time stamping is in terms of the number of bus-clock cycles, i.e., is
synchronized with 1/8 cycle of the internal clock signal (¢).

[Selection of the trace contents]:
Selects the form to display time stamps and IRQ7 to IRQO. In this emulator,
acquisition of time stamps and IRQ signals in tracing is realized by the same hardware
resource. It is thus not available to use the 32-bit time stamp counter and IRQ7 to
IRQO tracing at the same time. Select either of the following options according to the
situation.

[Time stamp]: Enables the 32-bit time stamp counter for display of time stamps. For IRQs,
the states of IRQ7 to IRQO are ANDed and this result is displayed.

[IRQ7-0 all indications]: Lower 16 bits of time stamps are fixed to 0. The states of IRQ7-0 are
displayed respectively.

[Suppress]: Acquires no DMAC or AUD cycles.
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(3) [Trace Acquisition Condition Channel n] dialog box

Use this dialog box to set pass points and a reset point for a sequential trace stop, and conditions in the address
range trace, address range conditional trace, conditional trace, Point to Point trace, execution time measurement,

and a trigger output.

n Condition 2=l
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[ Enable output trigger
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Figure 3.27 [Trace Acquisition Condition Channel n] Dialog Box

The [Trace Acquisition Condition Channel n] dialog box has pages [Action], [Address], [Data], [Bus/Area],
[Probe], [Interrupt], [Count], and [Delay]. The user can make more complex settings by a combination of

conditions provided on these pages.

[Action]

[After Condition Match]: Selects an action to take when a condition is satisfied.

[Trace Stop]:

[Address Range Trace]:

[Acquisition Condition]:

Selects a trace stop.

Selects an address range trace. Selecting this option and checking
[Combination with the next channel] allows an address range
conditional trace.

Selects a conditional trace.

[None]: Select this option if you do not want to take any of the actions listed
above. This is useful for a trigger output or execution time
measurement.

[Address]: Sets the start and end addresses of the range in the address range trace,

address range conditional trace, or Point to Point trace.
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[Start]: Set the start address.

[End]: Set the end address.
[fO...]: The address range of a function can be set by [Start] and [End].
[Output Trigger]: Outputs a trigger after the satisfaction of a trace condition.
[Address]: Sets address conditions.
[Datal]: Sets data conditions.
[Bus/Areal: Sets access type, bus status, and read/write cycle conditions.
[Probe]: Sets the levels (high or low) of the external probe signals (PRB1 to PRB4) as the condition.
[Interrupt]: Sets the levels (high or low) of the IRQ and NMI signals as the condition.
[Count]: Sets a satisfaction count condition.
[Delay]: Sets the number of bus cycles delayed after the satisfaction of a trace condition. This function

allows you to check the trace information before/after any of the specified conditions are
satisfied. When [Don’t Care] has been selected, there is no delay.

Notes: 1. The settings to be made on pages [Address], [Data], [Bus/Area], [Probe], [Interrupt], and [Count] are
the same as those for on-emulator break conditions. For details on the on-emulator break conditions,
refer to section 3.7, Using the Event Points.

2. Set the range in the address range trace so that value of the end address will be larger than that of the
start address.

3. Two channels are used in the address range conditional trace. To perform the address range
conditional trace, select an odd-numbered channel (2n + 1) for the address range trace and an even-
numbered channel (2n + 2) for the conditional trace, respectively, and then check [Combination with
the next channel].
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3.84 Searching for a Trace Record

Use the [Trace Find] dialog box to search for a trace record. To open this dialog box, choose [Find...] from the

popup menu.

ace Find Xl

Bus | Potes | IR@ | Timestamp
General | Address | Data | s | Rw

Trace search range
[~ Mot designation [~ Upward search

Start PTR : I'1 31071
EndPTR : ID—

0]4 I Cancel Spply

Figure 3.28 [Trace Find] Dialog Box

The [Trace Find] dialog box has the following options:

[General]: Sets the range for searching.
[Not designation]: Searches for information that does not match the conditions set in other
pages when this box is checked.
[Upward search]: Searches upwards when this box is checked.
[Start PTR]: Enters a PTR value to start a search.
[End PTR]: Enters a PTR value to end a search.
[Address]: Set an address condition.

[Don't care]:

[Value]:
[Data]:

[Don't care]:

[Value]:
[CS]:

[Don't care]:

[Value]:
[R/W]:

Detects no address when this box is checked.
Detects the specified address. Enter an address value.
Set a data condition.
Detects no data when this box is checked.
Detects the specified data. Enter a data value.
Set a CS condition. (No CS condition can be set in the SH7059 E6000H emulator.)
Detects no CS when this box is checked.
Detects the specified CS.

Select the type of access cycles.
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[Don't care]: Detects no read/write condition when this box is checked.

[Setting]: Detects the specified read/write condition.
[RD]: Read cycle
[WR]: Write cycle
[IF]: Instruction fetch cycle

[Bus] Set a bus mastership condition.
[Don't care]: Detects no bus mastership condition when this box is checked.
[Setting]: Detects the specified bus mastership condition.

[Probes]: Select the status of probe signals.
[Don't care]: Detects no probe signal condition when this box is checked.
[Setting]: Detects the specified probe signal condition.

Don't care: Detects no selected probe condition.
High: The status of the probe signal is high.
Low: The status of the probe signal is low.

[IRQ]: Sets an IRQ signal condition.
[Don't care]: Detects no IRQ signal condition when this box is checked.
[Setting]: Detects the specified IRQ signal condition.

Don't care: Detects no selected IRQ signal condition.
High: The status of the IRQ signal is high.
Low: The status of the IRQ signal is low.

[Timestamp]: Specify the time stamp value for bus cycles.
[Don't care]: Detects no time stamp value when this box is checked.
[Setting]: Detects the specified time stamp value. Enter a time stamp value.

Clicking the [OK] button after setting conditions in those pages stores the settings and starts searching. Clicking
the [Cancel] button closes this dialog box without setting of conditions.

When a trace record that matches the search conditions is found, the line for the trace record will be highlighted.
When no matching trace record is found, a message dialog box will appear.

Only the trace information that satisfies all the conditions set in above pages will be searched.

If a find operation is successful, selecting [Find Next] from the popup menu will move to the next found item.

3.8.5 Clearing the Trace Information

Select [Clear] from the popup menu to empty the trace buffer that stores the trace information. If several [Trace]
windows are open, all [Trace] windows will be cleared as they all access the same buffer.
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3.8.6 Saving the Trace Information in a File

Select [Save...] from the popup menu to open the [Save As] file dialog box, which allows the user to save the
information displayed in the [Trace] window as a text file. A range can be specified based on the [PTR] number
(saving the complete buffer may take several minutes). Note that this file cannot be reloaded into the [Trace]
window.

Note: In filtering of trace information, the range to be saved cannot be selected. All the trace information
displayed in the [Trace] window after filtering will be saved. Select a filtering range on the [General]
page in the [Trace Filter] dialog box if you want to save the selected range. For details on the filtering
function, refer to section 3.8.11, Extracting Records from the Acquired Information.

3.8.7 Viewing the [Editor] Window
The [Editor] window corresponding to the selected trace record can be displayed in the following two ways:

e Select a trace record and choose [View Source] from the popup menu.
e Double-click a trace record

The [Editor] or [Disassembly] window opens and the selected line is marked with a cursor.

3.8.8 Trimming the Source
Choose [Trim Source] from the popup menu to remove the white space from the left side of the source.

When the white space is removed, a check mark is shown to the left of the [Trim Source] menu. To restore the
white space, choose [Trim Source] while the check mark is shown.

3.8.9 Temporarily Stopping Trace Acquisition
To temporarily stop trace acquisition during execution of the user program, select [Halt] from the popup menu.

This stops trace acquisition and updates the trace display. Use this method to check the trace information without
stopping execution of the user program.

3.8.10  Restarting Trace Acquisition

To restart trace acquisition being stopped during execution of the user program, select [Restart] from the popup
menu.
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3.8.11 Extracting Records from the Acquired Information

Use the filtering function to extract the records you need from the acquired trace information. The filtering
function allows the trace information acquired by hardware to be filtered by software. Unlike the settings made
in the [Trace Acquisition] dialog box for acquiring trace information by conditions, changing the settings for
filtering several times to filter the acquired trace information allows easy extraction of necessary information,
which is useful for analysis of data. The content of the trace buffer will not be changed even when the filtering
function is used. Acquiring useful information as much as possible by the [Trace Acquisition] settings improves
the efficiency in analysis of data because the capacity of the trace buffer is limited.

Use the filtering function in the [Trace Filter] dialog box to select a range for filtering.

Probes I IR I Timestamp
Genetal | Addess | Daa | C5 | Raw | Bus

] Enable Filker

[ Mot designation

Trace dizplay range

Start PTR: I
End PTF : I

ak I Cancel Lpoply

Figure 3.29 [Trace Filter] Dialog Box ([General] Page)
To open the [Trace Filter] dialog box, select [Filter...] from the popup menu.
The [Trace Filter] dialog box has the following pages:
[General]: Sets the range for filtering.

[Don't care other pages]: Only selects the cycle number when this box is checked. Other options
become invalid.

[Enable Filter]: Enables the filter when this box is checked.

[Not designation]: Filters information that does not match the conditions set in those pages
when this box is checked.

[Start PTR]: Enter a PTR value to start filtering.
[End PTR]: Enter a PTR value to end filtering.
[Address]: Set an address condition.
[Don't care]: Filters no address when this box is checked.
[Setting]: Detects the specified address.
[Point]: Enter a single address value.
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[Range]: Specify an address range.

[From]: Enter a single address value or the start of the address range.
[To]: Enter the end of the address range.
[Datal: Set a data condition.
[Don't care]: Filters no data when this box is checked.
[Setting]: Detects the specified data.
[Point]: Enter a single data value.
[Range]: Specify a data range.
[From]: Enter a single data value or the minimum value of the data range.
[To]: Enter the maximum value of the data range.
[CS]: Set a CS condition. (No CS condition can be set in the SH7059 E6000H emulator.)
[Don't care]: Filters no CS when this box is checked.
[Setting]: Detects the specified CS.
[R/W]: Select the type of access cycles.
[Don't care]: Detects no read/write condition when this box is checked.
[Setting]: Detects the specified read/write condition.

[RD]:  Detects read cycles.
[WR]: Detects write cycles.

[Bus]: Set a bus mastership condition.
[Don't care]: Detects no bus mastership condition when this box is checked.
[Setting]: Detects the specified bus mastership condition.

[Probes]: Select the status of probe signals.
[Don't care]: Detects no probe signal condition when this box is checked.
[Setting]: Detects the specified probe signal condition.

Don't care: Detects no selected probe condition.
High: The status of the probe signal is high.
Low: The status of the probe signal is low.

[Timestamp]: Specify the time stamp value for bus cycles.
[Don't care]: Detects no time stamp value when this box is checked.
[Setting]: Detects the specified time stamp value.
[Point]: Specify a single time stamp value.
[Range]: Specify a time stamp range.
[From]: Enter a single time stamp value or the minimum value of the time

stamp range.
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[To]: Enter the maximum value of the time stamp range.

Set filtering conditions and then press the [OK] button. This starts filtering according to the conditions. Clicking
the [Cancel] button closes the [Trace Filter] dialog box, which holds the settings at the time when the dialog box
was opened.

In filtering, only the trace information that satisfies one or more filtering conditions set in the above pages will
be displayed in the [Trace] window.

Filtering conditions can be changed several times to analyze data because the content of the trace buffer is not
changed by filtering.
3.8.12  Calculating the Difference in Time Stamping

Select [Timestamp Difference...] from the popup menu to calculate the time difference between the two points
selected by the result of tracing in acquisition of time stamp information.

2]

—Select 2 line

First PTH : |'32?54 Second PTR : ID

|Timestamp difference information :

Timestamp Difference -

0000k 000min 000z 003ms 897us 875ns Get Difference
Clear |

« [

Figure 3.30 [Timestamp Difference] Dialog Box
[Select 2 line]: Select trace records to calculate the time stamp difference.

[First PTR]: Specifies the first pointer to measure the difference. The pointer of the line
selected on the [Trace] window is displayed by default.

[Second PTR]: Specifies the second pointer to measure the difference.
[Timestamp Difference]: Displays the results of calculation.

[Get Difference]: Calculates the difference between the specified two points and display its result in the
[Timestamp Difference] list.

[Clear]: Clears all the results in the [Timestamp Difference] list.
[OK]: Closes the dialog box. All the results in the [Timestamp Difference] list are cleared.
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3.8.13  Analyzing Statistical Information

Choose [Statistic] from the popup menu to open the [Statistic] dialog box and analyze statistical information
under the specified conditions.

Result :

Besult

== {33}
Ix

LClear

Condition | Amount I FTR

K I

I,

LClose

[Statistic Analysis]:
[Default]:
[Range]:
[Item]:

[Start]:

[End]:

[Set]:
[New]:
[Result]:
[Clear]:

[Close]:

Figure 3.31 [Statistic] Dialog Box
Setting required for analysis of statistical information.
Sets a single input value or character string.
Sets the input value or character string as a range.
Sets the item for analysis.

Sets the input value or character string. To set a range, the start value must be
specified here.

Specify the end value if a range has been set (only available when [Range] has been
selected).

Adds a new condition to the current one.

Creates a new condition.

Obtains the result of statistical information analysis.

Clears all conditions and results of statistical information analysis.

Closes this dialog box. All the results displayed in the [Result] list will be cleared.
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This dialog box allows the user to analyze statistical information concerning the trace information. Set the target
of analysis in [Item] and the input value or character string by [Start] and [End]. Click the [Result] button after
setting a condition by pressing the [New] or [Add] button to analyze the statistical information and display its
result in the [Result] list.

Note: In this emulator, only [PTR] can be set as a range. Each of other items must be specified as a character
string. In analysis of statistical information, character strings are compared with those displayed in the
[Trace] window. Only those that completely match are counted. Note, however, that this test is not case
sensitive. The number of blanks will not be cared either.

3.8.14  Extracting Function Calls from the Acquired Trace Information

To extract function calls from the acquired trace information, select [Function Call...] from the popup menu.
The [Function Call Display] dialog box will be displayed.

2]

Setting
Enable to display trace infarmation with function
call only ?
o | " Disable
ok LCancel

Figure 3.32 [Function Call Display] Dialog Box

[Setting]: Selects whether or not to extract function calls.
[Enable]: Extracts function calls.
[Disable]: Does not extract function calls.

When [Enable] is selected, only the cycles that include function calls are extracted for display from the acquired
trace information. The content of the trace buffer is not changed by extraction of function calls. Using this
function for the result of the free trace or the trace information that includes function calls allows the user to
know the order of function calls.
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39 Analyzing Performance

Use the performance analysis function to measure the rate of execution time. The performance analysis function

does not affect the realtime operation because it measures the rate of execution time in the specified range by

using the circuit for measurement of hardware performance included in the emulator.

Select one of the following five modes according to the purpose of measurement.

Table 3.1  Available Measurement Modes
Mode Description Purpose
Time Of Specified Range  Measures the execution time and  Measurement of time taken for
Measurement execution count in the specified processing of functions except for

Start Point To End Point
Measurement

range.

Measures the execution time and
execution count between the
specified addresses.

that required for child functions
called from the functions.

Measurement of time taken for
processing of functions.

Start Range To End
Range Measurement

Measures the execution time
from a specified range to another
specified range.

Measurement of execution time
spent from calling of any of
sequential subroutines to calling of
any of other sequential subroutines
in a program that includes
subroutines in sequence, such as
an assembly program.

Access Count Of
Specified Range
Measurement
Called Count Of
Specified Range
Measurement

Measures the number of times a
specified range is accessed from
another specified range.
Measures the number of times a
specified range has called
another specified range.

Measurement of the number of
times a global variable is accessed
from a specific function.

Measurement of the number of
times a function is called from a
specific function.

Use eight performance channels installed on the circuit for measurement of hardware performance in the

emulator for setting of conditions for measurement. Up to eight points can be set.

Note, however, that up to four points can be set in Start Range To End Range Measurement, Access Count Of

Specified Range Measurement, or Called Count Of Specified Range Measurement because two sequential points
are used for setting a condition in these modes.
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Table 3.2 Mode Settings for Measurement

Point

Measurement Mode

Time Of Specified Range 0 0 0 o) e} o (e} (¢]
Measurement

Start Point To End Point 0 0 0 0 0 [e] (6] [¢]
Measurement

Start Range To End o) _ 0 _ 0 _ 0 _
Range Measurement

Access Count Of lo) — 0 — 0 — 0 —
Specified Range

Measurement

Called Count Of lo) — 0 — 0 — 0 —
Specified Range

Measurement

Note: O: Available
—: Not available

Note: Only one point is used in Time Of Specified Range Measurement and Start Point To End Point
Measurement, while two sequential points are used in Start Range To End Range Measurement, Access
Count Of Specified Range Measurement, and Called Count Of Specified Range Measurement. The
conditions that have been set will be canceled when switching these modes of different types.
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3.9.1 Opening the [Performance Analysis] Window

Choose [View -> Performance -> Performance Analysis] or click the [PA] toolbar button () to open the
[Select Performance Analysis Type] dialog box.

erformance Anal

EE000H Perfarmarn

Performance Analpsis:

Figure 3.33 [Select Performance Analysis Type] Dialog Box

Select [E6000H Performance Analysis] and then click the [OK] button to open the [Performance Analysis]

window.

5 [=
*a e *E [
No Name | Condition ‘ Rate ‘ RUN-TIME MAX-MIN-TIME Count O0---10---20---30--
1 pal Range H'00002046 E'000020c4  14% 00k 0O0win 00s 00lms 303us 820ns 1 HEARBES
2
3
4
3
3
;
8
4 | i}

Figure 3.34 [Performance Analysis] Window

This window displays the rate of execution time in the area selected by the user during the last program run in
percentages, histogram, or numerical values.

It is possible to hide any column not necessary in the [Performance Analysis] window. Selecting a column you
want to hide from the popup menu displayed by clicking the right-hand mouse button on the header column
hides that column. To display the hidden column, select the column from the said popup menu again.
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3.9.2 Setting Conditions for Measurement

Conditions for measurement can be displayed and changed in the [Performance Analysis] window. Select a point
where a condition is to be set, and then select [Set...] from the popup menu to display the [Performance Analysis
Properties] dialog box.

Select either from the following five modes as the condition by the [Measurement Method] option:

Table 3.3  Conditions for Measurement (Measurement Method)

[Measurement Method] Option

Time Of Specified Range Measurement
Start Point To End Point Measurement

Start Range To End Range Measurement

Access Count Of Specified Range Measurement
Called Count Of Specified Range Measurement

Set a condition for measurement according to the mode being selected. The parameters to be set depend on the
modes.

The [Performance Analysis Properties] window has a support function to enter the address range of a function
automatically if the name of the function is entered to set an address range. Entering a function name in the
[Input Function Range] dialog box displayed by clicking the [...] button on the [Performance Analysis
Properties] dialog box automatically enters the address range of the function.

d b

Eunction
IS ample::sortlong®) Cancel |

Figure 3.35 [Input Function Range] Window

Notes: 1. Entering the name of an overload function or a class opens the [Select Function] dialog box. Select a
function in this dialog box.

2. The addresses figured out are just for reference. In some cases, the end address of a function may be
different. Check the last instruction of the function in the [Disassembly] window to correct the value
set in [End Address] so that it will be the address of the last instruction (in general, the last instruction
of a function is a RTS instruction). A label name or an expression can be entered instead of an
address value in boxes where an address should be entered.
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(1) Time Of Specified Range Measurement

21X

Measurement Method PAT: Time Of Specified R ange Measurement j

Bange Hame : IF'A'I
Fange

Start Address IH'DDDDDDDD J
End Address : IH'DDDDDDDD

— Common Settings of Performance(PA1-8)
Address Control Mode: PC

Tirme Measurement Unit: 20ns

Cancel |

Figure 3.36 Time Of Specified Range Settings

[Range Name]: The name of the range to be measured

[Range]: The range for the Time Of Specified Range Measurement
[Start Address]: Address to start measurement
[End Address]: Address to end measurement

Measures the execution time and the execution count in the range between the start address and end address.
Starts measurement with a detected program prefetch in the range specified between the start and end addresses,
and then stops with a detected program prefetch out of the specified range. Measurement can be restarted with a
detected program prefetch in the specified range. The execution count is incremented every time the program is
prefetched at the end address of the specified range. The execution time measured does not include the time
spent while being called from the specified range.
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(2) Start Point To End Point Measurement

Measurement Method PAT: Start Paint Ta End Point Measurement j

21X

Paint

End

Bange Hame : IF'A'I

Start Address IH'DDDDDDDD J
Time Out Action: IDisabIe Yl

Address : IH ‘00000000

— Common Settings of Performance(PA1-8)
Address Control Mode: PC

Tirme Measurement Unit: 20ns

Cancel |

[Range Name]:

[Point]:
[Start Address]
[End Address]:

[Time Out Action]:

[Time Out]:
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Figure 3.37 Start Point To End Point Measurement Settings
The name of the range to be measured
The range for the Start Point To End Point Measurement
: Address to start measurement
Address to end measurement
The action to take when a timeout or count-out occurs.

Disable: Disables setting of a timeout or count-out value.
Enable: Stops the user program execution when a timeout or count-out occurs.
Trace Stop: Stops trace acquisition when a timeout or count-out occurs.

This is only available for channel 1.

The timeout value to finish measurement. When the minimum time for measurement
is 160 ns, 40 ns, or 20 ns, enter the value as follows.
Example: 1h 2min 3s 123ms 456us 789ns

If the CPU operating mode is target, enter a hexadecimal number in 10 digits.
Example: 123456789A

A break occurs every time a value measured in the specified range exceeds the
timeout value (not the total time). This is only available for channel 1.
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[Count]: The count-up value used in measurement of the execution count. A break occurs
every time the execution count exceeds the count-up value. This is only available for
channel 1.

Measures the execution time and the execution count in the range between start address and end address. Starts
measurement with a detected program prefetch at the start address, and then stops with a detected program
prefetch at the end address. The execution count is incremented every time the program is prefetched at the end
address of the specified range. The execution time measured includes the time spent while being called from the
specified range. When either from one to four points is selected, the maximum and minimum time in the
specified range can be measured.
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(3) Start Range To End Range Measurement

Measurement Method PAT: Start Range To End Range Measurement j

Bange Hame : IF'A'I
Start Range End Range

Start Address IH'DDDDDDDD J Start Address : IH'DDDDDDDD _I
End Address : IH'DDDDDDDD End Address : IH'DDDDDDDD

— Common Settings of Performance(PA1-8)
Address Control Mode: PC

Tirme Measurement Unit: 20ns

Cancel |

Figure 3.38 Start Range To End Range Measurement Settings

[Range Name]: The name of the range to be measured

[Start Range]: The start range for the Start Range To End Range Measurement
[Start Address]: Start address
[End Address]: End address

[End Range]: The end range for the Start Range To End Range Measurement
[Start Address]: Start address
[End Address]: End address

Starts measurement with a detected prefetch cycle in the specified start address range, and then stops with a
detected prefetch cycle in the specified end address range. The execution count is incremented every time the
program passes the end address range.
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(4) Access Count Of Specified Range Measurement

Measurement Method PAT: Access Count OF Specified Fange Measurement j

Bange Hame : IF'A'I

Fange Aocess Area Range

Start Address IH'DDDDDDDD J Start Address : IH'DDDDDDDD _I
End Address : IH'DDDDDDDD End Address : IH'DDDDDDDD

— Common Settings of Performance(PA1-8)
Address Control Mode: PC

Tirme Measurement Unit: 20ns

Cancel |

Figure 3.39 Access Count Of Specified Range Measurement Settings

[Range Name]: The name of the range to be measured
[Range]: The range for the Access Count Of Specified Range Measurement
[Start Address]: Start address
[End Address]: End address
[Access Area Range]: The access range for the Access Count Of Specified Range Measurement
[Start Address]: Start address
[End Address]: End address

Measures the number of times the range specified as the access range is accessed from the range specified by the
start and end addresses. The execution count in the range is measured with Time Of Specified Range
Measurement mode.
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(5) Called Count Of Specified Range Measurement

Measurement Method PAT: Called Count OF Specified Range Measurement j

21X

Fange

Bange Hame : IF'A'I

Start Address IH'DDDDDDDD J Start Address : IH'DDDDDDDD _I
End Address : IH'DDDDDDDD End Address : IH'DDDDDDDD

Call Range

— Common Settings of Performance(PA1-8)
Address Control Mode: PC

Tirme Measurement Unit: 20ns

Cancel |

Figure 3.40 Called Count Of Specified Range Measurement Settings

[Range Name]:

[Range]:
[Start Address]:
[End Address]:

[Call Range]:

[Start Address]:

[End Address]:

The name of the range to be measured

The range for the Called Count Of Specified Range Measurement
Start address
End address

The range for the Called Count Of Specified Range Measurement. As the call range,
specify the start and end addresses of the selected subroutine.

Start address

End address

Measures the number of times the range specified as the call range is called from the range specified by the start
and end addresses. The execution time in the specified range can be measured with Time Of Specified Range
Measurement mode. As the call range, specify the start and end addresses of the selected subroutine.

72

RENESAS




3.9.3 Starting Performance Data Acquisition
Executing the user program clears the result of previous measurement and automatically starts measuring the rate

of execution time according to the conditions that have been set. Stopping the user program displays the result of
measurement in the [Performance Analysis] window.

394 Deleting a Measurement Condition

Select [Reset] from the popup menu with a measurement condition selected to delete the condition.

3.9.5 Deleting All Measurement Conditions

Choose [Reset All] from the popup menu to delete all the conditions that have been set.
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3.10 Profiling Function

3.10.1 Enabling the Profile

Choose [View->Performance->Profile] to open the [Profile] window. Choose [Enable Profiler] from the popup
menu of the [Profile] window. The item on the menu will be checked.

3.10.2  Specifying Measuring Mode

You can specify whether to trace functions calls while profile data is acquired. When function calls are traced,
the relations of function calls during user program execution are displayed as a tree diagram. When not traced,
the relations of function calls cannot be displayed, but the time for acquiring profile data can be reduced.

To stop tracing function calls, choose [Disable Tree (Not traces function call)] from the popup menu in the
[Profile] window (a check mark is shown to the left of the menu item).

When acquiring profile data of the program in which functions are called in a special way, such as task switching
in the OS, stop tracing function calls.

3.10.3  Executing the Program and Checking the Results

After the user program has been executed and execution has been halted, the results of measurement are
displayed in the [Profile] window.

The [Profile] window has two sheets; a [List] sheet and a [Tree] sheet.
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3.10.4  [List] Sheet

i ]

& -= ||E[§|Show Functions" anables j EJ‘-} | &F

Function/Varisble I F/Vl Address | Size Times I Cyclesl
_PowerON _Reset PC F 0o0o00a00  H'OOOOO0ZE 1 208
Sample: :change (long *) F 0000Z0OCE  H'OO0OOOEA 1 150
Sample: :sort{long *) F 0ooo0zZo3z  H'OOODOOO9: 1 401
Sample: :Sample () F 0o0oozooo  H'O0OOOO3Z 1 145
_rand F Qooolzzes  E'OOQOOOZC 10 273
operator new(unsigned long) F oooollicg  H'OOOOOCOED 1 g
_ CATL_INIT F 0ooo1i7e H'OOOOOOZE 1 77

_ INITSCT F 0ooo11io ®H'O0OOOO0O0O 1 293
tutorial (} F 00001054 H'OOOOOOQAOD 1 1205
_main F 0oooio3s  ®'O0OOOO1c 1 52

AN Kl List 4 Tree

Figure 3.41 [Profile] Window ([List] Sheet)

This window displays the address and size of a function or a global variable, the number of times the function is
called or the global variable is accessed, and profile data.

When the column header is clicked, data are sorted in alphabetic or numeric ascending/descending order.

Double-clicking the [Function/Variable] or [Address] column displays the source program of the address in the
line. Right-clicking on the mouse within the window displays a popup menu. For details on this popup menu,
refer to section 3.10.5, [Tree] Sheet.

Note: For notes on the profiling function, refer to section 5.9, Profiling Function.
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3.10.5 [Tree] Sheet

=1olx|

7
Address

[E5 == ||E,":,|Show Functions/\ariables =

Function 3tack Zize

owerON_Reset () 0oooo4o0 H'00000024 H'00000000 1
_ INITSCT 000010ES H'00000000  H'00000000 1 48074
_srand 0o0011as H'0000O00E  H'00O0OO000 1 135
__ CALL INIT 0000114E H'0000001E  H'O0O0OO00 1 268
é“"_main 000010ZA H'00000004  H'O00000000 1 63
= tutorial() O00010ZE H'00000028  H'O0O0OOO00 1 3151
sEample () 0o0o0zooo H'0000O046  H'O0O0OO00 1 603
r:ichange (long *) 0000Z0CE H'00000054  H'00000000 1 4605
tgort (long *) 0000zZ046 H'00000020  H'O0000OO00 1 15632
0o0o0117A H'000000ZE  H'0O0O0CO00 10 4120

A Y Hf List A Tree

Figure 3.42 [Profile] Window ([Tree] Sheet)

This window displays the relation of function calls in a tree structure. Displayed contents are the address, size,
stack size, and number of function calls and execution cycles. The stack size and number of function calls are
values when the function is called.

The [Tree] sheet is only available when [Not trace the function call] is not checked in the popup menu of the
[Profile] window.

Double-clicking a function in the [Function] column expands or reduces the tree structure display. The
expansion or reduction is also provided by the “+” or “-” key. Double-clicking the [Address] column displays the
source program of the specific address.

Right-clicking on the mouse within the window displays a popup menu. Supported menu options are described
in the following sections:

e View Source

Displays the source program or disassembled memory contents for the address in the selected line.

e View Profile-Chart

Displays the [Profile-Chart] window focused on the function in the specified line.

e Enable Profiler

Toggles acquisition profile data. When profile data acquisition is active, a check mark is shown to the left of the
menu text.
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o Not trace the function call
Stops tracing function calls while profile data is acquired. This menu is used when acquiring profile data of the
program in which functions are called in a special way, such as task switching in the OS.

To display the relation of function calls in the [Tree] sheet of the [Profile] window, acquire profile data without
selecting this menu. In addition, do not select this menu when optimizing the program by the optimizing linkage
editor using the acquired profile information file.

. Find...

Displays the [Find Text] dialog box to find a character string in the [Function] column. Search is started by
inputting a character string to be found in the edit box and clicking [Find Next] or pressing the Enter key.

e Clear Data
Clears the number of times functions are called and profile data. Data in the [Profile] window’s [List] sheet and
the [Profile-Chart] window are also cleared.

e Output Profile Information Files...

Displays the [Save Profile Information Files] dialog box. Profiling results are saved in a profile information file
(.pro extension). The optimizing linkage editor optimizes user programs according to the profile information in
this file. For details of the optimization using the profile information, refer to the manual of the optimizing
linkage editor.

Note: If profile information has been acquired by selecting the [Not trace the function call] menu, the program
cannot be optimized by the optimizing linkage editor.

e  Output Text File...
Displays the [Save Text of Profile Data] dialog box. Displayed contents are saved in a text file.

e  Setting
This menu has the following submenus (the menus available only in the [List] sheet are also included).

1. Show Functions/Variables

Displays both functions and global variables in the [Function/Variable] column.

2. Show Functions

Displays only functions in the [Function/Variable] column.

3. Show Variables

Displays only global variables in the [Function/Variable] column.

4. Only Executed Functions

Only displays the executed functions. If a stack information file (.sni extension) output from the optimizing
linkage editor does not exist in the directory where the load module is located, only the executed functions are
displayed even if this check box is not checked.

5. Include Data of Child Functions

Sets whether or not to display information for a child function called in the function as profile data.

e  Properties...
This popup menu is unavailable in the SH7058 E6000H emulator.
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3.11 [Profile-Chart] Window

o Profile-Chart -3 x|

5 <] |2

|»

tutoriali)

-
«| | »

Figure 3.43 [Profile-Chart] Window

This window displays the relation of calls for a specific function. This window displays the calling relation for
the function specified in the [List] sheet or [Tree] sheet in the [Profile] window. The specified function is
displayed in the middle, the calling function on the left side, and the called function on the right side. Values
beside the calling and called functions show the number of times the function has been called.

Right-clicking on the mouse within the window displays a popup menu. Supported menu options are described
in the following sections.

e  View Source

Displays the source program or disassembled memory contents for the address of the function on which the
cursor is placed when the right-hand mouse button is clicked. If the cursor is not placed on a function when the
right-hand mouse button is clicked, this menu option is displayed in gray characters.

e  View Profile-Chart

Displays the [Profile-Chart] window for the specific function on which the cursor is placed when the right-hand
mouse button is clicked. If the cursor is not placed on a function when the right-hand mouse button is clicked,
this menu option is displayed in gray characters.

o Enable Profiler
Toggles acquisition of profile data. When profile data acquisition is active, a check mark is shown to the left of
the menu text.

e Clear Data
Clears the number of times functions are called and profile data. Data in the [List] sheet and [Tree] sheet in the
[Profile] window are also cleared.
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e Multiple View

If the [Profile-Chart] window is going to be opened when it has already been opened, selects whether another
window is to be opened or the same window is to be used to display data. When a check mark is shown to the
left side of the menu text, another window is opened.

e Output Profile Information File...

Displays the [Save Profile Information File] dialog box. Profiling results are saved in a profile information file
(.pro extension). The optimizing linkage editor optimizes user programs according to the profile information in
this file. For details of the optimization using the profile information, refer to the manual of the optimizing
linkage editor.

e Expands Size
Expands spaces between each function. The “+” key can also be used to expand spaces.

e Reduces Size

@ s

Reduces spaces between each function. The “-” key can also be used to reduce spaces.
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Section 4 Tutorial

4.1 Introduction
This section describes the main functions of the emulator by using a tutorial program.

The tutorial program is based on the C++ program that sorts ten random data items in ascending or descending
order. The tutorial program performs the following actions:

e The main function repeatedly calls the tutorial function to repeat sorting.

e The tutorial function generates random data to be sorted and calls the sort and change functions in
that order.

e The sort function enters the array where the random data generated by the tutorial function are stored,
and sorts them in the ascending order.

e The change function then sorts the array, which was sorted in ascending order by the sort function, in
descending order.

The file tutorial. cpp contains the source code for the tutorial program. The file Tutorial.absisa
compiled load module in the Dwarf2 format.

Notes: 1. After recompilation, the addresses may differ from those given in this section.

2. This section describes general usage examples for the emulator. For the particular specifications of
each product, refer to section 3, Debugging, or the online help.

3. The operation address of Tutorial . abs attached to each product differs depending on the
product. Replace the address used in this section with the correct address in each product after
checking that it is placed on the corresponding line of the source program.

4. In this tutorial, the SH7058 E6000H emulator is taken as an example. File paths or the appearance of
figures differ depending on the product.
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4.2 Running the High-performance Embedded Workshop
Open a workspace by following the procedure listed in section 2.1.3, Selecting an Existing Workspace.

Select the following directory.
OS installation drive \Workspace\Tutoria\E6000H\7058

Notes: 1. The directory mentioned above cannot be specified depending on the version of the software. In such
cases, specify the following directory instead.
High-performance Embedded Workshop installation destination directory
\Tools\Renesas\DebugComp\Platform\E6000H\7058\Tutorial
2. The file path differs depending on the product. If necessary, replace \7058 with another name.

Then select the file indicated below.

2]

Lok in: Ia Tutarial j - IE:F -
| 1Debug_sh7058_e6000h_emulator_cpu
| 150urce

3 Tutorial, s

Filz name: | Open I
Files of type: I HEW Workspaces [ hws) =l Cancel |
-

Figure 4.1 [Open Workspace] Dialog Box
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4.3 Downloading the Tutorial Program

4.3.1 Downloading the Tutorial Program
Download the object program to be debugged.

e Select [Download module] from [Tutorial.abs] of [Download modules].

E@ Tutarial
E@ Tutorial
- a C zaurce file

Ela Co++ source fils
o e[ resetpro.cpp
| %] zort.epp

Q tutarial. cpp
Download modules

ad madule

Dependencie

shrk.h Download module {debug data only)
sorth Unlead medule
% stacksct.

Configure Yiew. ..

,T Allow Docking

Hide:

Figure 4.2 Downloading the Tutorial Program
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4.3.2 Displaying the Source Program

The High-performance Embedded Workshop allows the user to debug a user program at the source level.

e Double-click [Tutorial.cpp] under [C++ source file].

E@ Tutaorial
El@ Tutorial
B3 L source file
[=] dbsctc
intpra.c
resetprg.c
shik.c
B Q wectthl.c
{23 Co+ zource file

Q sort.cpp

tutarial.cpp
23 Download modules

Tutorial abs
4 Dependencies

| 1 Proj... | Elte.. | <dna.. |

1]

vold main (woid)
{
while (114
tutorial();

woid tutorial (void)
i
long j:
int 1i:
class ZJawple *p_sam;

p_Sam= Sample;
for( i=0; i<102 i4+4+ ){

J = randi):

if(3 < 014

3= -3

}

alil = 3:
H
b_Sam->Z0rt (&)}
p_sam->change (g) ;

p_sam-»s0=al0];
p_sam-rsl=all]:
p_sam-rsZ=al];
p_sam-rsi=ali];
p_sam-rsi=ald];
p_Sam-rs5=als]:
p_Sam->z6=al&] ;
p_sam-»sT=al7]:
p_sam-»rs&=ald];
p_sam-»s9=al9];
p_Sam;

Z4 00001035
z5

26 0000103 =
27 gooo1042
28

9

30

31 gooo1054
3z

33

34

35

36

37 gooo0105c
38 oooo01066
39 gooo0l06e
40 oooo0107 6
41 0000107a
42

43 0000107
44

45 goooio90
46 ooo0109a
47

45 oooo010=a4
49 gooodl0aa
50 0000 10b0o
51 000010k 6
=1 0000 10kbe
53 gooo10e2
54 goooi0cs
55 goodidce
56 oooo010c4
57 00o0010da
55 goo010e0
59

tutarial. cpp

Figure 4.3 [Editor] Window (Displaying the Source Program)

e Select a font and size that are legible if necessary.

Initially the [Editor] window shows the start of the user program, but the user can use the scroll bar to scroll
through the user program and look at the other statements.
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4.4 Setting a Software Breakpoint
A software breakpoint is a simple debugging function.

The [Editor] window provides a very simple way of setting a software breakpoint at any point in a program. For
example, to set a software breakpoint where the sort function is called:

e Select by double-clicking the [S/W Breakpoints] column on the line containing the sort function call.

Jd 3
E@ Tutarial ||
El@ Tutorial - - -
Ea [ source file z4 00001035 wolid main(wvoid)
Q dbscte 23 { .
B e 26 0000103= while (1) {
I IC 27 oooo104z tutoriali):
shrk.c 28 H

vecthl.c 38 !

B E3 T+ gource file 30

31 oooo01054 wvoid tutorial (void)

: 3z {
33 long j:
LT int 1i;
35 class Jawple *p_Zam;
36
37 oooo0105c r_=Sam= Sample:;
35 ooool06a Tfor ([ i=0; i<10; i++ ){
39 ooo0106e J = randi):
40 | 00001076 if (3 < 04
41 0000107a j = -3:
42 H
43 0000107 ali]l = 3:
44 i
45 | 0oO01090 & p_sam->s0rtia) ;
46 000010%9= r_sam->change (a) ;
47
45 0000104 r_sSam->s0=a[0];
49 0000 10&aa p_sam-»s3l1=a[l]:
50 0000 10k0 p_sam->32=a[2];
51 000010k r_sSam->33=a[3];
52 000010k r_Sam->34=a[4];
53 oo0010cz r_Sam->35=a[5];
54 0000 10es r_Seam->36=a[6]
55 0000 10ce p_sSsam->sT7=a[7];
56 000010044 r_sSam->s8=a[8];
57 0000 10da p_sam-»>39=a[3];
58 000010=0 p_Sam;
59 i

K10
Eeeoi [ETe | e | || tuorialepp

Figure 4.4 [Editor] Window (Setting a Software Breakpoint)

The symbol e will appear on the line containing the sort function. This shows that a software breakpoint
has been set.
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4.5 Setting Registers

Set a value in the program counter before executing the program.

Select [Registers] from the [CPU] submenu of the [View] menu or click the [Register] toolbar button ( to
display the [Register] window.

=10l x|
Nemwe | Walues | Radix |;
RO 00000000 Hex
Rl 00000000 Hex
B2 00000000 Hex
B3 00000000 Hex
R 00000000 Hex
RS 00000000 Hex
RE 00000000 Hex
BT 00000000 Hex
B8 00000000 Hex
RO 00000000 Hex
Ri0 00000000 Hex —
Rll 00000000 Hex
RlZ 00000000 Hex
R13 00000000 Hex
Rl4  0000DOOO Hex
R15  20AD0DSAS Hex
BC ADFOAZEE Hex
SR 00000000000000000000000011110000  --1111--—— Bin
GER 00000000 Hex
VER 00000000 Hex
MACH 00000000 Hex
MaCL 00000000 Hex =]

Figure 4.5 [Register] Window

To change the value of the program counter (PC), double-click on the PC value area in the [Register] window
with the mouse. The following dialog box is then displayed, and the value can be changed. Set the program
counter to H’00000A00 in this tutorial program, and click the [OK] button.

21X
Yalue : | 00000400
Radix: |Hex =
Set4s [\whole Register =l

86

Figure 4.6 [Register] Dialog Box (PC)
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4.6 Executing the Program
Execute the program as described in the following:

e To execute the program, select [Go] from the [Debug] menu, or click the [Go] button on the toolbar.

=

Figure 4.7 [Go] Button

While the program is executed, the current address bus value and the operating state of the MCU are displayed
on the status bar.

The program will be executed up to the software breakpoint that has been set, and an arrow will appear on the
[S/W Breakpoints] column in the [Editor] window to show the position where the program has halted, with the
message [ Br eak = Sof t war e Br eak] in the status bar.

Notes: 1. When the source file is displayed after a break, a path of the source file may be inquired. The location
of the source file is as follows:

OS installation drive \Workspace\Tutoria\E6000H\7058\Source

The directory mentioned above cannot be specified depending on the version of the software. In such
cases, specify the following directory instead.

High-performance Embedded Workshop installation destination directory
\Tools\Renesas\DebugComp\Platform\E6000H\7058\Source

2. The file path differs depending on the product. If necessary, replace \7058 with another name.
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24 00001038
25
26 0ooo103a
27 00001042
28
29
30
31 00001054
32
33
34
35
36
37 0000105
3B 00001066
el 0000106e
40 o0oooi07a6
41 oooo107a
42
43 0000107
43
A5 ooooi020
45 0o0o1059a
47
45 000010a4
439 0o00010&aa
50 00001060
51 000010k 6&
52 000010k
53 0ooo10c2
54 0ooo10cs
55 0o0o01i0ce
56 000010d4
57 0o0o10da
58 ooooi0e0

wold main (void)
{
while (11{
tutorial():

woid tutorial (woid)
{
long j:
int i:
class Sawple *p_sam;

p_sSam= Jample:
for{ i=0; i<10; i++ ) {
J = rand(]:
if(3 < 0
j=-1
H
ali]l = 3:
*
[ =3 p_sSam->sSort(a) ;
p_sam-rchange (&) ;

p_seam-»30=a[0] ;
p_sam-rsl=a[l]:
p_sam-rs2=alz]:
p_Sem-»>33=a[3];
p_sam-rsd=al4] :
p_sa->35=al5] ;
p_sSeam-»36=al[6&];
p_sam-xs7=al[7]:
p_Sat->38=a[8] ;
p_sam->s9=a[9]:
p_=am;

: tumﬁdcppl
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Figure 4.8 [Editor] Window (Break Status)
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The user can see the cause of the break that occurred last time in the [Status] window.

e Select [Status] from the [CPU] submenu of the [View] menu or click the [Status] toolbar button (EI). After
the [Status] window is displayed, open the [Platform] sheet, and check the St at us of Cause of | ast
br eak.

~lal x|
Item Status
Connected To: 3IHY058 E6D0O0H Ewmulator CPU 3H-ZE (EGOO0OH H-UDI USE Driver)
CPU IHT058
Mode &
Clock source SMHz
JTAG Clock 10MH=
Cause of last hreak Zoftware Break
FunTime Count 00hO00min00=s000m=s127us120ns

Method of RunTime Count &o to Bresk

4 I }I\ Mernory }\Plalform /{ Events [‘

Figure 4.9 [Status] Window

Note: The items that can be displayed in this window differ depending on the product. For the items that can
be displayed, refer to section 3, Debugging, or the online help.
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4.7 Reviewing Breakpoints
The user can see all the breakpoints set in the program in the [Event] window.

e Select [Eventpoints] from the [Code] submenu of the [View] menu or click the [Eventpoints] toolbar button
(, The [Event] window is displayed. Select the [Software] sheet.

i

a2 X% |=
Type | State I Condition I Action I
Software Enable PC=00001080 (tutorial.cpp/45) Break

mSoﬂware /{ Cn Chip }\ 2n Emulator [‘

Figure 4.10 [Event] Window

The popup menu, opened by clicking the [Event] window with the right-hand mouse button, allows the user
to set or change breakpoints, define new breakpoints, and delete, enable, or disable breakpoints.
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4.8 Referring to Symbols
The [Label] window can be used to display the information on symbols in modules.

Select [Label] from the [Symbol] submenu of the [View] menu. The [Label] window is displayed so that the user
can refer to the addresses of symbols in modules.

Il

BT ES

EP I Address I Hame I‘
oooooooo _RE3ET Vectors
ooooooln _INT Vectors
0ooao400 _INT Illegal code
0oooo404 _INT Illegal slot
ooooo408 _INT CPU_address
ooooo40c _INT DMAC_Address
ooooo410 _INT NMI
ooooo414 _INT User_ Ereak
ooooo418 _INT FPU
oooo041c _INT HUDI
ooooo4z0 _INT TRAFPA3Z
ooooo4z 4 _INT TRAFPA33
ooooo4zs _INT TRAPAZ4
ooooo4z e _INT TRAPAZS
ooooo430 _INT TRAPAZR
ooooo43 4 _INT TRAPAZT
ooooo43s _INT TRAPA3S
ooooo43c _INT TRAPAID
00000440 _INT TRAPA4D
oooo0444 _INT TRAPA4L
ooooo44s _INT TRAFPA4Z
ooooo44c _INT TRAFPA43
0O000044E zerodiv
0oooo450 _INT TRAPA44 LI

Figure 4.11 [Label] Window
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4.9 Viewing Memory

When the label name is specified, the user can view the memory contents that the label has been registered in the
[Memory] window. For example, to view the memory contents corresponding to _main in byte size:

e Select [Memory ...] from the [CPU] submenu of the [View] menu or click the [View Memory] toolbar
button (@) to open the [Format] dialog box. Enter _main in the [Begin] edit box and +££ in the [End] edit
box, respectively, and select Byte in the [Format] combo box.

2]

Displap Addrezs: I_main - l |
Scroll Start Address: IDUDDUUU - l |
Scroll End Address: IFFFFFFF 'l |

Ok I Cancel |

Figure 4.12 [Format] Dialog Box

e Click the [OK] button. The [Memory] window showing the selected area of memory is displayed.

- = 3|
[v o[ 040 8 2 |focdndh dode|xc a2 |@

2ddress | Lebel | Register| +0 +1 +2 +3 +4 +5 +6 +7 +8 +9 +&4 +B +C 4D +E +F | ASCII ﬂ
00001038 | wain 4F 2z EL 0Ol &0 13 88 00 89 05 BO 07 00 09 El Ol O".. ...........
00001048 60 13 688 00 8B F9 4F 26 00 0B 00 09 2ZF DE 2ZF E6  ..... ST
00001058 4F 22 7F F4 E4 00 D3 26 43 OB 00 09 60 03 EE 00 O"..... AC...m. ..
00001068 El 0a 3E 13 B89 10 D3 23 43 OB 00 09 62 03 42 11 ..>....HC...b.B.
00001078 9 00 62 2B D4 20 66 EI 65 63 45 08 60 53 04 26 ..b+. f.ecE.'S.&
00001088 7E 01 E1 0Oa 3E 13 8B EE D5 1B 64 D3 D3 1B 43 OB S d...c.
00001098 00 09 DS 19 64 D3 D3 1a 43 OB 00 09 D6 16 62 62 d.. .bb
00001028 zp 22 DE 15 52 61 1p 21 D6 13 52 62 1p 22 DE 12 -"..Ra.!..Fh."..
00001088 52 63 1p 23 D6 10 52 64 1D 24 D6 OF 52 65 1D 25 Re.#..Rd.§..Re.3
000010¢8 D6 Op 52 66 1b 26 DE OC 52 &7 1p 27 D6 On 52 68 ..Rf.5..Rg.'..Eh
00001008 1D 38 D6 09 52 69 1b 29 64 D3 D3 OA 43 OB 00 09 .[..Ri.)d...C...
000010E8 7F Oc 4F 26 KE F6 6D F& 00 0B 00 09 00 OB 00 03

000010F8 00 00 20 00 00 OO0 1z 28 FF FF 04 00 00 00 20 32

00001108 00 00 20 cE 00 00 11 B4 2F 16 2ZF 26 ZF 36 2F 46

00001118 2F 56 ZF 6& DL 1z Dz 13 A0 08 E5 00 63 16 64 16

00001128 A0 0z 00 09 23 52 73 04 34 36 BI FB 32 16 89 TS

00001138 Dl Op DZ OE A0 O 00 03 &3 16 &4 16 €5 16 a0 03

00001148 00 09 66 36 25 62 75 04 34 36 B89 FA 32 16 89 T3

00001158 66 F6 65 FE 61 F6 63 FE 62 F6 00 OB 61 FE 00 09

00001168 bsec to 00 00 15 D4 00 OO0 15 DC OO 00 15 DS 00 00 15 E8

00001178 | cann_ ZF DE ZF EE 4F 22 D2 0Oa DD Oa A0 OE EE 22 52 E1

00001188 2z 28 B9 05 42 0B 00 03 7FE Oc 62 DZ 3E 22 8B F6

00001198 4F 26 6E F6 00 OB 6D F6 DZ 03 42 2B 00 09 OO0 OO

00001128 00 00 15 ©8 00 00 15 cc 00 00 13 D4 24 48 89 02 =l

Figure 4.13 [Memory] Window
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4.10 Watching Variables

As the user steps through a program, it is possible to watch that the values of variables used in the user program
are changed. For example, set a watch on the long-type array a declared at the beginning of the program, by the

following procedure:
e Click the left of displayed array a in the [Editor] window to place the cursor.

e Select [Instant Watch...] with the right-hand mouse button.

The following dialog box will be displayed.

[ & { FFFFO400 } (lang[10]]

Figure 4.14 [Instant Watch] Dialog Box

e Click the [Add] button to add a variable to the [Watch] window.

-\ akch

g [m 3]

RE |/ X|H

A p ] watcha 4 wratchz  viestchs J watcha [

Figure 4.15 [Watch] Window (Displaying the Array)
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The user can also add a variable to the [Watch] window by specifying its name.

e Click the [Watch] window with the right-hand mouse button and select [Add Watch...] from the popup menu.

The following dialog box will be displayed.

2]

Warnable ar expreszion:

i LCancel |

Figure 4.16 [Add Watch] Dialog Box

e Enter variable i to [Variable or expression] edit box and click the [OK] button.

The [Watch] window will now also show the int-type variable 1.

------ i H'0000000= { R14 } [int)

A p ] watcha 4 wratchz  viestchs J watcha [

Figure 4.17 [Watch] Window (Displaying the Variable)
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The user can click mark ‘+” at the left side of array a in the [Watch] window to watch all the elements.

----- R [0] H'00000000 { FFFFO400 }  (long)
----- R [1] H'000053dc { FFFFO404 }  (long)
----- R [z H'00002704 { FFFFO408 }  (long)
----- R [3] H'00005665 { FFFFO40C }  (long)
----- R [4;] H'00000d=a= { FFFFO410 }  (long)
----- R [5] H'O000421f { FFFFO414 }  (long)
----- R [6] H'00003ead { FFFFO418 } (long)
----- R [7] H'00004d1d { FFFFO41C } (long)
----- R [a] H'00002f5=a { FFFFO42Z0 }  (long)
----- R [9] H'000020d=a { FFFFO424 }  (long)
------ i H'0000000= { r14 } [int)

Ay watch1 4 wiastchz i watch3 J, Watchd [f

Figure 4.18 [Watch] Window (Displaying Array Elements)
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4.11 Displaying Local Variables

The user can display local variables in a function by using the [Locals] window. For example, we will examine

the local variables in the tutorial function, which declares local variables j, 1, andp_sam.

e Select [Locals] from the [Symbol] submenu of the [View] menu. The [Locals] window is displayed.

The [Locals] window shows the local variables in the function currently pointed to by the program counter,
along with their values. Note, however, that the [Locals] window is initially empty because local variables are

yet to be declared.

JRT=TES

-------- i H'0000000= { R14 }  [ink)
----- p_sam Oxf£££03d83 { R13 } (class Sample*)

Figure 4.19 [Locals] Window

The user can click mark ‘+’ at the left side of class instance p_sam in the [Locals] window to watch all the
elements. View the elements of class instance p_sam before and after the execution of the sort function and

check that the random data is sorted in the descending order.
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4.12 Stepping Through a Program

The High-performance Embedded Workshop provides a range of step menu commands that allow efficient
program debugging.

Table 4.2 Step Options

Menu

Command Description

Step In Executes each statement, including statements within functions.

Step Over Executes a function call in a single step.

Step Out Steps out of a function, and stops at the statement following the statement in the program
that called the function.

Step... Steps the specified times repeatedly at a specified rate.

4.12.1 Executing the [Step In] Command
The [Step In] command steps into the called function and stops at the first statement of the called function.

e To step through the sort function, select [Step In] from the [Debug] menu, or click the [Step In] button on
the toolbar.

®

Figure 4.20 [Step In] Button
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11 0oooz000
12 00002002
13 0o00z014
14 0000zZ018
15 0000201&
16 0000zZ01e
17 Oo0ooz01e
15 ooooz0z0
19 Qooozozz2
z0 O000Z0Z4
21 0000zZ026
22 0ooozZozs
&3
24
25 Qoooz032
Zh
a7
28
8
30 0000203 &
31 0000zZ03e
32 0o0oz040
33 0000Z046
34 Qooozos52
35 0000z05=a
36 0000z2074
37 oooozove
36 0000z096
39
40
41
42
43
44
45 0000Z0k6
46

0 tutonalepp o

Sample: :Sample )

{
s0=0;
s1=0;
z2=0;
s3=0;
s4=0;
55=0;
s6=0;
s7=0;
z8=0;
s9=0;

Crvoid Sample::sortilong *a)
{
long t;
int i, 3j, k, gap:

gap = 5;
while| gap > 0 14
for( k=0: k<gap: k++){
for{ i=k+gap; i<10; i=i+tgap )1
for (j=i-gap: J>=K: J1=]-gap) |
ifialjl=ali+gap] )
t = alil:
ali]l = aljt+gapl:
al[j+gap] = t©:
}
slse
break;

gap = gapf2:;

Figure 4.21 [Editor] Window (Step In)

e The highlighted line moves to the first statement of the sort function in the [Editor] window.
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4.12.2 Executing the [Step Out] Command

The [Step Out] command steps out of the called function and stops at the next statement of the calling statement.

e To step out of the sort function, select [Step Out] from the [Debug] menu, or click the [Step Out] button in
the toolbar.

Figure 4.22

[Step Out] Button

24 00001038 wold wain(void) j
25 i
26 o0o0103a while (1){
27 00001042 tutorial():
28 3
29 B
a0
31 00001054 wvioid tutorial (void)
3z i
33 long 3:
24 int i:
35 class Sample *p_sam; =1olx|
36
37 | ooO00105e p_sam= Sample: R 2|00/ X |5
38 00001066 for{ i=0; i<10; i++ ) {
39 0000106 1 = randi():
40 | 00001076 i£(3 < D)t
. || coonenra 3 o e ~R [0] H'00000000 { FFFFO400 }  (long)
az s ~R [1] H'00000daa [ FEFF0404 |  (long)
43 | 0000107¢ ali] = 3: R [2] H'000020da { FFFF0408 } (long)
24 ' ~R [3] H'00002704 { FFFFO40cC }  [long)
45 | 00001080 L] p_sam->Sort (a); " )
26 | oeEmiEEm s e ere g ~R [4] H'O000Zf5a [ FFFF0410 | (long)
a7 R [S] H'00003ead { FFFF0414 } (long)
48 | 000010a4 p_sam->s0=a[0] ; ~R [6] H'0000421f { FFFFO0418 } (long)
49 | 00001Daa i) EETE R[] 5 ~R [7] H'00004d1d { FFFFO41c }  [long)
&0 000010b0O p_ﬁﬂmf>SZ:ﬂ[2] ;
o1 | ooooioms P eass5=al3] + R [8] H'000053dc { FFFF0420 } (long
5z | 00001Obe p_sam->sd=al4]: ~R [9] H'O000S6E5 { FFFFO424 | (long)
53 000010c2 p_sam->s5=a[5]; i H'0000000a { R14 } (int)
54 | 000010=8 p_sam->sc=a[6] ;
55 | 000010ce p_sam->s7=a[7]:
56 | 00001044 p_sam->sB=al&] ;
57 | 000010da p_sam->s9=a[9] ;
58 000010e0 P Sam;
. ¥ - A watcha £ watchz J wiatcha  wiatcha [
1] T
Figure 4.23 [High-performance Embedded Workshop] Window (Step Out)
The data of variable a displayed in the [Watch] window is sorted in the ascending order.
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4.12.3 Executing the [Step Over] Command

The [Step Over] executes a function call in a single step and stops at the next statement of the main program.

e To step through all statements in the change function in a single step, select [Step Over] from the [Debug]

menu, or click the [Step Over] button on the toolbar.

Figure 4.24 [Step Over] Button

=101x|

24 00001038 wvoid main(wvoid)
25 {

26 0000103a while (1)1

27 | 00001042 tutorial () ;

28 i

29 1

30

31 00001054 woid tutorial (void)

3z {

33 long 32

34 int 1;

35 olags Sample *p sam:
)

37 0000105 p_sam= Sample:
38 00001066 for{ i=0; i<10; i++ ) {
39 | 0000106e 3 = rand():
40 | 00001076 if(3 < 0j{

41 | 0000107a 3= -a:

4z +

43 | 0000107c a[i] = 3:

44 i

45 | 00001090 L ] p_sam->sort(a) ;

46 0000108a p_Sam->change (a) 7
47

45 000010a4 o p_sam-rs0=a[0];

49 000010&aa
a0 000010k0
51 000010beE
52 000010be
53 onoo10cz
54 000010cs
55 000010ce
56 00001044
a7 000010da
58 000010e0

p_sem-»si=a[1];
p_sam-rsi=al2];
P Sam->3¥=al3];
p_sam->s4=al4] ;
p_Sam->s5=al[5]:
p_sam->s6=a[f] ;
p_sam->s7=al7]:
p_sam->s8=a[8] ;
p_sam-rs2=a[9];
p_san;

R E o/ K|S

=1oix]

B [o] H'00005665 { FFFFO400
- R [1] H'000033de { FFFFO404
~R [2] H'00004d1d { FFFFO408
-~ R [3] H'0000421f { FFFFO40C

B o[4] H'00003ead { FFFFO410

B [5] H'00002f5a { FFFF0414
- R [8] H'00002704 { FFFFO413
~R 7] H'000020da { FFFFO41C
~ R 8] H'00000daa { FFFFO42Z0

B [9] H'00000000 { FFFFO4Z4

i H'0000000= { R14 }

A, wateht

Wiatchz y Watchs b Watchd [

Figure 4.25 [High-performance Embedded Workshop] Window (Step Over)

The data of variable a displayed in the [Watch] window is sorted in the descending order.
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4.13 Forced Breaking of Program Executions
The High-performance Embedded Workshop can force a break during the execution of a program.
o Cancel all the breakpoints.

e To execute the remaining sections of the t ut ori al function, select [Go] from the [Debug] menu or the
[Go] button on the toolbar.

Figure 4.26 [Go] Button

e The program goes into an endless loop. To force a break during execution, select [Halt] from the [Debug]
menu or the [Halt] button on the toolbar.

Figure 4.27 [Halt] Button

4.14 Resetting the Target MCU

Resetting the target MCU initializes the on-chip I/O registers and makes the program counter jump to the address
set in the reset vector.

e To reset the target MCU, select [Reset CPU] from the [Debug] menu or the [Reset CPU] button on the
toolbar.

Figure 4.28 [Reset CPU] Button

e To execute the user program immediately after a reset, select [Reset Go] from the [Debug] menu or the
[Reset Go] button on the toolbar.

Figure 4.29 [Reset Go] Button

Note: This tutorial program is executable from the reset vector.
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4.15 Break Function

The emulator provides break functions by software breaks, on-chip breaks, and on-emulator breaks. Software
breakpoints, on-chip breakpoints, and on-emulator breakpoints can be set in the High-performance Embedded
Workshop’s [Event] window.

An overview and setting of the break function are described below.

4.15.1 Software Break Function
The emulator can set up to 255 software breakpoints.

e Select [Eventpoints] from the [Code] submenu of the [View] menu or click the [Eventpoints] toolbar button
(, The [Event] window is displayed.
e Select the [Software] sheet.

=T
a2 X |=
Type | State I Condition |Act:i.0n I

IIII\Soﬂware .'[\ on Chip )\ ©n Ernulator !“

Figure 4.30 [Event] Window (Before Setting a Software Breakpoint)

e Click the [Event] window with the right-hand mouse button and select [Add...] from the popup menu.
e The [Breakpoint Properties] dialog box ([Software Break] page) is displayed.
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21X

Software Break | On Chip Break | On Emulator Break |

Sequerntial Break

FisF 2l a4 s 6 7251 8

[Caurt]
Address Fanage Break
(I‘ 510 = 112
Fiur e count between tigger outputs
’V I Erom 7 to & Back

Cloge I Cance| | Apply |

Figure 4.31 [Breakpoint Properties] Dialog Box
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e Click the [Edit...] button to display the [Software Break] dialog box.

2=

Address |

Address

Addiess  |HDO001044

oK I Cancel Apply

Figure 4.32 [Software Break] Dialog Box

e Use the [Editor] window to refer to the address on the line that has ‘p_sam->s0=a[0];” within the tutorial
function and enter this address in the [Address] edit box. In this example, enter H* 00001 0A4.

Note: This dialog box differs depending on the product. For the items of each product, refer to section 3,
Debugging, or the online help.

e Click the [OK] button. Then click the [Close] button on the [Breakpoint Properties] dialog box.
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The software breakpoint that has been set is displayed in the [Event] window.

i

A=
Type | State I Condition I Action I
Software Enable FC=00001024 (tutorial.cpp/48) Break

MSoftware .'[\ on Chip }\ O Emulator !“

Figure 4.33 [Event] Window (Software Breakpoint Setting)

Note: The items that can be displayed in this window differ depending on the product. For the items that can
be displayed, refer to section 3, Debugging, or the online help.

e Close the [Event] window.

e To stop the tutorial program at the breakpoint, select [Reset Go] from the [Debug] menu.
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The program runs until it stops at the breakpoint that has been set.

24
25
Z6
27
28
29
30
31
32
33
34
35
36
37
38
ElE]
40
41
4z
43
44
45
46
47
45
49
50
51
52
53
54
55
56
57
58
59

[« |

00001035 woid main(woid)
{
0o00103a while (1)
00001042 tutorial () :
}
*
oooo1054 void tutorial (woid)
{
long i:
int i:
class Fample *p_sam:
0000105 b Sam= Sample;
oo001066 Lo i=0; i<10; i++ 14
0000106e 1 = randi):
00001076 if(j < 0]
ooo00107a 3= -3:
i
0000107 afi]l = i:
}
00001090 p_Sam->sort(a):
000010%a p_Sam->change (&) ;
00001 0ad [ -3 p_sam->s0=a[0]:
00001 0&aa p_sam->sl=al[l]:
000010kb0 p_sSam->32=al2]:
000010k A p_sam->=3=al[3]:
000010k p_sam->sd=al4]:
00001002 p_Ssm->35=a[5]
0000105 p_sam->s6=a[6]:
000010ce p_sam->s7=al[7]:
000010d4 p_sSam->38=a[8]
000010da p_sam->s59=a[3]:
0oo010e0 p_Sam;
}
Event < tutarial.cpp
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Figure 4.34 [Editor] Window at Execution Stop (Software Break)
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The [Status] window displays the following contents:

~lal x|
Item Status
Connected To: 3IHY058 E6D0O0H Ewmulator CPU 3H-ZE (EGOO0OH H-UDI USE Driver)
CPU IHT058
Mode &
Clock source SMHz
JTAG Clock 10MH=
Cause of last hreak Zoftware Break
FunTime Count 00hO00min00=s000ms209us660ns

Method of RunTime Count &o to Bresk

4 I }I\ Mernory }\Plalform /{ Events [‘

Figure 4.35 Displayed Contents of the [Status] Window (Software Break)

Note: The items that can be displayed in this window differ depending on the product. For the items that can
be displayed, refer to section 3, Debugging, or the online help.
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4.15.2 On-Chip Break Function

Setting of an on-chip breakpoint on channel 8 such that a break is triggered when the break condition has been

satisfied five times is explained as an example of the use of on-chip breakpoints.

Note: The channels on which the satisfaction count can be specified differ depending on the product. For

details on each product, refer to section 3, Debugging, or the online help.

e Select [Eventpoints] from the [Code] submenu of the [View] menu or click the [Eventpoints] toolbar button

(. The [Event] window is displayed.

e The software breakpoint that has been previously set must be deleted. Click the [Software] sheet of the
[Event] window with the right-hand mouse button and select [Delete All] from the popup menu to delete all

the software breakpoints that have been set.
e Click the [On Chip] tab of the [Event] window.

e Click the [Event] window with the right-hand mouse button and select [Add...] from the popup menu.

e The [Breakpoint Properties] dialog box ([On Chip Break] page) is displayed.

2]

Software Break  On Chip Break I On Emulator Break |

Sequential Break

Mie T 2o 34 B> B 721 &

[Count]
Address Fange Break
(I‘ 310 [~ 1112
Run time count between tgger outputs
’7 I~ Fom7to8 Back

= O T 0 T —

TEZZw

Edi.. |  Fesst | Fesetay |

Close I [Cancel | Spply |

e Select [8] in the list box and click the [Edit...] button. The [On Chip Break Channel 8] dialog box is

displayed.
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Figure 4.36 [Breakpoint Properties] Dialog Box ([On Chip Break] Page)
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e Make the following settings in the group boxes on the [Address] page:
Uncheck the [Don’t Care] checkbox.
Then use the [Editor] window to refer to the address on the line that has ‘a[i]=j;” within the tutorial
function and enter this address in the [Address] edit box. In this example, enter H*0000107C.
e Make the following settings in the boxes on the [Count] page:
Uncheck the [Don’t Care] checkbox.
Enter D’ 5 in the [Count] edit box.

Note: The content of this dialog box differs depending on the product. For details on each product, refer to
section 3, Debugging, or the online help.

2=

Addiess | Data | Busttrea | Count | Action |

- Addre

Address I

r Uze mask I

Ml H er 0 ar B effective,
amazk iz and & tomask i: 0

(n] I Cancel Apply

Figure 4.37 [On Chip Break Channel 8] Dialog Box

e Click the [OK] button. Then click the [Close] button on the [Breakpoint Properties] dialog box.

The on-chip breakpoint that has been set is displayed in the [Event] window.

Note: The items that can be displayed in this window differ depending on the product. For the items that can be
displayed, refer to section 3, Debugging, or the online help.

Close the [Event] window. Then select [Reset Go] from the [Debug] menu to stop the tutorial program at on-chip
breakpoints. The program runs and then stops at the breakpoint that has been set. The cause of a break can be
checked in [Cause of last break] of the [Status] window.

Refer to the [Watch] window for the value of variable i. The value is 4, indicating that the break occurred after
the condition had been satisfied five times.

Then delete the on-chip breakpoint. Clicking the right-hand mouse button on the [Event] window displays a
popup menu. Select [Delete All] from this menu to delete all the on-chip breakpoints.
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4.16 Trace Functions

The trace functions of the emulator use the realtime trace buffer, which can store the information of up to 128-k
bus cycles. The content of this buffer, which is constantly updated during execution, is displayed in the [Trace]

window.

Select [Trace] from the [Code] submenu of the [View] menu or click the [Trace] toolbar button (El) to display
the [Trace] window.

ace

®2| 7| E@E & |0

ol x|

Ccycle | Address | ¢S | coded | codel | Data | R/W | 82 | Bus | Prabes | IMI | TRQ | Timestemp | Timestemp-Difference | Source | Label |

Figure 4.38 [Trace] Window

When trace information is displayed in the [Trace] window, clicking the right-hand mouse button on the [Trace]

window displays a popup menu. Select [Clear] from this menu to clear the trace information.

The following sections give an overview of the trace functions and the settings.
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4.16.1 Displaying Trace Information by the Free Trace Function

The free trace function allows continuous acquisition of trace information from the start of user program
execution to the occurrence of a break.

(1) All break conditions must be deleted. Clicking the right-hand mouse button on the [Trace] window displays
a popup menu. Select [Acquisition...] from this menu to display the [Trace Acquisition Properties] dialog
box. Ensure that [Free Trace] is checked and then click the [Close] button.

2]

Condition I Other |

— Combination
— Seguential Trace Stop

CHHC 2 3T 4 B T B0 7
™ ResetPaint (Delay]
— Run time count between trigger outputs
v Free trace
I Use & Eromd o2 = From 3 to 4 ~ -
£ Fram 5 to B | From 7 to 8 Back

‘

Edi. |  Resst | Fesetar |
Cloze I [Cancel | Apply

Figure 4.39 [Trace Acquisition Properties] Dialog Box (Free Trace)
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(2) Set a software breakpoint at the address on the line that has ‘p_sam->s0=a[0];” within the tutorial
function (refer to section 4.15.1, Software Break Function).
(3) Select [Reset Go] from the [Debug] menu. Execution stops when the break condition is satisfied, and the
[Trace] window then displays the trace information.

=10 x|
|7 E S| |0
Cycle \ Address \ cs | Coded Codel \ Data | R/W | 5z \ Bus | Erohes \ HMI | IRQ | Timestans|
-00010 fiffhfad 00000000 RD L CPO 1111 1 0000ha.
-00009 00002120 MOV R4,R0 MOV.L R1,E@(... 60430516 IF PO 1111 1 0000h0.
-00008 00002124 ADD #H'01,R2 MOV #H'OA,R7 72Z01e?0a IF PO 1111 1 0000h0.
-00007 ffff0424 00000000 WR b} PO 1111 1 0000h0.
-0000& 00002128 CME/GE R7,RZ BF @H'Z1... 32738bec IF cPooo 1111 1 0000h0.
-00005 0000Z212c ADD #H'Zc, RIS MOV. T @riS5+, RO TfIcedfE IF cPooo1111 1 0000h0 .
-00004 00002130 RTS NOP 000bO00S  IF cPooo1111 1 0000h0 .
-00003 ffffhfdn 00000000 RD b} cPooo1111 1 00000 .
-00002 000010a% JDATA.W H'0000 0000EZEZ  IF CPU 1111 1 0000RO.
—-00001 000010a8 2d22dels IF CPU 1111 1 0000RO

1 [

Figure 4.40 [Trace] Window (Free Trace)
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4.16.2 Displaying Trace Information by the Trace Stop Function

While the trace stop function is in use, acquisition of trace information stops when a specified condition is
satisfied. The user can check the program flow by the trace information without breaking the user program

execution.

(1) Delete all the break conditions that have been set. Uncheck [Free Trace] on the [Condition] page of the
[Trace Acquisition Properties] dialog box (otherwise, the free trace mode will be selected).

(2) Select [1] from the list box on the [Condition] page of the [Trace Acquisition Properties] dialog box and then
click [Edit...]. The [Trace Acquisition Condition Channel 1] dialog box is displayed. Select the [Trace Stop]
radio button in the [After Condition Match] group box on the [Action] page.

Intemupt |
Aution | Address |

Count I Delay

2]

| Buzsirea | Frobe

—After Condition M atch
o B

£ Acquisition Condition
" Mone

" Address Bange Trace

Combination with the nest
charnel

Addre

Sitark I

Erd |

— Dutput Trigger
[ Enable output trigger

(n] I Cancel Apply

Figure 4.41 [Trace Acquisition Condition Channel 1] Dialog Box (Trace Stop)
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(3) An address must be set as the condition. Uncheck [Don’t Care] on the [Address] page of the [Trace
Acquisition Condition Channel 1] dialog box. Then use the [Editor] window to refer to the address on the
line that includes ‘a[i]=j;” within the tutorial function and enter this address in the [Start] edit box. In
this example, enter H' 00001 07C. This completes the setting of the address. Click the [OK] button to close

the [Trace Acquisition Condition Channel 1] dialog box.

Condition Channel 1

2]

Intemupt I Count I Delay
Action Address | [ata | Buzsirea | Frobe
— Addre
L :
¢ Addess  { Bange
Stat  [HO000107C [
End |
= Dutside Ranae
ak I Cancel Lpply
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Figure 4.42 [Trace Acquisition Condition Channel 1] Dialog Box ([Address] Page)
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(4) Ttems that have been set are displayed in the list box on the [Condition] page of the [Trace Acquisition
Properties] dialog box. Click the [Close] button on this dialog box.

Condition I Other |

— Combination
— Seguential Trace Stop
NS WY i i mi e Sy i)
™ ResetPaint

2]

[Delay]

— Run time count between trigger outputs
I Use & Eromd o2

£ Fram G ta

= From 3 to 4
B | From 7 to 8

¥ Free trace

E

1
2
3
4
5
g
7
g
9
10
1
12
PtoP
Reset | Fiezet All |
Cloze | Cancel | Apply

Figure 4.43 [Trace Acquisition Properties] Dialog Box (Trace Stop)

(5) Select [Reset Go] from the [Debug] menu. The trace condition is satisfied, and the [Trace] window then
displays the following contents.

«# Generic Trace:

=& B®E|E | w0

=

cyele | Address | ¢S | Code [ code1 Data | B/W | 32 | Bus | Probes | WMI | IRQ | Timesta:s|
-00010 00001074 mov RO, RZ cop/PE ORI £2034211 IF cPU 1111 1 0000RO.
00008 fEEFREAD 00000000 R T cEU 1111 1 0Dookd.
-00006 00001078 BT @H' 107¢:8 8900622 TP ceu 1111 1 0D0ORO.
-000n7 000M107s A42086=3 TF cem 1111 1 00nomd.
-000ns 0001075 MoV, @(H'0080:8,PC), R4 MOV R14,R6  d42066e3 IF cem 1111 1 00nomd.
-000ns 00on10gn Mo RE, RS sHmL RS £5634508 TF cPU 1111 1 00nomd.
-ODOD4 00001100 FEEENAD0 RD L CPU 1111 1 0ooomd.
-0DOD3 00001084 Ho¥ RS, RO MOV RZ,80... 50530426 IF cPU 1111 1 0ooomd.
-00002 00001088 aop #H'01,R14 mov #H'OA,RL TeOlel0a IF cPU 1111 1 0000RO.
00001 £E££0400 00000000 WR L cPU 1111 1 0DOokD.
1

Figure 4.44 [Trace] Window (Trace Stop)
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4.16.3  Displaying Trace Information by the Conditional Trace Function

The conditional trace function only acquires trace information at the address where a specified condition has
been satisfied. This is useful for analyzing a program focused on reading from or writing to a specific address
(e.g. a global variable or memory mapped 1/0).

(1) If the user program is running, select [Halt Program] from the [Debug] menu to halt the program.

(2) Delete all the break conditions that have been set. Uncheck [Free Trace] on the [Condition] page of the
[Trace Acquisition Properties] dialog box (otherwise, the free trace mode will be selected).

(3) Select [1] from the list box on the [Condition] page of the [Trace Acquisition Properties] dialog box and
then click [Edit...]. The [Trace Acquisition Condition Channel 1] dialog box is displayed. Select the
[Acquisition Condition] radio button in the [After Condition Match] group box on the [Action] page.

(4) An address must be set as the condition. Uncheck [Don’t Care] on the [Address] page of the [Trace
Acquisition Condition Channel 1] dialog box. Then use the [Watch] window to refer to the address on the
line that includes ‘a[0]” and enter this address in the [Start] edit box. In this example, enter H' FFFF0400.
This completes the setting of an address. Click the [OK] button to close the [Trace Acquisition Condition
Channel 1] dialog box.

(5) Items that have been set are displayed in the list box on the [Condition] page of the [Trace Acquisition
Properties] dialog box. Click the [Close] button on this dialog box.

(6) Set a software breakpoint at the address on the line that has ‘delete p_sam;’ within the tutorial function
(H'000010EO. in this example) (for details, refer to section 4.15.1, Software Break Function).

(7) Select [Reset Go] from the [Debug] menu. Execution stops when the break condition is satisfied, and the
[Trace] window then displays the following contents.

# Generic Trace =10l x|
=& EDE|E w0

Cyele | Address | % | coded Codel Data | R/W | 52 | Bus | Probes | NMI | IRQ | Timestea]
-00010 —------- 1111 1 D0OORD
-00008 ££E££0400 00000000 R L €BU 1111 1 0000KD
-00008 —=-mm-mm 1111 1 ODOOKO
-00007 £EEE0400 00000000 RD L ePU 1111 1 ODOOKD
-00006 —=-mmm-mm 1111 1 ODOOKD
-00005 £E£0400 00D000O0 RD L €PU 1111 1 D0OORD
-00004 —------- 1111 1 D00ORD
-00003 -------- 1111 1 0000KD
-00002 ££E£0400 00005665 WR L cRU 1111 1 0000KD
-00001 £EEE0400 00ODSEES RD L CPU 1111 1 ODOORO

T

Figure 4.45 [Trace] Window (Conditional Trace)
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4.16.4  Statistics

The number of times the on-chip RAM has been written to can be included in the acquired trace information.

1)

(@]

3)

“)

Delete all the break conditions that have been set. Click [Reset All] on the [Condition] page of the [Trace
Acquisition Properties] dialog box to cancel trace conditions. Check [Free Trace] on the [Condition] page
of the [Trace Acquisition Properties] dialog box.

Make the setting so that a break occurs at the address on the line that has ‘p_sam->s0=a[0];” within the
tutorial function (H” 00001044 in this example) (for details on, refer to section 4.15.1, Software
Break Function).

Select [Reset Go] from the [Debug] menu. Execution stops when the break condition is satisfied, and the
[Trace] window then displays the trace information.

Select [Statistic...] from the popup menu that is displayed when you click the right-hand mouse button on
the [Trace] window. A message box appears, indicating that the trace data is being loaded, and the
[Statistic] dialog box will be displayed.

2]

— Statiztic Analysi

 Range

Set
Item |<None> =l
Start : I

Hesult |
End :I

Clear |
Result :
Condition | Arnount | FTR

KN I

Cloze

.

Figure 4.46 [Statistic] Dialog Box
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(5) Select [R/W] in the [Item] combo box and enter WR in the [Start] edit box. Then, click the [New] button.
“R/W=WR” will be displayed in the [Condition] column of the [Result] list box.

21l
— Statiztic Analysi
' Default ©© Fange et
ltem IHM j
Start : IWH
Hesult |
End :I
Clear |
Result :
Condition | Arnount | FTR
KN o
Cloze |

Figure 4.47 [Statistic] Dialog Box (New Condition)
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(6) Then, select [SZ] from the [Item] combo box and enter L in the [Start] edit box. Then, click the [Add]
button; the new condition is now added to the “R/W=WR" display in the [Condition] column of the [Result]
list box, so that it now shows “R/W=WR & SZz=L". This completes the setting of the conditions.

' Default ©© Fange

ltem - I 57 j

MHew
Start : IL

Result |
End I

Clear |
Result :
Condition | Amnount | FTR
R And=wdF & S2=L

| | 2
Cloze |

Figure 4.48 [Statistic] Dialog Box (Condition Added)
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(7) To start statistical analysis of the specified condition, press the [Result] button. The number of write
operations that satisfies the conditions and the PTR values will be displayed.

KN I

— Statiztic Analysi
' Default ©© Fange et
ltem - ISZ j
Mew
Start : IL
End I Z
Clear |
Result :
Condition | Amnount | FTR
R And=wdF & S2=L 401 02671 ,-02670.-0266!

o
Cloze |

Figure 4.49 [Statistic] Dialog Box (Result of Analysis)

(8) Click the [Close] button to close the [Statistic] dialog box.

(9) Delete the event points that have been set and clear the trace information. Clicking the right-hand mouse
button on the [Event] window displays a popup menu. Select [Delete All] from this menu to delete all the
event points that have been set. Clicking the right-hand mouse button on the [Trace] window displays a
further popup menu. Select [Clear] from this menu to clear the trace information.
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4.16.5

Function Calls

This mechanism is only used to collect trace information on the function calls.

(1) Make the setting so that a break occurs at the address on the line that has ‘p_sam->s0=a[0];” within the

tutorial function (H”000010A4 in this example) (for details, refer to section 4.15.1, Software Break

Function).

(2) Select [Reset Go] from the [Debug] menu. Execution stops when the break condition is satisfied, and the
[Trace] window then displays the trace information.

(3) Select [Function Call...] from the popup menu displayed by clicking the right-hand mouse button on the
[Trace] window. The [Function Call Display] dialog box will be displayed.

Jd

Seatting
Enable to dizplay trace infarmation with function
call only ?
(O : " Dizable
ok LCancel

(4) Click the [Enable] radio button and then the [OK] button. Only the information on function calls is now

Figure 4.50 [Function Call Display] Dialog Box

displayed in the [Trace] window.

&2 | 7| B &= F |0

Cyole | Address | CS | Data

[ r/w ] 52 | Bus | Probes | w1 [ TRg | source

Label

-0Z879
-01475
-01470
-01462
-01389
-00974

00000a00
00001038
00001054
0000zoo0
00001000
00002032

dZ0cef10
4f22e101
2fdeZfel
4f222448
Tifedslb
0009Zfce

IF CPU 1111 set_vbr ((void *j [ (char *]...
IF CPU 1111 1 void main(veid)
IF CPU 1111 1 vaoid tutorial(void)
IF CPU 1111 1 Seuple: : Sample ()
IF CPU 1111 1 char *shrkiunsigned long size...
IF cPU 1111 1 d s izork (L *a)

1

_PowerON_Reset_BC
_main

tutorial ()
Sample::Semple ()
_shrk

Figure 4.51 [Trace] Window (Function Calls)

(5) To return the display in the [Trace] window to its previous state, follow the procedure in (3) to display the
[Function Call Display] dialog box. Click the [Disable] button and then the [OK] button.

(6) Delete the event points that have been set and clear the trace information. Clicking the right-hand mouse

button on the [Event] window displays a popup menu. Select [Delete All] from this menu to delete all the

event points that have been set. Clicking the right-hand mouse button on the [Trace] window displays a

further popup menu. Select [Clear] from this menu to clear the trace information.
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4.17 Stack Trace Function

The emulator uses the information on the stack to display the function call history.

Notes: 1. This function can be used only when the load module that has the Dwarf2-type debugging
information is loaded. Such load modules are supported in H8S, H8/300 C/C++ compiler V4.0 or

later.

2. For details on the stack trace function, refer to the online help.

e Double-click the [S/W Breakpoints] column in the sort function and set a software breakpoint.

11 oooozooo
1z ooooz0o0z
13 0oDooOz014
14 0oooz01s
15 0o0o0z01a
16 ooooz01e
17 00oo0zZ01e
15 ooooz0z0
19 ooooz0zz2
20 00002024
21 O0D0Z0z6
a2 ooooz0zs
23
24
25 ooooz032
26
27
28
29
30 0000E03a
31 ooooz03e
32 oooozogo
33 0oo0z046
34 ooooz0s52
35 oooozosa
36 0ooo0z074
37 ooooz0ve
38 oooozo26
ElE
40
41
42
43
44
45 0000Z0ka6
46
47

[« |

Sample: :Sample |

{
=0=0;:
=21=0;
s2=0;
z3=0:
=4=0;
s5=0;
s6=0;
27=0;
s8=0:
z5=0;

wvoild Sawmple::isort(long *a)
{

long t;

int i, 3, k, gap:

gap = 5;
while{ gap > 0O 1§
for | k=0; k<gap; k++){
for{ i=k+gap: i<10:; i=i+gap |1
for (j=i-gap: jr=k; j=j-gap){
if(alilzali+gap] )i
t = alil:
alil = ali+gapl:
alj+gap] = t;
¥
else
break;

gap = gap/Z:

zort.cpp I

Figure 4.52 [Editor] Window (Software Breakpoint Setting)
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e Select [Reset Go] from the [Debug] menu.

e After the break in program execution, select [Stack Trace] from the [Code] submenu of the [View] menu to

open the [Stack Trace] window.

=3
Kind| Harme | Value |
F Sample: :sort (long *) { 00002054 }
F tutorialf) { 00001094 }
F maini) { DODO1046 }
F PowerON_Reset PC() { 000ODDAZZ )
F PowerON_Reset PC() { 000O0DDAZZ
F PowerON_Reset PC() { 000O0DDAZZ )
F PowerON_Reset_PC() { 000O0DDAZZ )
F PowerON_Reset PC() { O000DAZZ 3
F PowerON_Reset PC() { 00000AZZ 3

Figure 4.53 [Stack Trace] Window

Figure 4.53 shows that the position of the program counter is currently at the selected line of the sort ()
function, and that the sort () function is called from the tutorial () function.

To delete the software breakpoint, double-click the [S/W Breakpoints] column in the sort function again.
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4.18 Performance Analysis Function
Performance analysis by the emulator is available in the following modes:

e Time Of Specified Range Measurement

e  Start Point To End Point Measurement

e  Start Range To End Range Measurement

e Access Count Of Specified Range Measurement

e  Called Count Of Specified Range Measurement

In this tutorial, we describe the Time Of Specified Range Measurement.

4.18.1 Time Of Specified Range Measurement

(1) Select [Performance Analysis] from the [Performance] submenu of the [View] menu to display the [Select
Performance Analysis Type] dialog box.

Performance Analysiz: EE000H Perfarmance dnalysis j

Cancel |

Figure 4.54 [Select Performance Analysis Type] Dialog Box

(2) Select “E6000H Performance Analysis” from the [Performance Analysis] combo box in the [Select
Performance Analysis Type] dialog box and click the [OK] button. The [Performance Analysis] window
will be displayed.

_lol x|
o | =
Ho Name | Condition Rate RUN-TIME MAX-MIN-TIME Count 0---10---20---30-—-4C
1
2
3
4
5
3
-
H
4] | |
Figure 4.55 [Performance Analysis] Window
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(3) Select the line in the [Performance Analysis] window that has 1 in its [No] column and click the right-hand
mouse button to display a popup menu. Select [Set...] from this popup menu to display the [Performance
Analysis Properties] dialog box.

Perfarmance An = ilil

Meazurement Method PAT:

Tirne Of

Range Name : |F'A‘I
Range

Start Address IH'DDDDUUUD J
End Address : |H'DDDDDDDD

— Comman Settings of Performance(PA1-8)
Addrezs Control Mode: PC

Time Measurement Unit: 20ns

Cancel |

Figure 4.56 [Performance Analysis Properties] Dialog Box

(4)Select Time Of Specified Range Measurement from the [Measurement Method PA1] combo box.
(5) The parameter settings are as follows.

. Enter sort in the [Range Name] edit box.

. Click the [...] button on the right of the [Start Address] edit box to display the [Input Function Range]
dialog box. Enter the function name sort in the [Function] edit box in this dialog box and then click
the [OK] button. The addresses for the function Sample: : sort (long*) will now be set in the
[Start Address] and [End Address] edit boxes.

d b

Eunction
IS ample::sortlong®) Cancel |

Figure 4.57 [Input Function Range] Dialog Box
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Note: The addresses figured out in the [Input Function Range] dialog box are just for reference. In some cases,
the end address of a function may be incorrect. Check the last instruction of the function in the
[Disassembly] window to correct the value set in [End Address] so that it will be the address of the last
instruction (in general, the last instruction of a function is a RTS instruction). A label name or an
expression can be entered instead of an address value in boxes where an address should be entered.

(6) Click the [OK] button to display the contents that has been set for line 1 of the [No] column in the
[Performance Analysis] window. This completes the settings for measuring the time within the specified

range.
I —— =loix]
e 1S
Mo Bame | Condition | Rate [RUN-TIME =~~~ | MAX-MIN-TIHE | Count | O===10=--20--=30---4
1 Pal Range X'00002032 ¥'000020cC O% 00k N0min O0a O00ma 000ua O00na o
2
k}
4
s
[
7
8
| | |

Figure 4.58 [Performance Analysis] Dialog Box (Setting Completed)

(7) Set a software breakpoint at the address on the line that has ‘p_sam->change(a);” within the tutorial
function (H” 00001094 in this example). Refer to section 4.15.1, Software Break Function.

(8) Select [Reset Go] from the [Debug] menu. Execution stops when the break condition is satisfied, and the
[Performance Analysis] window then displays the information shown below. The value shown in the [Count]
column is 1, which indicates that the sort function has been executed once, and the execution time is also
displayed. In this tutorial, the minimum unit for time measurement is defined as 20 ns. This value can be
changed in the [Configuration Properties] dialog box.

T ~Imi x|
R I 1

Mo Vemn |[Condeion | eve|RUN-EINE [ MAKSWOGTIME [[Count | OSsS10TS-20-ci30---40-50

1 pal Range 100002032 ¥'000020cc  32% OOh OOmin 0O0s OOOws OGOus 560ns L HEgERggs

z
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Figure 4.59 [Performance Analysis] Dialog Box (Displaying the Result)

(9) Delete the settings for performance analysis and delete the event points. Click the right-hand mouse button
on the [Performance Analysis] window to display a popup menu. Select [Reset All] from this popup menu to
clear all of the settings. Clicking the right-hand mouse button on the [Event] window also displays a popup
menu. Select [Delete All] from this popup menu to delete all the event points that have been set.
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4.19 Profiling Function
The profiling function allows the user measure the performance for each of the functions.

(1) Select [Profile] from the [View] menu to open the [Profile] window.

i ] 5|
E == | 4 IShow Functions ariables R | e
Function/Variashle | FfVl Address I Size Times | Cyclesl
A kI List A Tree
Figure 4.60 [Profile] Window ([List] Sheet)
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(2) To enable the profiling function, click the right-hand mouse button on the [Profile] window to show the
popup menu and select [Enable Profiler].

=alx]

E == | i IShow Functions "V ariables | = | 7
Function/Variahle | F/Vl 2ddress I Size Tites | Cyclesl
Wiew Source:

Siew Profile-Chart

Enable Prafiler

Mot trace the Function call
Setting

Properties

Eind...
Clear Data

Cutput Profile Information Files. ..

Qutput Texk File,. .

,T Toolbar display
Custamize toolbar. ..

Allows Docking

AN Kl List 4 Tree Hide
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Figure 4.61 Selecting [Enable Profiler]
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(3) Set an on-chip breakpoint by an address condition at the line which includes “delete p_sam;” in the

tutorial function (see section 4.15.2, On-Chip Break Function).

24
25
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27
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33
ek
35
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37
38
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41
42
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44
45
46
47
45
49
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51
52
53
54
55
56
57
58
58

KIE|

oooo1038 woid mwain(woid)
{
0000103 = while (1]{
oooo0104z cutorisli() ;
H
}
gooo1054 vold tutorial (void)
{
lang 3:
int i
class Sample *p_sam;
gooo0105c p_=Sam= Sample;
00001066 for( i=0; i<10; i++ |4
0000106e j = randi):
oo0o01a7e if(3 € 0y ¢
0000107a j = -3:
H
oooo1a7e a[i] = 3:
¥
00001090 p_Sam->S0rt (&) ;
0000109a p_sam->change (a) »
000010=4 p_sam->30=a[0];
000010&aa p_sam-»>31=a[1];
000010k0 p_sam->si=al[Z];
000010kb6 p_sam->s3=al[3];
000010k p_Sam-»34=a[4];
000010c2 p_sam->s5=a[5];
000010cs p_sam->s6=al[6];
000010ce p_sam->s37=a[7];
00001044 p_sam->s3=a[8]:
000010da p_sam->s9=a[3];
000010e0 |4 p_sam:
¥
Profile |

< hutorial.cpp kﬁﬁ

Figure 4.62 [Editor] Window (Setting an On-Chip Breakpoint)

(4) To use the profiling function for measurement, select [Reset Go] from the [Debug] menu.

RENESAS

129




(5) The [Profile] window is shown below.

i x|

& -= ||E[§|Show Functions" anables j EJ‘-} | &F

Function/Varisble I F/Vl Address | Size Times I Cyclesl
_PowerON _Reset PC F 0o0o00a00  H'OOOOO0ZE 1 208
Sample: :change (long *) F 0000Z0OCE  H'OO0OOOEA 1 150
Sample: :sort{long *) F 0ooo0zZo3z  H'OOODOOO9: 1 401
Sample: :Sample () F 0o0oozooo  H'O0OOOO3Z 1 145
_rand F Qooolzzes  E'OOQOOOZC 10 273
operator new(unsigned long) F oooollicg  H'OOOOOCOED 1 g
_ CATL_INIT F 0ooo1i7e H'OOOOOOZE 1 77

_ INITSCT F 0ooo11io ®H'O0OOOO0O0O 1 293
tutorial (} F 00001054 H'OOOOOOQAOD 1 1205
_main F 0oooio3s  ®'O0OOOO1c 1 52

AN Kl List 4 Tree

Figure 4.63 [Profile] Window ([List] Sheet)

(6) Click the [Tree] tab on the [Profile] window to display the [Tree] sheet.

il
E. == ||E|"ea!|8how Functions" ariables j }aﬁ | &7

Function Address Stack Iize

_PowerON_Reset PC 00000AOD H'ODOOOOZE  H'O0DODOOO 1

- INITSCT 00001110 H'ODOOOQODOO  H'OODOOOOO 1 293

-+ CALL_INIT 00001178 H'OD0O000Z8  H'OODOOOOO 1 T

_main 00001038 H'OD0OOOO1c H'OODOOOOO 1 52

=t tutorial() 00001054 H'O0O00ODAD  H'OOOOOOOO 1 1205
~Gample: :Sample () 0ooo0z000 H'ODOOOO32  H'OODODOOOO 1 145
~Zample: rchange (long *) 0000Z0CE H'OOOODOO6A H'OOOODOOO 1 150
~Zample: rsort{long *) 00002032 H'ODOOOOSC  H'OODODOOO 1 401
_rand 00001228 H'ODOOOQOZC  H'OODODOOOO 10 a73

A [ List A Tree

Figure 4.64 [Profile] Window ([Tree] Sheet)
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(7) Click the right-hand mouse button on the [Profile] window and select [View Profile-Chart] to open the
[Profile-Chart] window.

E ¢ ||z g

N
: change (long
tutorial ()
rtilong *
tSample ()
-

Figure 4.65 [Profile-Chart] Window

(8) To disable the profiling function, uncheck [Enable Profiler] in the popup menu opened by clicking the right-
hand mouse button on the [Profile] window. Delete all the break conditions that have been set.
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4.20 Monitor Function

The emulator allows monitoring of the contents of specified addresses in memory during execution of the user
program. In this example, we monitor the content of the address range where variable a of the tutorial
function is stored.

(1) Select the [CPU] submenu from the [View] menu. Selecting [Monitor Setting...] from the [Monitor]
submenu displays the [Monitor Setting] dialog box.

fonitar Setting I

Name : |m0nit0r1

— Optiotis
Address

Size (byte) - [Hronz0 4|
[

Aocess [Fomat] : |BYTE [ASCI)

[V &uto-Refrash at rate [ms) ; ID'DDEDD

v Beading the: Initial alue

~ Calar
LChange Indicatar : IChange =l
Foreground : _I'l Backaround I:II'I
v Mayfly
~ Deta
IDETAILNDT SUPPORTED! Detail... |
—Hiztary

| =
QK I Cancel |

Figure 4.66 [Monitor Setting] Dialog Box
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(2) Set the items in the [Monitor Setting] dialog box as follows:

Note:

Enter moni tor1 in the [Name] edit box.

Set the parameters in the [Options] group box as follows:

(2)

(b)
(c)
d
(e)

Set the parameters in the [Color] group box as follows:

(a) Select Change from the [Change Indicator] combo box.

(b) Select red and white in the [Foreground] and [Background] combo boxes, respectively.

(c) Check the [Mayfly] check box.

Use the [Watch] window to refer to the address on the line where variable a, which is defined within
the tutorial function, is allocated and enter this address in the [Address] edit box. In this example,
H’/FFFF0400 is entered.

Enter H” 20 in the [Size (byte)] combo box.

Select BYTE (ASCII) from the [Access (Format)] combo box.
Check the [Auto-Refresh at rate (ms)] check box and enter D 00500 in the edit box.
Check the [Reading the Initial Value] check box.

Depending on the operating system in use, the foreground and background colors may not be selectable.

Monitor Setting I

2=

Mame : |monitor1

— Dptionz
Address - [HFFFFO400 |
Size (bpte] : [Honz0 =l
Access [Format] - IBYTE [ASCI) j

v &uto-Refresh at rate [ms)] : ID'DDEDD

¥ Beading the Iritial alue

— Caolar
Change ndicator : Ichange ﬂ

Foreground : _I"l Background I:IIYI

¥ Mayfly

— Detail
|DETNL NOT SUFPORTED! Detail... |
—History

[HFFFFO400 H'20byte BYTE (45C11]Change Maytly = |

QK I Cancel |

Figure 4.67 [Monitor Setting] Dialog Box (Setting Completed)
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(3) Click the [OK] button to open the [Monitor] window.

or1 - FFFF0400 1ol x|
® 2 [[ie =] |[ese ez =l
nddress| +0) +1) 2| +3] +a| +5| +a| +7] +0] o] waf t8] +c| [ m] +F] Value [

FFFFO400 0O OO 56 65 OO0 OO 53 DpC OO OO 4p 1D OO OO 42 1F ..Ve..3...M...B.
FFFFO410 00 00 3E Ap 00 OO0 2ZF Sa& 00 00 27 04 00 00 20 D& ..>.../2..'.....

Figure 4.68 [Monitor] Window

(4) Select [Reset Go] from the [Debug] menu. When the contents of the address range changes by execution,
the updated values are in red (i.e. the color that was selected in the [Foreground] and [Background] combo
boxes). Values will be displayed in black if they have not been updated or a certain period of time has
elapsed since the last update.

monikorl - FEFF (=] B
® 2 |[ie =]|[Bpeascn =]
OD5E2ws | +0| +1 | +2 +3 | +4| +5| +6| +7| +8| 49| +a| 45| +c| +n| 45| 7| Value [
FFFFO400 00 00 15 B4 00 00 OC D3 OO0 00 1E 4D 00 00 33 AR ........... m..3

FFFFO410 00 00 4 &2 00 00 46 S 00 OO0 61 31 00 00 49 E5 ..J7...F...al..I.

Figure 4.69 [Monitor] Window (during Execution)

(5) After you have finished checking the states in the [Monitor] window, select [Halt Program] from the
[Debug] menu to halt the program’s execution.

4.21 What Next?

In this tutorial, some of the main features of the emulator and the High-performance Embedded Workshop
operation have been given. By using the emulation functions provided by the emulator, a high-level debugging is
possible. The conditions caused by hardware and software can be accurately classified and the users can
investigate the problems effectively.
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Section 5 Software Specifications and Notes Specific to This Product
This section describes the software specifications and notes specific to the EGOO0H emulator.

51 Supported Hardware

This emulator software is specialized for the SH7058 E6000H (HS7058EPH60H) and SH7059 E6000H
(HS7059EPH60H) emulators.

5.2  Debugging Platform

The following debugging platform can be selected in this emulator. The target MCU to be emulated depend on
the selected debugging platform.

Table 5.1  Selectable Debugging Platform

Debugging Platform Description Hardware
SH7058 E6000H Emulator CPU The SH7058 microcomputer can be emulated. HS7058EPH60H
SH-2E

SH7058S E6000H Emulator CPU  The SH7058S microcomputer can be emulated. HS7059EPH60H
SH-2E

SH7059 E6000H Emulator CPU The SH7059 microcomputer can be emulated. HS7059EPH60H
SH-2E

5.3  Displaying and Modifying the Contents of Memory

The emulator accesses memory in the following two ways to display and modify the contents of memory during
user program execution.

Table 5.2  Access Types for Displaying and Modifying Contents of Memory

Period

Access Type Description Suspended  Display Modification
Monitor function Automatically updates the display of the None Enabled Disabled

memory contents without stopping the user

program execution.

If the specified range is not accessed, the

contents of memory will not be updated.
Parallel access For on-chip ROM and on-chip RAM areas, Short Enabled Enabled

function memory content displays are automatically
updated without a halt during user program
execution. When updating, a forced memory
access occurs and realtime emulation will
not be performed.
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These access types have the following characteristics.

Table 5.3  Characteristics of Displaying and Modifying Contents of Memory

Access Type Target Window/Operation Target Memory Area

Monitor function Realtime update of display in the [Monitor] Specified eight points or up to 256 bytes of
window and in the [Watch] window when the  the areas that the user program is allowed to

monitor function is used access
Parallel access Windows that display the memory contents All areas that the user program is allowed to
function other than the [Monitor] window. access

Tooltip watch and instant watch.
Command to display or modify the contents
of memory.

Notes: 1. Memory contents cannot be displayed or modified by a parallel access in the sleep and standby
modes.

2. When [Enable select AUD to Emulator (Enable read and write on the fly)] in the [Configuration
Properties] dialog box is unchecked, reading memory by a parallel access during user program
execution can be disabled. Uncheck [Enable select AUD to Emulator (Enable read and write on the
fly)] for realtime user program execution.

5.3.1 Reference Values for Parallel Access Function Termination Period

Values for reference when the user program is terminated for displaying and modifying the memory contents
during user program execution is given below.

Table 5.4 Reference Values of Termination Period

Access Method Condition Termination Period
Parallel access Read: Longword-access read from 320 ns

on-chip RAM.

Write: Longword-access writeto 320 ns

on-chip RAM.
"Auto update Memory” User program execution is not terminated.

Table 5.5 Measurement Environment

Item Set Value
System clock (¢) 10.0 MHz
Clock mode Clock mode 3
H-UDI clock 5.0 MHz
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5.3.2 Monitor Function

e Up to eight points or 256 bytes in total can be specified for the monitor function.

e The monitor function is implemented by eight 32-byte hardware channels. The address range specified for
one channel must be aligned to a 32-byte boundary; two channels should be used to specify a range across a
32-byte boundary. Accordingly, when multiple ranges are specified across 32-byte boundaries, the total
specifiable size is less than 256 bytes.

e When monitor function conditions are set or modified during user program execution, the program is not
executed in realtime.

e When [Access Size and Display Format] are modified during user program execution, the program is not
executed in realtime.

533 Note on Accessing Memory

In the single-chip mode, do not access (i.e. display or modify memory contents) the external memory space of
H’00200000 to H’7FFFFFFF in the [Memory] window. If this is done, an address error will occur.

5.4  Executing Your Program

54.1 Step Execution

Break conditions are ignored during step execution, but trigger pulses will be output.

54.2 Break Suspension

The break processing may be suspended for some instructions which are being executed when the break
condition is satisfied. The suspended break will be generated when the emulator enters the state that can accept a
break. The instructions for which a break is suspended is listed in the table below.

Table 5.6 Instructions for which a Break is Suspended

Instruction Description
Delayed branch instruction JMP, JSR, BRA, BSR, RTS, RTE, BF/S, BT/S, BSRF, BRAF
FPU instruction Floating-point instructions of the FPU instruction, and CPU

instructions concerning the FPU

Note: Software breaks are not suspended since they are realized by replacing the instructions.

The emulator internally sets break conditions to realize step execution functions. Accordingly, when the above
instructions are executed in steps, the program execution may continue until the emulator enters the state that can
accept breaks.
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5.5 Event Functions

5.5.1 Software Breakpoints

A software breakpoint is realized by replacing the instruction at the specified address with a special
instruction. Accordingly, it can only be set to the area including the emulation RAM. Note that it cannot be
set to the following addresses:

— Addresses whose memory content is H'0000

Do not modify the contents of the software breakpoints addresses by the user program.

The content of a software breakpoint address is replaced by a break instruction during user program
execution.

The maximum number of software breakpoints and temporary PC breakpoints in [Temporary PC
Breakpoints] of the [Run Program] dialog box is 255 in total. Therefore, when 255 software breakpoints
have been set, no temporary breakpoint set in [Temporary PC Breakpoints] of the [Run Program] dialog box
is valid. Ensure that the total number of software breakpoints and temporary PC breakpoints are 255 or less.
Do not set a breakpoint immediately after a delayed branch instruction (at a slot instruction). If this is
attempted, a slot illegal instruction interrupt will occur when the delayed branch instruction is executed, and
the break will not occur.

5.5.2 On-Chip Break

The satisfaction count can only be set for channel 8.

The address and data conditions are satisfied on the bus cycles where the values on the address bus or data

bus match. Consider the following points when setting these conditions.

— Longword access
Longword data is read and written in a single bus cycle. A data condition is only valid for a longword
access when specified as longword. The specified address must be a multiple of four. Note that longword
data is only valid as the size of an access.

— Word access
Word data is read and written in a single bus cycle. The specified address must be a multiple of two.
Word data is only valid as the size of an access.

— Byte access
Byte data is read and written in a single bus cycle. A data condition is only valid for a byte access when
specified as byte. Any address condition, both an even and odd address, are valid.
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553 On-Emulator Break

e A break will occur several cycles after a condition is satisfied.
e The address and data conditions are satisfied on the bus cycles where the values on the address bus or data
bus match. Consider the following points when setting these conditions.
— Longword access
Longword data is read and written in a single bus cycle. A data condition is only valid for a longword
access when specified as longword. The specified address must be a multiple of four.
— Word access
Word data is read and written in a single bus cycle. Word data is only valid as the size of an access. The
specified address must be a multiple of two.
— Byte access
Byte data is read and written in a single bus cycle. A data condition is only valid for a byte access when
specified as byte. Any address condition, both an even and odd address, are valid.

Use the mask function so that no invalid data of a 32-bit data bus will be applied as a condition to search data.
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5.6 Trace Functions

5.6.1 Displaying the Trace Information

e The same hardware resource is used for acquisition of time stamps and the IRQ signals in the trace function.
Accordingly, the trace contents differ depending on the [Selection of the trace contents] setting in the [Trace
Acquisition Properties] dialog box.

Table 5.7 Trace Contents

Setting Description

When [Timestamp] is selected Acquires and displays timestamp in 32 bits. The IRQ signals
are not acquired.

When [IRQ7-0 all indications] is Acquires and displays the IRQ signals. The time stamp is

selected displayed with the lower 16 bits fixed to 0.

e When the user clock (internal clock signal ¢) has been selected for [Time measurement unit] in the [Trace
acquisition] dialog box, the time stamp is displayed for 32 bits in hexadecimal.

5.6.2 Specifying Trace Acquisition Conditions

e The trace will stop several cycles after a condition is satisfied.

e Six or more bus cycles are required between pass points of sequential trace stop conditions and reset
condition.

e Six or more bus cycles are required between the start and end of measurement when [1-2], [3-4], or [5-6] is
specified in [Run time count between trigger outputs] of the [Trace Acquisition Properties] dialog box.

o Fifteen or more bus cycles are required between the start and end of measurement when [7-8] is specified in
[Run time count between trigger outputs] of the [Trace Acquisition Properties] dialog box.

e Six or more bus cycles are required from the start of execution to satisfaction of a trace stop mode condition.

e A sequential break or a trace stop may be incorrect when the user program is executed after the specified
address condition has been applied as the PC address to start execution.

e The Point to Point trace mode is not available when channel 1 is used for the performance analysis function.

5.6.3  Searching for a Trace Record

e When the range for searching is specified in the [General] page, a PTR value to end the search can be
specified in the [Start PTR] option, and a PTR value to start the search can be specified in the [End PTR].

e When the user clock (i.e. internal clock signal ¢) has been selected in [Time measurement unit] of the [Trace
Acquisition Properties] dialog box, no time stamp information will be searched.

5.6.4 Filtering Trace Records

e After the trace information is filtered, all trace information displayed in the [Trace] window is saved; a range
for saving trace information cannot be specified. To save a specific range of trace information, the filter
range must be specified in the [General] page of the [Trace Filter] dialog box.

e When the user clock (i.e. internal clock signal ¢) has been selected in [Time measurement unit] of the [Trace
Acquisition Properties] dialog box, no time stamp information will be filtered.

5.7  Monitor Function
The foreground and background colors cannot be changed in some operating systems.
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5.8  Performance Analysis Function

5.8.1 Errors
An error will be included in the measured performance as follows:

e tone-resolution error (£20-ns error when the measurement resolution is 20 ns)
This error may occur when the user program execution starts or stops (breaks) or when the measurement start
or end condition is satisfied.

e Frequency stability of the crystal oscillating module for performance analysis: £0.01%

5.8.2 Notes

e In all measurement modes, the interval between the end condition satisfaction and the next start condition
satisfaction must be longer than one-measurement-resolution time. If the interval is shorter than that, the
interval itself is included in the measured time.

e In [Time Of Specified Range Measurement], measurement stops when an instruction is fetched outside the
specified range. In [Start Point To End Point Measurement] and [Start Range To End Range Measurement],
measurement stops when the specified end condition is satisfied. When the same addresses are specified for
these modes, the time measured in [Time Of Specified Range Measurement] is longer than that measured in
[Start Point To End Point Measurement] or [Start Range To End Range Measurement].

e Execution time is measured by using address bus values in prefetch cycles. If the end address condition is
specified at an address near the instruction following a branch instruction or delayed slot instruction, correct
time cannot be measured. Check the bus trace display for the operation after the branch instruction prefetch
cycle, and specify the end address condition at the address in a prefetch cycle which will not be executed by
the branching.

e Channel 1 is not available for performance analysis when the Point to Point trace mode is selected.

e The resolution for the performance analysis function can be set in [Timer Resolution] of the [Configuration
Properties] dialog box. If the clock counter value is set as the resolution, the value shown in [RUN-TIME]
and [MAX-MIN-TIME] will be that of the clock counter (displayed in hexadecimal).

e The counter for measurement has 24 bits, and the maximum measurement time is as given below depending
on the value set in [Timer Resolution].

Table 5.8 Maximum Measurement Time

Value of [Timer Resolution] Maximum Measurement Time
52 us Approximately 14 minutes

1.6 us Approximately 26 seconds

20 ns Approximately 0.33 second

e The maximum measurement count for Access Count of Specified Range Measurement and Called Count of
Specified Range Measurement is 65,535.
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5.9  Profiling Function

o If there is no stack information file (extension is ‘.sni’) that is output from the optimizing linkage editor, only
the functions that have been executed during the profiling data measurement are displayed. For details of the
stack information file, refer to the manual of the optimizing linkage editor.

o The stack size differs from the actual value. It should be used as a reference value during a function call. If
there is no stack information file (extension is ‘.sni’) that is output from the optimizing linkage editor, the
stack size is not displayed.

e While the profiling function is used, software break and on-emulator break, which are event functions, are
not available.

e While the profiling function is used, the parallel access function during user program execution is not
available.

e Since the profiling function internally breaks user program execution, the program is not executed in realtime.
The measured value includes an error.

e The profiling function internally uses the on-chip break channels 9 to 12. Therefore, break channels 9 to 12
cannot be used when the profiling function is used.

e [Cycle] displays a decimal value of the counter for measurement of execution time. The resolution for the
counter for measurement of execution time can be set in [Timer Resolution] of the [Configuration Properties]
dialog box. The expression for the execution time of each function is as follows:

Execution time = Value of the [Cycle] item x Value of [Time Resolution]

e To enable the profiling function, [Enable select AUD to Emulator (Enable read and write on the fly)] must be

unchecked in the [Configuration Properties] dialog box.
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5.10 Input Format

5.10.1 Entering Masks

Address bus conditions and data bus conditions can be input with masks. Addresses can be masked in 1-, 3-, or
4-bit units. When a bit is masked, it always satisfies the condition.

To specify a mask for an address bus condition, specify the mask value in the [Mask] area.
The mask for data conditions is similarly specified in the [Mask] area.

To specify any further mask, specify 1 for the digits to be ignored. Examples of mask specification are listed
below.

Table 5.9 Address Mask Specification

Input Value Mask Unit Example Masked Bits
Binary 1 bit B’00000111 Masks bits 0 to 2
Octal 3 bits 0’000017 Masks bits 0 to 3
Hexadecimal 4 bits H'07FF Masks bits 0 to 10

5.11 Downloading a Program

Before downloading a program to the on-chip flash memory, the input frequency and the method for loading to
the on-chip flash memory must be set in the [Configuration Properties] dialog box. For details on the
[Configuration Properties] dialog box, refer to section 3.1, Setting the Environment for Emulation.
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5.12  Tutorial Program

5.12.1 Downloading the Tutorial Program

The setting of the emulation RAM is applied in the area in which downloading of the tutorial program is
necessary for the workspace of the tutorial program attached to this product. When the tutorial program is
downloaded according to the procedure of section 4, Tutorial, the tutorial program is downloaded in the
emulation RAM, not in the on-chip flash memory. To download the tutorial program to the on-chip flash
memory, the setting of the input frequency and the loading method is required in the [Configuration Properties]
dialog box beforehand. Note, however, that you do not need to download the tutorial program to the on-chip
flash memory to operate the High-performance Embedded Workshop according to the description of section 4,
Tutorial.

For description on setting the emulation RAM and how to download a program to the on-chip flash memory,
refer to section 3.1, Setting the Environment for Emulation.

5.12.2  Notes on Operating the Tutorial Program

To operate the High-performance Embedded Workshop according to the description of section 4, Tutorial, the
following procedures must be added or modified.

Table 5.12 Notes on Operating the Tutorial Program

4.6 Executing the Reset the target MCU before executing the program. Refer to section 4.14,
Program Resetting the Target MCU for how to reset the target MCU.
4.12.3 Executing the In this product, after execution of [Step Out], execution stops at the statement where

[Step Over] Command  the sort function is called. Before executing the [Step Over] command, execute the
[Step In] command once so that the execution stops at the statement where the
change function is called.

4.19 Profiling Function ~ Before enabling the profiling function, ensure that [Enable select AUD to Emulator
(Enable read and write on the fly)] in the [Configuration Properties] dialog box is
unchecked.
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Section 6 Error Messages
6.1 Error Messages of the Emulator

6.1.1 Error Messages at Emulator Initiation

The emulator displays error messages in the format below if an error occurs at emulator initiation in the
dedicated message dialog box when the High-performance Embedded Workshop is used.

Table 6.1 lists error messages at emulator initiation.
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Table 6.1 Error Messages at Initiation

Error Message

Description and Solution

There is no configuration file.

The configuration file that is required to initiate the emulator
cannot be found. Exit and re-install the High-performance
Embedded Workshop. Then re-connect the user system
interface cable, turn on the power of the emulator, and re-
initiate the High-performance Embedded Workshop. If the
problem is not solved, contact us and describe the error
occurrence in detail.

The contents of the configuration file

are incorrect.

The configuration file that is required to initiate the emulator
is invalid. Exit and re-install the High-performance Embedded
Workshop. Then re-connect the user system interface cable,
turn on the power of the emulator, and re-initiate the High-
performance Embedded Workshop. If the problem is not
solved, contact us and describe the error occurrence in
detail.

Main Board not Support (XX XX XX)

Emulator is switched off or not
connected

Emulation Board not Support
(XX XX XX)

Emulator is switched off or not
connected

The emulator power is not turned on, or the user system
interface cable is not connected. Exit the High-performance
Embedded Workshop, re-connect the user system interface
cable, turn on the power of the emulator, and re-initiate the
High-performance Embedded Workshop. If the problem is
not solved, contact us and describe the error occurrence in
detail.

The emulator power is not turned on, or the user system
interface cable is not connected. Exit the High-performance
Embedded Workshop, re-connect the user system interface
cable, turn on the power of the emulator, and re-initiate the
High-performance Embedded Workshop. If the problem is
not solved, contact us and describe the error occurrence in
detail.

EVA chip Board not Support
(XX XX XX)

Emulator is switched off or not
connected

Can't initialize G/A registers

The emulator power is not turned on, or the user system
interface cable is not connected. Exit the High-performance
Embedded Workshop, re-connect the user system interface
cable, turn on the power of the emulator, and re-initiate the
High-performance Embedded Workshop. If the problem is
not solved, contact us and describe the error occurrence in
detail.

An error occurred during the initialization of the emulator. Exit
the High-performance Embedded Workshop, re-connect the
user system interface cable, turn on the power of the
emulator, and re-initiate the High-performance Embedded
Workshop. If the problem is not solved, contact us and
describe the error occurrence in detail.

There is no effective clock source

A valid clock source cannot be found. Connect a valid clock
source.

This mode can not specify

The state of mode pins for the target board is incorrect.
Initiation is only possible in mode 4. Set the mode pins
correctly.
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Table 6.1 Error Messages at Initiation (cont)

Error Message

Description and Solution

Can't find firmware file
Firmware open Error
Firmware Download Error
Firmware Name Error

There is an error in the file that is required at emulator
initiation. Exit the High-performance Embedded Workshop,
re-connect the user system interface cable, turn on the
power of the emulator, and re-initiate the High-performance
Embedded Workshop. If the problem is not solved, contact
us and describe the error occurrence in detail.

Failed to receive a firmware
initialization command.

Target system is Vcc down

Initiation of the emulator firmware has failed. Exit the High-
performance Embedded Workshop, re-connect the user
system interface cable, turn on the power of the emulator,
and re-initiate the High-performance Embedded Workshop. If
the problem is not solved, contact us and describe the error
occurrence in detail.

The value of Vcc is lower than the specified threshold value.

JTAG Timeout Srval Error
JTAG Packet Receive Error

Exit the High-performance Embedded Workshop, re-connect
the user system interface cable, turn on the power of the
emulator, and re-initiate the High-performance Embedded
Workshop.

6.1.2 Error Messages during Emulation

The emulator displays error messages if an error occurs during emulation in the dedicated message dialog box
when the High-performance Embedded Workshop is used, and on the status bar. Table 6.2 lists error messages

during emulation.

Table 6.2 Error Messages during Emulation

Error Message

Description and Solution

Communication DLL error.
Communication Timeout error.

Parallel Access Error

The power of the emulator is turned off or there is a
communication error. Exit the High-performance Embedded
Workshop, re-connect the user system interface cable, turn
on the power of the emulator, and re-initiate the High-
performance Embedded Workshop. If the problem is not
solved, contact us and describe the error occurrence in
detail.

An error has occurred during a parallel access. Parallel
accesses are disabled until a break occurs.
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Appendix A Menus

Table A.1 shows GUI menus.

Table A.1 GUI Menus

Toolbar
Menu Option Shortcut  Button Remarks
View Command Line Ctrl + L Opens the [Command Line]
window.
Workspace Alt + K Opens the [Workspace]
window.
Output Alt + U Opens the [Output] window.
Disassembly Ctrl +D Opens the [Disassembly]
window.
CPU Registers Ctrl+ R Opens the [Register] window.
Memory... Ctrl + M Opens the [Memory] window.
10 Ctrl +1 Opens the [I0] window.
Status Ctrl + U Opens the [Status] window.
Extended Monitor Opens the [Extended Monitor]
window.
Monitor  Monitor Shift + Opens the [Monitor] window.
Setting... Ctrl+E
Windows Opens the [Windows Select]
Select... dialog box to list, add, or edit
the [Monitor] window.
Sym-  Labels Shift + Opens the [Labels] window.
bol Ctrl + A
Watch Ctrl + W Opens the [Watch] window.
Locals Shift + Opens the [Locals] window.
Ctrl + W
Code Eventpoints Ctrl + E Opens the [Event] window.
Trace Ctrl +T Opens the [Trace] window.
Code Coverage... Shift + Opens the [Code Coverage]
Ctrl + H window.
Data coverage... Shift + Opens the [Data Coverage]
Ctrl+Z window.
Stack Trace Ctrl + K Opens the [Stack Trace]

window.
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Table A.1 GUI Menus (cont)

Menu Option

Shortcut

Toolbar
Button

Remarks

View Gra-
(cont) phic

Image...

Shift +
Ctrl+ G

(]

Opens the [Image] window.

Waveform...

Shift +
Ctrl + V

Opens the [Waveform]
window.

Per- Performance
form-  Analysis
ance

Profile

Menu Option

Shift +
Ctrl + P

Shift +

Ctrl + F

Shortcut

Toolbar
Button

Opens the [Performance
Analysis] window.

Opens the [Profile] window.

Remarks

Debug Debug Sessions...

Opens the [Debug Sessions]
dialog box to list, add, or
remove the debug session.

Debug Settings...

Opens the [Debug Settings]
dialog box to set the
debugging conditions or
download modules.

Reset CPU

Go

F5

Resets the target hardware
and sets the PC to the reset
vector address.

Starts executing the user
program at the current PC.

Reset Go

Go To Cursor

Shift +
F5

Resets the target hardware
and executes the user
program from the reset vector
address.

Starts executing the user
program at the current PC until
the PC reaches the address
indicated by the current text
cursor position.

Set PC To Cursor

Sets the PC to the address at
the row of the text cursor.

Run...

Launches the [Run Program]
dialog box allowing the user to
enter the PC or PC breakpoint
during executing the user
program.

Display PC

Shift+Ctrl
+Y

F

Opens the [Editor] or
[Disassembly] window at
the address of the PC.
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Table A.1 GUI Menus (cont)

Menu Option

Shortcut

Toolbar
Button

Remarks

Debug
(cont)

Step In

F11

®

Executes a block of user
program before breaking.

Step Over

F10

o

Executes a block of user
program before breaking. If a
subroutine call is reached, then
the subroutine will not be
entered.

Step Out

Step...

Step Auto
Mode

Executes the user program to
reach the end of the current
function.

Launches the [Step Program]
dialog box allowing the user to
modify the settings for stepping.

Steps only one source line when
the [Editor] window is active.
When the [Disassembly] window
is active, stepping is executed in
a unit of assembly instructions.

Assembly

Source

Executes stepping in a unit of
assembly instructions.

Steps only one source line.

Halt Program

Esc

Stops the execution of the user

program.

Initialize Disconnects the emulator and
connects it again.

Connect Connects the emulator.

Disconnect Disconnects the emulator.

Save Memory...

Saves the specified memory
area data to a file.

Verify Memory...

Verifies file contents against
memory contents.

Configure Overlay...

Selects the target section group
when the overlay function is
used.

Download Modules

Downloads the object program.

Unload Modules

Unloads the object program.

RENESAS

151



Table A.1 GUI Menus (cont)

Menu

Option

Toolbar
Shortcut  Button

Remarks

Setup

Customize...

Options...

Customize the High-
performance Embedded
Workshop application.

Sets option of the High-
performance Embedded
Workshop application.

Format Views...

Configure fonts, colors,
keywords and so on, for the
window.

Radix Hexadecimal

Uses a hexadecimal for
displaying a radix in which the
numerical values will be
displayed and entered by
default.

Decimal

Uses a decimal for displaying a
radix in which the numerical
values will be displayed and
entered by default.

Octal

Uses an octal for displaying a
radix in which the numerical
values will be displayed and
entered by default.

Binary

Uses a binary for displaying a
radix in which the numerical
values will be displayed and
entered by default.

Emu-  System...
lator

Opens the [Configuration
Properties] dialog box allowing
the user to modify the emulator
settings.
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Appendix B Command Lines

Table B.1 lists the High-performance Embedded Workshop commands.

Table B.1

No. Command Name

High-performance Embedded Workshop Commands

Abbreviation Function

! - Comment

2 ADD_FILE AF Adds a file to the current project

3  ANALYSIS AN Enables or disables performance analysis

4 ANALYSIS_RANGE AR Sets or displays a performance analysis range

5  ANALYSIS_RANGE_ AD Deletes a performance analysis range
DELETE

6  ASSEMBLE AS Assembles instructions into memory

7  ASSERT - Checks if an expression is true or false

8 AUTO_COMPLETE AC Enables or disables the auto-complete function

9 BREAKPOINT_ONCHIP BC Displays on-chip breakpoints, sets sequential

breaks, and sets PtoP time measurement

10 BREAKPOINT_ONCHIPn BCn Sets on-chip breakpoint of each channel

11 BREAKPOINT_ONCHIP BCC Clears on-chip breakpoints
_CLEAR

12 BREAKPOINT_ONCHIP BCE Enables or disables an on-chip breakpoint
_ENABLE

13 BREAKPOINT_ BE Displays on-emulator breakpoints
ONEMULATOR

14 BREAKPOINT_ BEn Sets on-emulator breakpoint of each channel
ONEMULATORN

15 BREAKPOINT_ BEC Clears on-emulator breakpoints
ONEMULATOR_CLEAR

16 BREAKPOINT_ BEE Enables or disables an on-emulator breakpoint
ONEMULATOR_
ENABLE

17 BREAKPOINT_ BS Sets a software breakpoint
SOFTWARE

18 BREAKPOINT_ BSC Clears software breakpoints
SOFTWARE_CLEAR

19 BREAKPOINT_ BSE Enables or disables a software breakpoint
SOFTWARE_ENABLE

20 BUILD BU Performs a build on the current project

21 BUILD_ALL BL Performs a build all on the current project

22 CHANGE_ CC Sets the current configuration
CONFIGURATION

23 CHANGE_PROJECT CP Sets the current project

24 CHANGE_SESSION CS Changes the current session

25 CLOSE_WORKSPACE CW Close the current workspace

26 CONFIGURE_ CPF Sets the debugging environment for the emulator
PLATFORM

27 DEFAULT_OBJECT_ DO Sets the default object (program) format
FORMAT

28 DEVICE_TYPE DE Selects a device type to emulate
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Table B.1

No. Command Name

High-performance Embedded Workshop Commands (cont)

Abbreviation Function

29 DISASSEMBLE DA Disassembles memory contents

30 EMULATOR_CLOCK ECK Selects the clock rate of the target MCU for the
emulator

31 ERAM ERM Sets the ERAM or displays the ERAM setting

32 ERASE ER Clears the [Command Line] window

33 EVALUATE EV Evaluates an expression

34 EXMONITOR_DISPLAY EXMD Displays the content of the expansion monitor

35 EXMONITOR_SET EXMS Selects whether or not to display the items in the
expansion monitor

36 EXMONITOR_ EXMSR Sets the time to update the expansion monitor

SETRATE during emulation or a break

37 FILE_LOAD FL Loads an object (program) file

38 FILE_SAVE FS Saves memory to a file

39 FILE_UNLOAD FU Unloads a file

40 FILE_VERIFY FV Verifies file contents against memory

41 FLASH_MEMORY FLM Erases the contents of the flash memory

42 GENERATE_MAKE_ GM Creates a makefile to be built outside the High-

FILE performance Embedded Workshop

43 GO GO Executes user program

44 GO_RESET GR Executes user program from reset vector

45 GO_TILL GT Executes user program until temporary breakpoint

46 HALT HA Halts the user program

47 HELP HE Displays the command line help

48 INITIALIZE IN Initializes the debugging platform

49 JTAG_CLOCK JCK Sets and displays the JTAG clock (TCK)

50 LOG LO Controls command output logging

51 MAP_DISPLAY MA Displays memory mapping

52 MEMORY_COMPARE MC Compares memory contents

53 MEMORY_DISPLAY MD Displays memory contents

54 MEMORY_EDIT ME Modifies memory contents

55 MEMORY_FILL MF Modifies the content of a memory area by specifying
data

56 MEMORY_FIND Ml Searches for data within the memory range

57 MEMORY_MOVE MV Moves a block of memory

58 MEMORY_TEST MT Tests a block of memory

59 MODE MO Sets or displays the MCU mode

60 MONITOR_CLEAR MOC Deletes a monitor point

61 MONITOR_DISPLAY MOD Displays the content of the monitor

62 MONITOR_REFRESH MOR Controls an automatic update of the content of the
monitor

63 MONITOR_SET MOS Sets or displays a monitor point

64 OPEN_WORKSPACE ow Opens a workspace

65 PROFILE PR Enables or disables the profile

66 PROFILE_DISPLAY PD Displays profiling results
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Table B.1

High-performance Embedded Workshop Commands (cont)

No. Command Name Abbreviation Function
67 PROFILE_SAVE PS Saves profiling results
68 QUIT QU Exits High-performance Embedded Workshop
69 RADIX RA Sets default input radix
70 REFRESH RF Updates windows related to memory
71 REGISTER_DISPLAY RD Displays CPU register values
72 REGISTER_SET RS Sets CPU register contents
73 REMOVE_FILE REM Deletes the specified file from the current project
74 RESET RE Resets CPU
75 SAVE_SESSION SE Saves the current session
76 SLEEP - Delays command execution
77 STEP ST Steps program (by instructions or source lines)
78 STEP_MODE SM Sets the step mode
79 STEP_OUT SP Steps out of the current function
80 STEP_OVER SO Steps program, not stepping into functions
81 STEP_RATE SR Sets or displays rate of stepping
82 SUBMIT SuU Executes a command file
83 SYMBOL_ADD SA Defines a symbol
84 SYMBOL_CLEAR SC Deletes a symbol
85 SYMBOL_LOAD SL Loads a symbol information file
86 SYMBOL_SAVE SS Saves a symbol information file
87 SYMBOL_VIEW SV Displays symbols
88 STATUS STS The content of the [Platform] sheet in the [Status]
window is displayed.
89 SAVE_WORKSPACE Sw Saves the current workspace
90 TCL - Enables or disables the TCL
91 TEST_EMULATOR TEM Tests the on-chip flash memory area
92 TIMER TI Sets or displays the timer resolution
93 TOOL_INFORMATION TO Outputs information on the currently registered tool
to afile
94 TRACE TR Displays trace information
95 TRACE_ACQUISITION TA Sets or displays trace acquisition parameters
96 TRACE_ACQUISITIONn TAn Sets PtoP point and each channel for trace
acquisition conditions
97 TRACE_ACQUISITION TAC Deletes trace acquisition parameters
_CLEAR
98 TRACE_BINARY_ TBC Compares a trace binary file with the current trace
COMPARE information
99 TRACE_BINARY_SAVE TBV Outputs trace information into a binary file
100 TRACE_FILTER TF Filters trace information
101 TRACE_SAVE TV Outputs trace information into a file
102 TRACE_STATISTIC TST Analyzes statistic information
103 UPDATE_ALL_ ub Updates dependencies of the current project
DEPENDENCIES
104 USER_SIGNALS us Enables or disables the user signal information
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Table B.1 High-performance Embedded Workshop Commands (cont)

No. Command Name Abbreviation Function

105 WATCH_ADD WA

Adds a watch item

106 WATCH_AUTO_UPDATE WU Selects or cancels automatic update of watch items
107 WATCH_DELETE WD Deletes a watch item

108 WATCH_DISPLAY Wi Displays the contents of the Watch window

109 WATCH_EDIT WE Edits the value of a watch item

110 WATCH_EXPAND WX Expands or collapses a watch item

111 WATCH_RADIX WR Changes the radix of a watch item to be displayed

112 WATCH_SAVE WS

Saves the contents of the Watch window to a file

For the syntax of each command, refer to the online help.
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